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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide describes how to configure and work with Reports in HP Business 
Availability Center.

This chapter includes:

 ➤  How This Guide Is Organized on page 9

 ➤  Who Should Read This Guide on page 10

 ➤  Getting More Information on page 10

How This Guide Is Organized

The guide contains the following parts:

 Part I Global Reports Components

Describes how to work with reports, the reports available in HP Business 
Availability Center, customizing reports, and analyzing reports logs. 

 Part II User Reports

Describes the pages and dialog boxes that are part of User Reports, which 
enable tracking of specific performance issues relevant to your organization 
or business unit's performance monitoring needs.
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Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.



Part I

Global Reports Components
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1
Introducing Reports

This chapter provides general information on Reports.

This chapter includes:

Concepts

 ➤  Reports Overview on page 14

 ➤  HP Business Availability Center Reports on page 16

 ➤  Legacy Reports on page 36
Concepts
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Reports Overview

Reports are available in the various applications contexts in HP Business 
Availability Center, and enable you to view and analyze performance data 
collected by HP Business Availability Center data collectors and stored in the 
HP Business Availability Center database. 

HP Business Availability Center provides the following types of reports: 

➤ Application Reports. Contain data displaying how well different areas of 
HP Business Availability Center are performing. Reports are categorized by 
the application they relate to: 

➤ Business Process Insight Reports. Display information on business 
processes and business process monitors, which enable you to visualize 
the health, performance, and effectiveness of your business processes. For 
details on Business Process Insight reports, see Using Business Process 
Insight.

➤ Dashboard Reports. Display data collected from monitors, probes, and 
applications. For details on Dashboard reports, see “Dashboard Reports 
Overview” in Using Dashboard.

➤ End User Management Reports. Enable you to detect end-user business 
process issues before customers are impacted. For details on End User 
Management reports, see “End User Management Reports - Overview” in 
Using End User Management.

➤ Service Level Management Reports. Show you how well actual service 
levels compare with your goals. For details on Service Level Management 
reports, see “Service Level Management Reports - Overview” in Using 
Service Level Management. 

➤ HP Business Availability Center for Siebel Applications Reports. Display 
information on HP Business Availability Center for Siebel Applications 
diagnostics tools. For details on HP Business Availability Center for Siebel 
Applications Reports, see Solutions and Integrations.

➤ TransactionVision Reports. Display information on transaction topology 
and infrastructure for data collection. For details on TransactionVision 
reports, see Using TransactionVision.

Note: You must ensure that Java Runtime Environment is installed on 
the client PC, to enable viewing of the TransactionVision report applets.
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➤ System Availability Management Reports. Display information about 
how the servers and applications you are monitoring have performed 
over time. For details on System Availability Management reports, see 
“System Availability Management Reports” in Using System Availability 
Management.

➤ Alerts Reports. Enable you to view alert schedules configured for various 
HP Business Availability Center contexts. For details on Alerts Reports, 
see “Alerts Application” in Alerts.

➤ Universal CMDB Reports. Enable you to view and assess performance 
data collected by HP Business Availability Center and stored in the 
CMDB. For details on Universal CMDB Reports, see “Overview Reports 
Overview” in Model Management.

➤ User Reports. Customized reports containing user-defined data and 
formatting that can help you focus on specific aspects of your organization's 
application and infrastructure resource performance. 

User reports include:

➤ Favorite Filters. For details, see “Favorite Filters” on page 96.

➤ Custom Reports. For details, see “Custom Reports” on page 127. 

➤ Trend Reports. For details, see “Trend Reports” on page 175.

➤ Service Reports. For details, see “Service Report” on page 205.

➤ Custom Links. For details, see “New Custom Link Page” on page 113.

➤ Excel Reports. For details, see “Excel Reports” on page 97.

➤ Custom Query Reports. For details, see “Custom Query Builder” on 
page 285.

User reports are configured in the Report Manager. For details on the Report 
Manager, see “Report Manager” on page 93.

You can also create a Schedule for User Reports to enable them to be sent to 
recipients at specified times. For details on creating schedules, see “Report 
Schedules” on page 96.
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➤ Additional Reports. Reports that cannot be accessed directly from any 
application but that can be added to custom reports to provide additional 
information. For details on Additional Reports, see “Additional Custom 
Reports” on page 161.

HP Business Availability Center Reports

The following reports are available in HP Business Availability Center, 
arranged by context. 

These reports can be accessed via the specified contexts in HP Business 
Availability Center, and can also be assigned to Favorite Filters in the 
Favorite Filter Wizard, and to Custom Reports as report components using 
the Custom Report Wizard. Not all reports are available for each wizard. For 
details on configuring Favorite Filters, see “Favorite Filters Wizard” on 
page 107. For details on Custom Reports, see “Custom Reports” on 
page 127.

You can click the report name for a full description of the report.

This section includes the following topics:

➤ “Alerts Reports” on page 17

➤ “Application Change Lifecycle Reports” on page 18

➤ “Application Performance Lifecycle Reports” on page 19

➤ “Business Process Insight Reports” on page 19

➤ “Dashboard Reports” on page 20

➤ “Business Process Insight Reports” on page 20

➤ “End User Management Reports” on page 21

➤ “Real User Monitor Reports” on page 26

➤ “Service Level Management Reports” on page 30

➤ “Business Availability Center for SOA Reports” on page 33

➤ “System Availability Management Reports” on page 34

➤ “TransactionVision Reports” on page 35
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➤ “Universal CMDB Reports” on page 36

Alerts Reports

Reports Description

Actual vs. Baseline 
Suggested Alerts Report

Enables you to compare the actual alerts that were 
triggered by user-defined thresholds and the 
Baselined Suggested alerts that would be triggered 
during the specified time range, for the selected 
Business Process Monitor profiles if you were using 
Baselining. For details, see “Actual vs. Baseline 
Suggested Alerts Report” in Alerts.

Actual vs. Baseline 
Suggested Alerts – 
Detailed Report

Enables you to view, for each time period, whether 
the number of actual alerts that were triggered by 
user-defined thresholds is greater, equal, or smaller 
than the Baselined alerts that would be triggered 
during the specified time range, for the selected 
Business Process Monitor profiles if you were using 
Baselining. For details, see “Actual vs. Baseline 
Suggested Alerts – Detailed Report” in Alerts.

Alerts Count Over Time 
Report

Enables you to display, for the selected profile, the 
number of alerts that occurred over the specified 
time range, organized by time and severity. For 
details, “Alerts Count Over Time Report” in Alerts.

Alerts Count Summary 
Report

Enables you to display, for the selected profile, the 
total number of alerts that occurred over the 
specified time range, organized by severity. For 
details, see “Alerts Count Summary Report” in Alerts.

Alerts Log Report Enables you to track all alert details for event-based 
alerts sent by HP Business Availability Center during 
the specified time range, for the selected Business 
Process Monitor profiles, or Real User Monitor, 
regardless of the action specified for the alert in the 
alert scheme. For details, see “Alerts Log Report” in 
Alerts.
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Application Change Lifecycle Reports

Baseline Suggested Alerts 
Log Report

Enables you to track all alert details for event-based 
alerts that would be sent by HP Business Availability 
Center during the specified time range, for the 
selected Business Process Monitor profiles, or Real 
User Monitor, regardless of the action specified for 
the alert in the alert scheme, if you were using 
Baselining. For details, see “Baseline Suggested Alerts 
Log Report” in Alerts.

Configuration Item Status 
Alerts Report

Enables you to list all of the alerts that occurred in 
the specified period of time. For details, see 
“Configuration Item Status Alerts Report” in Alerts.

SLA Status Alerts Report Lists the alerts that were triggered during a specified 
time period. For details, see “SLA Status Alerts 
Report” in Alerts.

Reports Description

Location Load Analysis 
Report

Enables you to view the transaction load (the 
number of Real User Monitor transaction runs) and 
bit rate (bits per second) per end-user location. For 
details, see “Location Load Analysis Report” in 
Solutions and Integrations. 

Typical Transaction Load 
Report

Enables you to view the average transaction load 
(the number of Real User Monitor transaction runs) 
during a typical hour, day, or week within a larger 
time frame that you select. For details, see “Typical 
Transaction Load Report” in Solutions and 
Integrations.

Reports Description
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Application Performance Lifecycle Reports

Business Process Insight Reports

Reports Description

Business Process 
Distribution Page

Enables you to view transaction run and transaction 
response time data over time for the configured 
transactions monitored by the Real User Monitor, 
and create VuGen script templates that can be used 
in a Performance Center load test. For details, see 
“Business Process Distribution Page” in Using 
Application Performance Lifecycle.

Location Load Analysis 
Report

Enables you to view the transaction load (the 
number of Real User Monitor transaction runs) and 
bit rate (bits per second) per end-user location. For 
details, see “Location Load Analysis Report” in Using 
Application Performance Lifecycle.

Typical Transaction Load 
Report

Enables you to view the average transaction load 
(the number of Real User Monitor transaction runs) 
during a typical hour, day, or week within a larger 
time frame that you select. For details, see “Typical 
Transaction Load Report” in Using Application 
Performance Lifecycle.

Reports Description

BPI Monitors Over Time 
Report

Displays two graphs for each selected BPI Duration 
Monitor CI or BPI Custom/Value Monitor CI. For 
details, see "BPI Application Reports" in Using 
Business Process Insight.

Business Process Over 
Time Report

Displays information about the volume, backlog, 
and health of the selected Business Process CI, over 
the selected time period. For details, see "BPI 
Application Reports" in Using Business Process Insight.

Business Process 
Summary Report

Displays the summary data of the selected Business 
Process CIs. For details, see "BPI Application Reports" 
in Using Business Process Insight.
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Dashboard Reports

Business Process Insight Reports

Reports Description

KPIs Summary Report Displays a summary of KPI status distribution over 
time for each selected KPI. For details, see “KPIs 
Summary Report” in Using Dashboard.

KPIs Trend Report Enables you to analyze the trend for changes in KPI 
status over time, for selected statuses. For details, see 
“KPIs Trend Report” in Using Dashboard.

KPIs Distribution Over 
Time Report

Enables you to analyze KPI trend by viewing KPI 
status distribution over time for selected statuses. For 
details, see “KPIs Distribution Over Time Report” in 
Using Dashboard.

KPIs Over Time Report Displays the status or value, over time, of selected 
CIs and KPIs that are accessible from the Dashboard 
application. For details, see “KPIs Over Time Report” 
in Using Dashboard.

Reports Description

Business Process 
Summary

Displays the summary data for the selected Business 
Processes. For details, see "BPI Application Reports" 
in Using Business Process Insight.

Business Process Over 
Time

Displays an over-time graph of information relating 
to the Business Process instance status. For details, 
see "BPI Application Reports" in Using Business 
Process Insight.

BPI Monitors Over Time Displays information relating to the Business Process 
Monitors status for your Business Processes over a 
selected time period. For details, see "BPI Application 
Reports" in Using Business Process Insight.
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End User Management Reports

Snapshot Status Report

Summary Reports

Reports Description

End User Management 
Status Snapshot

Displays a summary of the five worst transactions 
and locations for Business Process Monitor for the 
last day. For Real User Monitor, End User 
Management displays the five worst sessions (that is, 
the least available) and the slowest applications. For 
details, see “Status Snapshot” in Using End User 
Management.

Network and Tool Reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description

Multi-Profile Summary 
Report

Displays an overall snapshot of application 
performance for multiple Business Process profiles. 
For details, see “Multi-Profile Summary Report” in 
Using End User Management.

Performance Matrix 
Report

Displays a distribution of average transaction 
response times—organized by transaction, location, 
or group—over a specified period of time. For details, 
see “Performance Matrix Report” in Using End User 
Management. 
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Business Process Reports

Single Profile Summary 
Report

Displays a quick snapshot of application 
performance for a specific Business Process profile. 
For details, see “Single Profile Summary Report” in 
Using End User Management.

Triage Report Displays transaction data for Business Process 
Monitor profiles, organized by location, for the past 
day or for any selected 24 hours. For details, see 
“Triage Report” in Using End User Management.

Reports Description

Availability Over Time 
Report

Displays the percentage of successful transactions 
performed by all hosts in a profile—organized by 
transaction, location, or group—over time. For 
details, see “Availability Over Time Report” in Using 
End User Management.

Breakdown Over Time 
Report

Displays a color-coded graph showing the average 
transaction breakdown category response times (in 
milliseconds) of a profile’s transactions over time. 
For details, see “Breakdown Over Time Report” in 
Using End User Management.

Breakdown Summary 
Report

Displays a color-coded graph that breaks down 
transaction times into categories, enabling you to 
determine whether poor transaction response times 
are being caused by network or server problems, or 
by client delays. For details, see “Breakdown 
Summary Report” in Using End User Management.

Reports Description
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Error Summary Report Displays detailed tables—organized by error type—of 
errors that occurred during a profile run, over the 
specified time period. Since not all errors cause 
transactions to fail, the Error Summary report 
includes errors for transactions that completed 
successfully as well as transactions that failed. The 
report also lists outlier transactions. For details, see 
“Error Summary Report” in Using End User 
Management.

Failed Transactions Report Displays details about errors that occur during a 
script run. You also access the Snapshot on Error 
feature from the Failed Transaction report. For 
details, see “Failed Transactions Report” in Using End 
User Management.

Location Analysis Report Displays an in-depth picture of the performance of 
locations. The report enables you to understand, for 
the selected profile and defined time frame:

➤ the average response times of your transactions 
over time for each location in the profile.

➤ how well your locations performed relative to the 
set transaction thresholds.

For details, see “Location Analysis Report” in Using 
End User Management.

Min./Max. Response Time 
Report

Displays the minimum, average, and maximum 
response time (in seconds) of completed 
transactions—organized by transaction, location, or 
group—for the selected time frame. For details, see 
“Min./Max. Response Time Report” in Using End User 
Management.

Response Time by 
Percentile Report

Displays, for the defined time range, the specific 
response time value that all measured response time 
values are equal to or below, for calculated 
percentiles. For details, see “Response Time by 
Percentile Report” in Using End User Management.

Reports Description
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Response Time Over Time 
Report

Displays the average response times (in seconds) of 
completed transactions—organized by transaction, 
location, or group—over time. For details, see 
“Response Time Over Time Report” in Using End User 
Management.

Transaction Analysis 
Report

Displays an in-depth picture of the performance of 
transactions. The report enables you to understand, 
for the selected profile and defined time frame:

➤ the average response times of your transactions 
over time.

➤ whether poor transaction response times are 
being caused by network or server problems, or by 
client delays.

➤ the availability level of your transactions.

➤ how well your transactions performed relative to 
set transaction thresholds.

For details, see “Transaction Analysis Report” in 
Using End User Management.

Transaction Breakdown 
Raw Data Report

Displays a summary of every instance of the 
transaction that occurred during the selected time 
range. For details, see “Transaction Breakdown Raw 
Data Report” in Using End User Management.

Triage Raw Data Report Displays performance and availability raw data for a 
Business Process Monitor transaction. For details, see 
“Triage Raw Data Report” in Using End User 
Management.

Network and Tool reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description
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Network Reports

Reports Description

Network Analysis Report Displays an in-depth picture of network 
performance for a Business Process profile, if you 
defined a WebTrace monitor for the profile. For 
details, see “Network Analysis Report” in Using End 
User Management. 

Page Component 
Breakdown Report

Displays an on-demand component breakdown of 
any Web page. For details, see “Page Component 
Breakdown Report” in Using End User Management. 

WebTrace by Location 
Report

Displays typical traceroute information from 
configured host locations to specified destinations, 
enabling you to analyze network performance. For 
details, see “WebTrace by Location Report” in Using 
End User Management. 

WebTrace Measurements 
Report

Displays WebTrace data with increased time 
granularity. For details, see “WebTrace 
Measurements Report” in Using End User 
Management. 

WebTrace Over Time 
Report

Displays additional route time and hop information 
that helps you determine at exactly which point 
along the network path bottlenecks are occurring. 
For details, see “WebTrace Over Time Report” in 
Using End User Management. 
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Real User Monitor Reports

Reports Description

Business Process 
Distribution Report

Displays transaction run and transaction response 
time data over time for the transactions that you 
configure in End User Management Administration. 
For details, see “Business Process Distribution 
Report” in Using End User Management. 

End User Over Time 
Report

Displays a selected end-user group’s hits, latency, 
events, requests, and traffic over the course of time. 
For details, see “End User Over Time Report” in Using 
End User Management.

End User Summary Report Displays data for specific end-user groups that were 
configured for Real User Monitor in End User 
Management Administration. Also displays 
aggregated data for unconfigured end-user groups, 
which is displayed grouped by country, or if the 
country is unknown, then grouped as OTHER. For 
details, see “End User Summary Report” in Using End 
User Management.

End Users by Page Report Displays data for a selected Web page configured for 
Real User Monitor in End User Management 
Administration, broken down by end-user groups. 
For details, see “End Users by Page Report” in Using 
End User Management.

End Users by Transaction 
Report

Displays general, availability, and performance data 
for each end-user group that ran the transaction you 
selected in the Transaction Summary report. For 
details, see “End Users by Transaction Report” in 
Using End User Management.

Event Analysis Report Displays data for a selected event type, broken down 
by pages, servers, and end-user groups. Also displays 
the Event Count Over Time report for the selected 
event type. For details, see “Event Analysis Report” 
in Using End User Management.
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Event Count Over Time 
Report

Displays data for all events, or sessions with events, 
in monitored applications that you configured in 
End User Management Administration, broken 
down by time intervals. For details, see “Event 
Count Over Time Report” in Using End User 
Management.

Event Summary Report Displays a summary of events in monitored 
applications that you configured in End User 
Management Administration. For details, see “Event 
Summary Report” in Using End User Management.

Global Statistics Report Contains tables displaying general page, end-user, 
and broken link data that is not related to the 
specific pages and end-users that you define for Real 
User Monitor in End User Management 
Administration. For details, see “Global Statistics 
Report” in Using End User Management.

Page Over Time Report Displays details of the availability, performance, hits 
availability, and breakdown for the selected Web 
page over the course of time. For details, see “Page 
Over Time Report” in Using End User Management.

Page Summary Report Displays data for specific Web pages that were 
configured for Real User Monitor in End User 
Management Administration. For details, see “Page 
Summary Report” in Using End User Management.

Pages by Server Summary 
Report

Displays a table showing each page hit by the server 
for which you are viewing data. For details, see 
“Pages by Server Summary Report” in Using End User 
Management.

Server Over Time Report Displays graphs and tables of the server’s availability, 
traffic, requests, and errors over the course of time. 
For details, see “Server Over Time Report” in Using 
End User Management.

Server Summary Report Displays data for the servers that are monitored by 
the Real User Monitor probe. For details, see “Server 
Summary Report” in Using End User Management.

Reports Description
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Servers by Page Summary 
Report

Displays a table showing each server used in 
accessing the page for which you are viewing data. 
For details, see “Servers by Page Summary Report” in 
Using End User Management.

Session Analyzer Report Displays session data for specific applications that 
were configured for Real User Monitor in End User 
Management Administration. Sessions in 
applications that have not been configured for 
monitoring are also reported as part of a default 
entity for other applications, called <engine name>’s 
other applications. For example, for a configured 
Real User Monitor engine called myengine, the 
default entity for non-monitored applications is 
myengine’s other applications.

For details, see “Session Analyzer Report” in Using 
End User Management.

Session Details Report Displays details of a session and includes panes 
showing data for Properties, General Events, and 
Pages. For details, see “Session Details Report” in 
Using End User Management.

TCP Application Over 
Time Report

Displays a selected application’s traffic, errors, load, 
and response times over the course of time. For 
details, see “TCP Application Over Time Report” in 
Using End User Management.

TCP Application 
Summary Report

Displays data for specific TCP applications, as well as 
for Web (HTTP) applications with TCP settings, that 
were configured for Real User Monitor in End User 
Management Administration. For details, see “TCP 
Application Summary Report” in Using End User 
Management.

Transaction Over Time 
Report

Displays details of the availability, page times, run 
availability, and breakdown for the selected 
transaction, over the course of time. For details, see 
“Transaction Over Time Report” in Using End User 
Management.

Reports Description
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Transaction Summary 
Report

Displays data for specific transactions that were 
configured for Real User Monitor in End User 
Management Administration. For details, see 
“Transaction Summary Report” in Using End User 
Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in a country 
or state selected in the Unconfigured End Users by 
Country/State report, grouped by city. For details, 
see “Unconfigured End Users by Country/State, City, 
or IP” in Using End User Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in an 
unconfigured end-user group selected in the End 
User Summary report, grouped by country and state. 
For details, see “Unconfigured End Users by 
Country/State, City, or IP” in Using End User 
Management.

Unconfigured End Users 
by Country/State, City, or 
IP

Displays data for the end-users included in a city 
selected in the Unconfigured End Users by City 
report, grouped by IP address. For details, see 
“Unconfigured End Users by Country/State, City, or 
IP” in Using End User Management.

Network and Tool Reports Displays reports that help you identify problems 
along the network.

Report data is based on WebTrace/Traceroute 
monitor data.

For details, see “Network Reports and Tools 
Overview” in Using End User Management.

Reports Description
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Service Level Management Reports

Status Snapshot Report

SLA Reports

Report Name Description

Status Snapshot Report Displays up-to-date information about the worst-
performing agreements in the current tracking 
periods, and in previous, closed periods.

For details, see “Status Snapshot Report” in Using 
Service Level Management.

Report Name Description

SLA Status Report Displays current and forecast status for agreements 
over a selected tracking period. Use to determine if 
current service levels may lead to a future breach of 
the agreement.

For details, see “SLA Status Report” in Using Service 
Level Management.

SLAs Summary Report Displays a list of agreements and their status, 
organized by KPI/calendar/time period. Use to view 
a summary of data for all (or specific) agreements.

For details, see “SLAs Summary Report” in Using 
Service Level Management. 

CI Summary Report Drill-down from the SLA Summary report. The 
report displays status for CIs in the branch for a 
selected CI (up to four levels), organized by 
KPI/calendar/time period. Use to find CIs that did 
not reach their objectives. For details, see “CI 
Summary Report” in Using Service Level Management.
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CI Impact Report Displays a CI’s impact across several agreements. The 
report displays status organized by 
KPI/calendar/time period. Use to compare the 
availability and performance of a CI across several 
agreements.

For details, see “CI Impact Report” in Using Service 
Level Management.

CI Status Report Displays status for CIs in the branch for a selected CI 
(up to four levels), for a selected time range, 
calendar, and KPI. Use to view configuration 
information, such as objectives, for each CI.

For details, see “CI Status Report” in Using Service 
Level Management.

Time Range Comparison 
Report

Enables you to compare status for up to eight time 
ranges for CIs in an agreement.

Displays status for CIs in the branch of a selected CI 
(up to four levels), for a selected calendar and KPI.

The added value in this report is that it displays a 
trend between two time ranges.

Use to compare time ranges to determine whether 
availability and performance have improved. 

For details, see “Time Range Comparison Report” in 
Using Service Level Management.

Report Name Description
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Outage Reports

CIs Over Time Report Displays a graphic display of status over time for 
selected CIs, for a specific KPI and calendar. Use to 
follow the results of a particular CI over a time 
period and compare with other CIs.

For details, see “CIs Over Time Report” in Using 
Service Level Management.

CI Over Time vs. Target 
Report

Displays a graphic display of status over time for a 
selected CI, for a specific KPI and calendar, and 
compares results to the target objectives for the CI. 
Use to see how well a CI has performed compared to 
its objectives.

For details, see “CI Over Time vs. Target Report” in 
Using Service Level Management.

Report Name Description

Outage Summary Report Displays a list of outages for selected CIs. Use to view 
outage information for a specific agreement.

For details, see “Outage Summary Report” in Using 
Service Level Management.

Report Name Description
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Business Availability Center for SOA Reports

Outage Breakdown Report Displays a graphic display for breakdown of outage 
categories by CI outages, or a breakdown of CI 
outages by outage categories. You view data 
according to outage duration or number of outages, 
for a specific calendar. Use to view a breakdown of 
all outages for certain CIs, to see to which category a 
CI belongs (Database, Network, Webserver, 
Undefined, or user-defined).

For details, see “Outage Breakdown Report” in Using 
Service Level Management.

Outage Distribution 
Report

Displays a graphic display of outage distribution by 
CI or by outage category. You view data according to 
outage duration or number of outages, for a specific 
calendar. Use to view the outage distribution for 
selected CIs, to see which CI or category has the 
most outages, or has outages with the longest 
duration. 

For details, see “Outage Distribution Report” in Using 
Service Level Management.

Reports Description

Consumer Summary 
Report

Displays specific metrics for all of the consumers 
accessing the selected Web services or operations in 
a selected view. For details, see “Consumer Summary 
Report” in Solutions and Integrations.

Health Report Displays health metrics for the selected Web 
service(s), operation(s), server, endpoint, or 
consumer in a selected view. For details, see “Health 
Report” in Solutions and Integrations.

Metrics Over Time Report Displays the performance of selected metrics related 
to a selected view and selected CIs, over time. For 
details, see “Metrics Over Time Report” in Solutions 
and Integrations.

Report Name Description
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System Availability Management Reports

Server and Endpoint 
Summary Report

Displays a drillable summary of the metrics for all of 
the servers or endpoints on which the selected Web 
services or operations of a selected view are running. 
For details, see “Server and Endpoint Summary 
Report” in Solutions and Integrations.

Top Metrics Report Displays the top metrics information about the 
traffic to and from all of the monitored Web services 
or operations in a specific view. For details, see “Top 
Metrics Report” in Solutions and Integrations.

Report Name Description

Monitor Performance 
Report

Displays the best- or worst-performing SiteScope 
monitors across various SiteScope categories. 

For details, see “Monitor Performance Report” in 
Using System Availability Management. 

Cross-Performance Report Displays data from more than one SiteScope server 
filtered by monitored servers, monitor types, and 
measurements. For details, see “Cross-Performance 
Report” in Using System Availability Management. 

Group Performance 
Report

Displays the infrastructure machine resource usage 
data for the monitors in the selected group and its 
subgroups. For details, see “Group Performance 
Report” in Using System Availability Management. 

Status Summary Report Displays a quick snapshot of the performance of 
monitored infrastructure machines, organized by 
SiteScope group. For details, see “Status Summary 
Report” in Using System Availability Management. 

Reports Description
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TransactionVision Reports

Warning Summary Report Displays a list of the monitors, for the selected group 
and its subgroups, whose measurements fell within 
the minor threshold level during the selected time 
period. For details, see “Warning Summary Report” 
in Using System Availability Management. 

Error Summary Report Displays a list of the monitors, for the selected group 
and its subgroups, whose measurements returned 
errors during the selected time period. For details, 
see “Error Summary Report” in Using System 
Availability Management. 

Reports Description

Transaction Over Time 
Report

Displays details of the availability, page times, run 
availability, and breakdown for the selected 
transaction, over the course of time. For details, see 
“Transaction Over Time Report” in Using 
TransactionVision

Transaction Summary 
Report

Displays data for specific transactions that were 
configured for Real User Monitor in End User 
Management Administration. For details, see 
“Transaction Summary Report” in Using End User 
Management. 

Transaction Over Time 
Report, Transaction 
Performance Summary 
Report

Displays summarized information for selected 
business transactions monitored by 
TransactionVision, and information over time for 
specific transactions. For details, see “Transaction 
Over Time Report” and “Transaction Performance 
Summary Report” in Using TransactionVision.

Report Name Description
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Universal CMDB Reports

Legacy Reports

Certain report functionalities are not supported in HP Business Availability 
Center Legacy Reports. These elements are indicated in the table in 
“Common Report Elements” on page 56. 

The following table outlines the HP Business Availability Center Legacy 
Reports, arranged by application:

Report Name Description

Asset Report Displays a list of all the CIs in a specified view, their 
attribute values, as well as their child CI’s in the 
CMDB. For details, see “Asset Report” in Model 
Management. 

Change Report Enables you to view and analyze the actual changes 
made to a specific CI and its children. For details, see 
“Change Report” in Model Management. 

Host Dependency Report Lists all the relationships of the type Dependency 
that connect between servers in the selected view, or 
between the servers in the CMDB and the servers 
within the selected view. For details, see “Host 
Dependency Report” in Model Management.

Topology Report Gives you information about the selected Report 
nodes in the TQL on which it is based. For details, 
see “Topology Report” in Model Management. 

Application Reports

End User Management - 
Summary Reports

Multi-Profile Summary Report

Single Profile Summary Report

Performance Matrix Report
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End User Management - 
Business Process Reports

Availability Over Time Report

Response Over Time Report

Transaction Analysis Report

System Availability 
Management

Monitor Performance Report

Group Performance Report

Status Summary Report

Warning Summary Report

Error Summary Report

Application Reports
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2
Working in Reports

This chapter includes the main concepts, tasks, and reference information 
for Working in Reports.

This chapter includes:

Concepts

 ➤  Working in Reports - Overview on page 40

 ➤  Generating Reports on page 41

 ➤  Report Annotation on page 44

 ➤  Viewing Reports with Adobe Flash Player on page 44

Tasks

 ➤  Generate Reports on page 45

 ➤  Configure Report Generation Settings on page 48

 ➤  Enable Font When Exporting to a PDF on page 48

Reference

 ➤  Working in Reports User Interface on page 50

Troubleshooting and Limitations on page 72
Concepts
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Working in Reports - Overview

Reports consist of charts and tables that help you track and analyze the 
health of your monitored environment. You view and generate reports, as 
well as drill down and apply various filtering criteria to examine 
performance trends and pinpoint the cause of availability and performance 
issues.

Reports enable you to examine and analyze the data that HP Business 
Availability Center collects. When generating reports, you can specify 
various report settings, including time range and resolution, profile, 
grouping, and filters.

You can also customize reports by adding a header and a footer, by selecting 
to automatically or manually generate the report, or by customizing other 
display elements. For details, see “Report Manager” on page 93. 

For details on navigation functions, see “Navigating HP Business Availability 
Center” in Platform Administration.

Note: HP Business Availability Center presents certain reports within the 
context of transaction thresholds. For details on configuring transaction 
thresholds, see “Transaction Threshold Settings” in Using End User 
Management.

The Annotation Tool enables you to generate a snapshot of select reports on 
which you can highlight important areas of the report. For details, see 
“Report Annotation” on page 44.

Certain user interface elements are common to most report pages. For 
details, see “Common Report Elements” on page 56.
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Generating Reports

You generate reports to enable receiving data in an organized format. 
Certain reports are initially generated automatically, whereas for others you 
must specify report criteria and generate the report manually. For a list of 
report elements used for report generation that are common to most 
reports, see “Common Report Elements” on page 56.

You can configure HP Business Availability Center to generate reports 
automatically after selecting the report from the menu or to generate reports 
only on demand from within the report. For details, see “Configure Report 
Generation Settings” on page 48.

You can configure the time range and granularity for which the report 
should be generated. The granularity determines how many measurement 
samples are displayed in the report per time interval. By default, reports are 
limited to a maximum of 32 samples (trend reports have a maximum of 50 
samples). Thus, for example, if you select the “Day” time range and the 
“minutes” granularity, since there are 1,440 minutes in a day and a 
maximum of 32 samples on a chart, the granularity ranges from “every 45 
minutes” (1440/32=45) to “every 59 minutes” (above 59 minutes, you use 
the “hour” granularity unit).

Additional examples:

➤ If you select the Day time range and a granularity of every 1 hour, the 
report is displayed using 24 samples (1 hour x 24 = 1 day).

➤ If you select the Month time range and a granularity of every 1 week, the 
report is displayed using 4 samples (1 week x 4 = 1 month). 

You can modify the allowed number of samples in reports in the 
Infrastructure Settings Manager. To do so, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, click Foundations, select End 
User/System Availability Management, and locate the Max Data Points in 
Report parameter entry in the Data table. Modify the value to the required 
amount.

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.
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Note: 

➤ In certain reports, the selected time range is displayed along the x-axis. 
HP Business Availability Center breaks down the time range according to 
segments that differ depending on the selected time range. For details, 
see “Report Times” in Reference Information.

➤ Depending on the time range you select, HP Business Availability Center 
generates reports using either raw data or aggregated data. A note is 
displayed in the report when aggregated data is used. For details, see 
“How Reports Use Aggregated Data” in Reference Information.

For details on configuring the time range and granularity for reports, see 
“Time Range and Granularity Bar” on page 70.

You can generate reports from the following locations in HP Business 
Availability Center.

➤ In the various Reports tabs located in the End User Management, Service 
Level Management, and System Availability Management contexts under 
the Applications menu item.

➤ In the Report Manager, accessed from the User Reports context under the 
Applications menu item. For details on the Report Manager, see “Report 
Manager” on page 93.

You apply filtering criteria to examine performance issue trends and 
pinpoint the cause of availability and performance issues. You can save your 
filter configurations as a Favorite Filter, to be used again for generating other 
reports of the same report type. For details, see “Save Filter to Favorites 
Dialog Box” on page 69.

You can also generate a Favorite Filter from outside the reports pages, using 
the Favorite Filters wizard in the Report Manager. For details, see “Favorite 
Filters Wizard” on page 107.

You can also choose from various options for publishing a report, for 
individuals who do not usually work with HP Business Availability Center. 
For details on publishing reports, see “Publishing a Report” on page 43.



Chapter 2 • Working in Reports

43

Publishing a Report
You can generate up-to-date reports that can be viewed by users who do not 
usually work with HP Business Availability Center, and, therefore, do not 
know how to create reports. However, these users must have a network 
connection to HP Business Availability Center to view the report. You 
publish the reports in .csv format, Excel format, .xml format, or printer-
friendly format, and send the report (generally, by email) to the user. 

The report contains data that is updated when the report is accessed. For 
example, say you prepare a report for the past month (24 Oct 2005 8:00 AM 
– 21 Nov 2005 8:00 AM), publish the report, and send the URL or an HTML 
file of the report to a user. The user accesses the report a week later (on 28 
Nov 2005), at which time the report shows the updated past month 
(31 Oct 2005 8:00 AM – 28 Nov 2005 8:00 AM).

If you define a time period using the Custom option, the report always 
shows data reflecting the customized time period, no matter when the user 
accesses the report.

You would probably publish reports that use a relative tracking period (for 
example, past month, month to date), as it may not be useful to publish 
reports that use an absolute tracking period (for example, hour, day, 
month).

You can choose between two methods for publishing reports: URL and 
HTML. Use URL to submit the form with a GET method (recommended), 
and HTML to submit the form with a POST method.

Tip: When publishing a report, choose only from tracking periods that show 
data when the user accesses the report. For example, if you know that the 
monitor being tracked by the profile is going down shortly, and you are 
setting up a report to show data, ensure that you have configured the report 
to show data for a time when the monitor is up and running. Otherwise, the 
user’s report does not include data. 

For details on the user interface for publishing a report, see “Publish Report 
Dialog Box” on page 63.
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Report Annotation

The Annotation Tool creates a snapshot of the report you are viewing and 
enables you to highlight important areas of the report by drawing shapes, 
lines, and adding text to the snapshot. Annotated reports can be shown to 
others to emphasize exceptional areas of the report, uploaded to Report 
Manager, or and saved to your local directory.

The Annotation Tool is accessible by clicking the Annotation Tool button on 
the right side of the page.

The actions you can perform with your annotation are:

➤ Print the annotation

➤ Save a snapshot of the annotation in .png format to your local machine

➤ Send the annotation using email

For details on the user interface for creating an annotation, see “Annotation 
Tool Window” on page 50.

Viewing Reports with Adobe Flash Player

HP Business Availability Center utilizes Adobe Flash Player technology in 
selected reports to render report charts, to control the flow of information, 
and add interest to your reports. 

You must have Flash Player version 8.0 or later installed on your machine. If 
you do not, the browser displays a message containing instructions on 
downloading Flash Player. 

Pie charts in Flash reports have the following functionality, available via the 
context menu:

➤ Enable Rotation. When this option is selected, you can click and drag to 
rotate the pie. Toggles with Enable Slicing Movement.

➤ Enable Slicing Movement. When this option is selected, you can click a pie 
slice to slide it out from the main pie. Toggles with Enable Rotation.

➤ View 2D/View 3D. Toggle between these options as required.
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By default, the KPIs Distribution Over Time, KPIs Summary, and KPIs Trend 
reports (available in Dashboard and My BSM Business Dashboard) use Flash 
with a built-in one second delay for rendering the reports. If required, you 
can remove the delay (so that the reports are immediately displayed fully 
rendered). To remove the delay, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Reports Delay Time entry in the 
Business Reports Properties table. Modify the value to False.

Tasks

Generate Reports

This task describes how to generate reports to track and analyze the health 
of your monitored environment. 

This task includes the following steps:

➤ “Access the Report Page” on page 45

➤ “Choose the Time Range and Granularity” on page 45

➤ “Configure Report Parameters” on page 46

➤ “Save Filter to Favorites” on page 46

➤ “Results” on page 47

 1 Access the Report Page
Access the relevant report page where you want to configure reports. For 
details on the reports contexts, see “HP Business Availability Center 
Reports” on page 16.

 2 Choose the Time Range and Granularity
When generating a report, you choose the time range and granularity in 
which the report is displayed. For details on configuring the time range and 
granularity for reports, see “Time Range and Granularity Bar” on page 70.

For additional information on choosing the time range and granularity in 
Service Level Management, see “Tracking Range and Granularity in Service 
Level Management” in Using Service Level Management.
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 3 Configure Report Parameters
You configure the parameters of your report, and optionally apply filtering 
criteria to receive specific data for the report. For details on the various 
elements used to configure reports that are common to most reports, see 
“Common Report Elements” on page 56.

Example

 a Click Profiles and Active Filters links to select the relevant profiles and 
active filters to be monitored by the report. 

 b Choose the time range for the report in the Time Range and Granularity 
bar. 

 c Optionally, choose from the following: 

➤ Click the Format button to choose a format for production of the 
report.

➤ Click the Export button to choose a format in which to transfer the 
report data, either via email, publishing, or uploading to the Report 
Manager.

➤ Add annotations to the report. For details on the user interface for 
annotating reports, see “Annotation Tool Window” on page 50.

➤ Configure a Favorite Filter for the report. For details on the user 
interface for performing this task, see “Save Filter to Favorites Dialog 
Box” on page 69.

 d Click Generate to generate the report.

 4 Save Filter to Favorites
Optionally, you can save your configured report filters to be used again for 
generating other reports. For details on the user interface for configuring a 
favorite filter, see “Save Filter to Favorites Dialog Box” on page 69.
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Example

Click the Favorite Filters button on the right side of the screen to open the 
Save Filter to Favorites dialog box.

After saving, the filter appears under the specified access level (Private or 
Public) in the Favorite Filters drop down.

You select a Favorite Filter and click Generate to generate a report according 
to the specific filter’s parameters. 

 5 Results
The report’s parameters appear in the collapsible pane above the report.

If you configured a Favorite Filter for the report, you can select the 
configured filter from the Favorite Filters drop down. The selected filter is 
now configured as the parameters by which the new report is generated.
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Configure Report Generation Settings

To configure the report generation settings in HP Business Availability 
Center, users with appropriate administrative privileges should perform the 
changes described in the procedure below. 

Note: You must have appropriate administrative privileges to configure 
these settings.

To configure report generation settings for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Foundations, select Reporting and locate the Generate reports 
automatically entry in the Reporting-Display table. 

 2 Click the Edit button  and set the property value as required:

➤ Select true to enable automatic report generation

➤ Select false to disable automatic report generation

To restore default settings, click the Restore Default button.

Enable Font When Exporting to a PDF

You can optionally configure Unicode font to display characters in most 
languages when exporting a report to a PDF. 

You can configure Unicode font either using the Infrastructure Settings 
Manager, or by installing the font to the font library on your system.

To configure Unicode font using the Infrastructure Settings Manager:

 1 Navigate to Admin > Platform > Setup and Maintenance > Infrastructure 
Settings. 

 2 Select Foundations and choose Reporting. 

 3 Locate the Reporting - Display table.
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 4 Modify the Unicode font path for PDF attribute to the path of the Unicode 
font located on the server. 

➤ For Windows: C:\Windows\Font_Location\arialuni.ttf

➤ For UNIX: /opt/tmp/arialuni.ttf

To configure Arial Unicode MS font using the font library:

 1 Navigate to the font library on your system: 

For example, in Windows: C:\Windows\Fonts

 2 Download the font from the following web site: 

http://www.microsoft.com/typography/fonts/family.aspx?FID=24

 3 Restart HP Business Availability Center.
Reference
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Working in Reports User Interface

This section describes:

 ➤  Annotation Tool Window on page 50

 ➤  Common Report Elements on page 56

 ➤  Export Options on page 61

 ➤  Format Options on page 68

 ➤  Save Filter to Favorites Dialog Box on page 69

 ➤  Time Range and Granularity Bar on page 70

Annotation Tool Window

Annotation Options

Description Enables you to annotate a snapshot of the report you are 
viewing, to highlight important areas.

To access: Click the Annotate button  on the right 
side of the page.

Important 
Information

When saving the annotation: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories. 

Included in Tasks “Generating Reports” on page 41

Useful Links “Report Annotation” on page 44

Description The elements which enable you to customize your 
snapshot.

To access: Click the Annotate button  on the right 
side of the report page. The annotation options are 
located on the left side of the annotation window.

Useful Links “Report Annotation” on page 44
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The following elements are included:

GUI Element (A–Z) Description

Click to navigate the snapshot.

Click to select a specific area of the snapshot.

Click to add a shape to the snapshot. Clicking the shape 
tool button enables the following shape buttons:

➤  Click to mark an area of the snapshot with a 
rectangle.

➤  Click to mark an area of the snapshot with a filled 
rectangle.

➤  Click to mark an area of the snapshot with an 
oval.

➤  Click to mark an area of the snapshot with a filled 
oval.

➤  Click to mark an area of the snapshot with a 
round rectangle. 

➤  Click to mark an area of the snapshot with a filled 
round rectangle. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation.
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Click to enable the line tool, which marks the selected 
area of the snapshot with a line. 

Customization. After selecting this button, you can 
customize your line appearance through the following 
parts of the interface:

➤ Line Style. Choose the style of line you want to add. 
Options include: 

➤ Regular line

➤ Line with endpoints

➤ Line with arrows

➤ Line Type. Choose the type of line you want to add. 
Options include:

➤ Solid Line

➤ Jagged Line

➤ Line Width. Select the width of the line, in pixels, in 
the annotation. 

Click to add text to the snapshot.

Example: Add, This is the problematic transaction above a 
line marking an area of the report.

GUI Element (A–Z) Description
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Border and Fill Colors Select the relevant square to choose the color of the 
border and fill of your annotations. The available squares 
are:

➤ Upper Square. Click to choose the color of lines, as 
generated by the line tool and displayed in unfilled 
shapes. 

➤ Lower Square. Click to choose the color to fill shapes.

Clicking either of the squares generates a dialog box with 
the following tabs where you choose the color:

➤ Swatches 

➤ HSB

➤ RGB

Opacity Slide the opacity bar to choose the darkness level of the 
selected shape line, text line, or shape color in the 
annotation. 

Note: 

➤ A higher opacity percentage means that the selection 
appears darker. A lower opacity percentage means that 
the selection appears lighter.

➤ This field is enabled when either the shape tool, line 
tool, or text tool button is selected.

GUI Element (A–Z) Description
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Menu Bar

The following elements are included:

Description Displays the elements which enable you to perform 
selected actions on your snapshot. 

To access: Click the Annotate button  on the right 
side of the report page.

The menu bar contains elements which enable you to:

➤ Change the appearance of the snapshot.

➤ Save, print, email, or upload an annotation report to 
the Report Manager.

➤ Customize the appearance of text annotated onto your 
snapshot. These elements are enabled only when the 
Text Tool button  is selected.

Useful Links “Report Annotation” on page 44

GUI Element (A–Z) Description

Click to save the snapshot on your local machine.

Note: 

➤ The snapshot is saved in .png format.

➤ You cannot select the New Folder icon  when 
saving in the My Documents directory or any of its 
subdirectories. 

Click to select all of the annotations added to your 
snapshot.

Click to clear all annotations.

Click to undo the most recent action performed on the 
snapshot.

Click to redo the most recent action performed on the 
snapshot.

Click to bring the snapshot view closer.
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Click to set the snapshot view further away.

Click to restore the snapshot to its original size.

Click to print the snapshot.

Click to send the snapshot via email.

Click to upload the snapshot to the Report Repository. 
For details on the Report Repository, see “Report Manager 
Overview” on page 94. 

Note: This option is not available when accessing the 
Annotation Tool from the SiteScope feature.

Click for help.

Click to mark the text as bold. 

Note: This field is enabled only when selecting the Text 
Tool button . 

Click to mark the text as italicized. 

Note: This field is enabled only when selecting the Text 
Tool button . 

Click to mark the text as underlined. 

Note: This field is enabled only when selecting the Text 
Tool button . 

<Font Family> Select the font for the text in the report.

Note: This field is only enabled when selecting the Text 
Tool button . 

GUI Element (A–Z) Description



Chapter 2 • Working in Reports

56

Common Report Elements

<Font Size> Select the size of the font in the report. 

Note: This field is only enabled when selecting the Text 
Tool button . 

Anti-aliasing Select to make adjust the pixel reading of text or 
annotation lines so that they appear smoother. 

Note: This field is only enabled when selecting the Text 
Tool button . 

Description The options that are common to most report pages.

Important 
Information

➤ You may see only a few of the items described below in 
your report. Report elements specific to a certain 
application are described within that application’s 
documentation.

➤ Reports contain a collapsible report filter which 
includes the specified elements noted in the 
description cells below. Many of these elements appear 
in other reports as well. Click the Minimize  or 
Restore  button to collapse or expand the report 
filter, respectively.

Note: When the collapsible report filter is hidden, the 
filter information is visible through a tooltip that 
appears when hovering anywhere on the report title 
bar.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

After you have specified the report criteria, click 
Generate to generate the report (in certain 
applications, such as Business Availability Center 
for Siebel Applications, reports are generated 
automatically when the page is loaded).

Certain reports are initially generated 
automatically, whereas for others you must specify 
report criteria and generate the report manually. 
For details on setting reports to be automatically 
generated, see “Configure Report Generation 
Settings” on page 80.

Click to send the report via email. For details, see 
“Mail Details Dialog Box” on page 62. 

Note. This button is accessible as a sub-option of 
the Export button , and on the report 
interface for legacy reports. For a list of legacy 
reports, see “Legacy Reports” on page 36. 

Divides a table of data or a list of reports into pages. 
You move from page to page by clicking the 
relevant button:

➤ To view more reports, click the Next page or 
Last page buttons.

➤ To view previous reports in the list, click the 
Previous page or First page buttons.

➤ Click the left arrow to adjust the time range of 
the report backwards according to the 
granularity displayed in the View dropdown. 

➤ Click the right arrow to adjust the time range of 
the report ahead, according to the granularity 
displayed in the View dropdown.

Click the Sort Up button to display an alphabetical 
list in the column you chose.
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Click the Sort Down button to display a reverse 
alphabetical list in the column you chose. 

Click to reset the table columns’ width to its 
default setting. You can adjust the width of the 
table’s columns by dragging the borders of the 
column to the right or the left.

Click the Select Columns button to open the Select 
Columns dialog box and select the columns you 
want to be displayed on the table. 

For details on the Select Columns dialog box, see 
“Working with Tables” in Reference Information.  

Click the Format button to drill down for options 
on formatting your report. You can then save the 
report to your local machine. For details on format 
options, see “Format Options” on page 68.

Note: Many of format options are available as 
individual buttons on HP Business Availability 
Center legacy reports. For a list of HP Business 
Availability Center legacy reports, see “Legacy 
Reports” on page 36. 

Click the Export button to drill down for options 
on exporting your report. For details on export 
options, see “Export Options” on page 61.

Note: The Export button is not available in 
HP Business Availability Center legacy reports. For 
a list of HP Business Availability Center legacy 
reports, see “Legacy Reports” on page 36.

Click the Capture result and add annotations 
button to capture the report and add annotations. 
For details on annotating reports, see “Report 
Annotation” on page 44.

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 36.

GUI Element (A–Z) Description
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Click the Save Filter button to open the Save Filter 
to Favorites dialog box and configure the current 
filter as a favorite filter. For details on Favorite 
Filters, see “Save Filter to Favorites Dialog Box” on 
page 69. 

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 36.

<breadcrumbs> The list of pages appearing horizontally across the 
top of the page that you have navigated through to 
get to the current page. 

Note: Each page in the list of breadcrumbs is a link 
which you can click to trace your path of 
navigation.

<calendar> Enables you to configure the day, month, year, and 
specific time that the report is to start and end. The 
Calendar dialog box also contains the following 
buttons: 

➤ Revert. Click to return the calendar to the most 
recently saved configuration.

➤ Current. Click to configure the calendar with the 
current date and time. 

Note: The date and time that are configured 
correspond to the time you opened the calendar 
dialog box. 

<color coding> HP Business Availability Center uses color coding 
in reports to organize data in a meaningful way, 
and make reports more readable.

Use the legend that appears in a report to get a 
basic description of the color coding used in the 
report. For detailed information about a specific 
report and how to interpret the color coding used, 
refer to that report’s documentation.

GUI Element (A–Z) Description
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<Time Range and 
Granularity Bar>

Located at the top of the report area. Displays the 
currently selected report date, time frame, and 
granularity. For details, see “Time Range and 
Granularity Bar” on page 70.

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
see “Legacy Reports” on page 36.

Profile Click the link to select the profile to be monitored 
by the report.

Note: This element is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 36. 

View as Graph tab Click to display a graphical representation of the 
data. This is generally the default view.

View as Table tab Click to display a tabular representation of the 
data.

GUI Element (A–Z) Description



Chapter 2 • Working in Reports

61

Export Options

The following exporting options are available when clicking the Export 
button:

Description Enables you to export a report or report item, either by 
sending it through email, publishing it, or creating a PDF 
to be sent to the Report Manager. 

To access: Click the Export button  on the right side 
of the report page. 

Important 
Information

The only Export option available in HP Business 
Availability Center legacy reports is the email option. For 
a list of HP Business Availability Center legacy reports, 
see “Legacy Reports” on page 36. 

Useful Links “Common Report Elements” on page 56

GUI Element (A-Z) Description

Click to send a report using email. For details, see “Mail 
Details Dialog Box” on page 62. 

Note: The Email button is also available on the report 
screen of HP Business Availability Center legacy reports. 
For a list of HP Business Availability Center legacy 
reports, see “Legacy Reports” on page 36. 

Click to publish a report with updated data. For details, 
see “Publish Report Dialog Box” on page 63. 

Note: The Publish button is not available in HP Business 
Availability Center legacy reports. For a list of 
HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 36.

Click to create a PDF of the report and export it to Report 
Manager. For details on Report Manager, see “Report 
Manager” on page 93.

Note: The Report Manager button is not available in 
HP Business Availability Center legacy reports. For a list 
of HP Business Availability Center legacy reports, see 
“Legacy Reports” on page 36.
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Mail Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure a report to be sent via email. 

To access: Click the Export button  and select Email. 

Important 
Information

If you choose to use a mail option that displays the 
report content in the email client, verify that the email 
client does not employ security restrictions which 
prevent the running of scripts contained in HTML mail. 
Email clients that do employ such restrictions may be 
unable to properly display all report content.

Useful Links “Export Options” on page 61

GUI Element (A-Z) Description

Comments Enter relevant comments, if required. 

Include Images Select to include all report resources (for example, 
graphics) in the email.

Clear to remove images from the email. The images are 
then located on HP Business Availability Center servers. 
A network connection to HP Business Availability Center 
is required to access HP Business Availability Center 
servers and view the report images.

Reply-to Enter an email address for receiving replies.

Note: If required, an email address can be configured to 
appear in the Reply-to field by default. This is done in the 
Infrastructure Settings Manager. Select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, click 
Foundations, select Business Availability Center, and 
locate the Default Reply-To Address entry in the Business 
Availability Center Interface - Display table. Update the 
value as required.
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Publish Report Dialog Box

Send as Internet 
Explorer Archived 
HTML (.mht)

All report resources (for example, graphics) are displayed 
in the browser, which must support MHT format (such as 
Microsoft Internet Explorer). It is not necessary to have a 
connection to an HP Business Availability Center 
machine to enable you to view the attachment.

Send Report As Specify the format in which you want to send the report. 
Choose from the following options:

➤ HTML mail. The report is displayed in the email client 
(the email client must support, and be configured to 
display, HTML)

➤ HTML attachment. The report is displayed in HTML 
format in a browser. 

Note: You must have a connection to an HP Business 
Availability Center machine to enable you to view the 
attachment. 

➤ PDF. The report is displayed in .pdf format in a new 
browser window. 

Subject Enter a descriptive subject, or accept the default value.

To Enter an email address to which you want to send the 
report.

Zipped Attachment Select to send the attachment in zipped format. 

Note: This field is available only when HTML attachment 
or PDF have been selected in the Send Report As field. 

Description Enables you to publish HP Business Availability Center 
reports in different formats for other users to view. 

To access: Click the Export button  on the right side 
of the report page, and select Publish Report . 

Important 
Information

The log in and log out steps to view the report are 
transparent to the user.

Useful Links “Publishing a Report” on page 43

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Choose export 
format

Choose the export format for the report. The available 
options are: 

➤ CSV. The report is formatted as a comma-separated 
values (CSV) text file that can be displayed in a 
spreadsheet.

Note: For the CSV formatted report to display 
correctly, the comma (,) must be defined as the list 
separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the 
Control Panel, and on the Numbers tab ensure that 
the comma is defined as the List Separator value. In 
Solaris, you can specify the list separator in the 
application that opens the CSV file.

➤ Excel. The report is formatted as an .xls (Excel) file that 
can be displayed in a spreadsheet.

Note: Any tooltips in the report are converted to 
comments in Microsoft Excel. To view all the text of a 
large tooltip, edit the comment by right-clicking the 
cell and choosing Edit Comment. Enlarge the box by 
dragging a corner of the comment box. 

➤ XML. The report is formatted as an XML file that can 
be opened in a text or XML editor. 

Tip: To extract HTML code from the report: 

1. Save the file as HTML

2. Open the file in an HTML editor

3. Copy the relevant table into the target file 

➤ Printer-Friendly. The report is saved in HTML format 
for printing purposes.
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Generate HTML Click to send the report as an HTML file. You can open or 
save the file on your local machine. 

Note:

➤ The user name and password are encrypted in the 
HTML file.

➤ If you include your own user name and password in 
the HTML file, when the user closes the report, you are 
simultaneously logged out of HP Business Availability 
Center. 

Generate URL Click to generate the URL and displays it in the resulting 
Published URL window. 

Click Copy to select the URL, then paste the URL into an 
email to send to the user. 

Note: 

➤ It is recommended that the URL not exceed a 
maximum length of 2,000 characters (~2K), to ensure 
that the URL can be read by all systems.

➤ Do not modify the URL string. If necessary, make 
changes to the report itself, then publish the report 
again.

➤ The user name and password are encrypted in the URL 
file.

➤ If you include your own user name and password in 
the URL, when the user closes the report, you are 
simultaneously logged out of HP Business Availability 
Center. 

GUI Element (A-Z) Description
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Save as PDF to Report Manager Dialog Box

Login name 
transmitted with 
report

The login name by which the report recipient can login 
to HP Business Availability Center and view the report. 

Note: 

➤ The default login name is that with which you logged 
in to HP Business Availability Center in the current 
session.

➤ Do not publish the report with administrator 
permissions. It is recommended that you create a login 
name and password for the user with less permissions 
than for an administrator. For details, see “User 
Management – Overview” in Platform Administration. 

Password 
transmitted with 
report

The password by which the report recipient can login to 
HP Business Availability Center and view the report.

Note: 

➤ The default password is that with which you logged in 
to HP Business Availability Center in the current 
session.

➤ Do not publish the report with administrator 
permissions. It is recommended that you create a login 
name and password for the user with less permissions 
than for an administrator. For details, see “User 
Management – Overview” in Platform Administration. 

Description Enables you to configure parameters of the report you 
want to save as a PDF to the Report Manager. 

To access: Click the Export button  and select Save 
as PDF . 

Useful Links “Report Manager” on page 93

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<report snapshot> A snapshot of the selected report, as it currently appears.

Description Optionally, enter a description for the report.

Report name Enter a name for the report, to be displayed in the Report 
Manager.

Save report as Choose the privilege level of the report, as per the 
following options: 

➤ Private. The report or report object is available only to 
the user who configured it or an administrator.

➤ Public. The report or report object is available to 
administrators or any user with appropriate 
permissions.
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Format Options

The following formatting options are available when clicking the Format 
button.

Description Enables you to format the report in a specific format to 
be saved on your local machine. 

To access: Click the Format button  on the right 
side of the report page. 

Important 
Information

Many of the Format options are available as individual 
buttons on the right side of HP Business Availability 
Center legacy reports. For a list of HP Business 
Availability Center legacy reports, see “Legacy Reports” 
on page 36. 

Useful Links “Common Report Elements” on page 56

GUI Element (A-Z) Description

Click to send a report to a printer. 

Tip: Before printing, ensure that printer settings are set to 
print the selected frame, and not to print frames as laid 
out on screen. 

To obtain optimal print results if you are using Microsoft 
Internet Explorer, enable the Print background color and 
images option (Tools > Internet Options > Advanced tab 
> Printing). 

Click to produce a .pdf format file. 

Note: To enable displaying characters in all languages in 
your .pdf file, you must configure the Infrastructure 
Settings Manager to access the appropriate Unicode file 
on your server. For details on performing this task, see 
“Enable Font When Exporting to a PDF” on page 48. 
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Save Filter to Favorites Dialog Box

Click to produce a .csv format file. 

Note: For the CSV formatted report to display correctly, 
the comma (,) must be defined as the list separator. In 
Windows, to verify or modify the list separator value, 
open Regional Options from the Control Panel, and on 
the Numbers tab ensure that the comma is defined as the 
List Separator value. In Solaris, you can specify the list 
separator in the application that opens the CSV file. 

Click to produce an Excel format file. 

Note: You cannot export information from charts into 
Microsoft Excel.

Click to produce an .xml format file. 

Note: Only those reports that support this functionality 
include the XML button.

Description Enables you to save the current filter to your list of 
Favorite Filters, to be used for generating a new instance 
of the same report type for which you created the filter.

To access: Click the Save Filter button  on the right 
side of the report page.

Important 
Information

You can view saved filters by selecting the specific filter 
in the Favorite Filters drop-down window.

Included in Tasks “Generate Reports” on page 45

Useful Links “Generating Reports” on page 41

GUI Element (A-Z) Description



Chapter 2 • Working in Reports

70

The following elements are included:

Time Range and Granularity Bar

GUI Element (A–Z) Description

Filter Description Enter a description for the filter you are creating. The 
description appears only in the list of Favorite Filters in 
the Report Manager. 

Filter Name Enter a descriptive name for the filter you are creating.

Report Name The name of the report for which you are creating a 
favorite filter. 

Note: This field cannot be edited. 

Save Report As Choose the access level for which you want to save your 
report.

➤ Private. Only the report organizer can view the report 
generated by the filter.

➤ Public. All users with appropriate permission levels can 
view the report generated by the filter.

Description Displays the time range and granularity for which the 
report is generated.

To access: Access the top portion of the report screen, or 
click the Restore button  at the top of reports to open 
the collapsible filter pane.

Important 
Information

➤ The Time Range and Granularity bar is not available in 
HP Business Availability Center legacy reports. For a 
list of HP Business Availability Center legacy reports, 
see “Legacy Reports” on page 36.

➤ For reports that are divided by time units, you select a 
report granularity or accept the default granularity. 
From the granularity value and granularity unit lists 
(labeled Every), you select the granularity for the 
report.

➤ Not all time ranges are available for all reports.
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The following elements are included:

Included in Tasks “Report Annotation” on page 44

Useful Links “Generating Reports” on page 41

GUI Element (A–Z) Description

Click to view the report one time frame earlier than the 
currently displayed time frame. 

Tooltip: Back

Example: If the value of the View field is Day, clicking 
this button displays data for one day earlier than the 
currently displayed report.

Click to view the report one time frame later than the 
currently displayed time frame. 

Tooltip: Forward

Example: If the value of the View field is Day, clicking 
this button displays data for one day later than the 
currently displayed report.

Every Select the report granularity level, or the time frame 
indicating the frequency of how often you want the 
report to be generated. Depending on the time range 
selected in the View field, the following options may be 
available:

➤ Hour

➤ Day

➤ Week

➤ Month

From Click the link to open the calendar and configure a start 
date and time for the report.
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Troubleshooting and Limitations

Following are troubleshooting and limitations relating to various areas of 
Working in Reports:

Annotating a Report

You cannot select the New Folder icon  when saving an annotation in 
the My Documents directory or any of its subdirectories.

Formatting a Report

➤ When exporting a report to Microsoft Excel, if you are using Microsoft Excel 
2007, an error message is generated. Click OK to close the error message 
window and display the data in Microsoft Excel. 

➤ You cannot export information from charts into Microsoft Excel.

To Click the link to open the calendar and configure an end 
date and time for the report.

View Select a time range for which you want to view the 
report. Available time ranges include the following 
ranges:

➤ Past hour, Past day, Past week, Past month, Past 
quarter, Past year

➤ Hour, Day, Week, Month, Quarter, Year

➤ Custom (a user defined time period)

Note: The available granularity units (minute, hour, day, 
week, month, year) differ depending on the selected time 
range and the specific report, and the granularity values 
differ per granularity unit.

GUI Element (A–Z) Description
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Generating a Report

If you configure a report with a time range that does not end in the present 
(for example, two days ago, three days ago, two days from now, three days 
from now), when you click Generate to generate the report, the report time 
range remains as it was originally configured and does not update itself to 
end in the present. 

Viewing a Report

If you are having trouble viewing a specific report, you may require Flash 
player to properly view the report. Install Flash player on your machine, and 
then try accessing the report again. For details on viewing reports with 
Adobe Flash player, see “Viewing Reports with Adobe Flash Player” on 
page 44. 

Publishing a Report

When producing a hierarchal UCMDB report, the size of the .pdf is limited 
to the default number of data units defined for your environment. The 
default value is 400. A data unit is the information displayed under a CI in a 
report. In a table, each row is counted as one data unit. If this value does not 
suit your needs and must be modified, contact HP Software Support. 

If the file you are producing contains more than the allotted number of data 
units, the .pdf file is truncated.

The affected UCMDB reports are: 

➤ Topology Report. For details, see “Topology Report Page” in Model 
Management.

➤ Asset Report. For details, see “Asset Report Page” in Model Management.

➤ Related CIs Report. For details, see “Get Related CIs Report” in Model 
Management.

➤ Correlation Report. For details, see “Correlation Manager Window” in Model 
Management.

➤ Export to Report. For details, see “Package Manager Window” in Model 
Management.
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3
Customizing Reports

This chapter describes how to generate reports automatically or manually, 
and how to specify a header and a footer for a report.

This chapter includes:

Concepts

 ➤  Customizing Reports - Overview on page 75

 ➤  Configuring a Report Header and Footer on page 76

Tasks

 ➤  Customize Report Settings in the Infrastructure Settings Manager on page 78
Concepts

Customizing Reports - Overview

You can specify various settings in the HP Business Availability Center 
Infrastructure Settings manager to enable you to customize the look and 
display of your HP Business Availability Center reports. 

HP Business Availability Center enables you to choose from the following 
customizing options:

➤ Specify a header and a footer for reports. For details, see “Configuring a 
Report Header and Footer” on page 76.

➤ Specify the default browser. For details, see “Specify the Default Browser” on 
page 78.

➤ Generate reports automatically. For details, see “Configure Report 
Generation Settings” on page 80.
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➤ Customize the display of global reports. For details, see “Customize the 
Global Reports Display” on page 81.

➤ Configure the maximum number of data units exportable to .pdf. For 
details, see “Configure the Maximum Number of Data Units Exportable to 
PDF” on page 81.

➤ Configure the maximum number of rows per table. For details, see 
“Configure the Maximum Number of Rows Per Table” on page 82.

➤ Customize the display of specific reports. For details, see “Customize the 
Specific Reports Display” on page 82.

Note: HP Business Availability Center also enables you to customize the 
look and layout of specific reports (customizable reports). Contact HP 
Software Support to assist you in performing this type of report 
customization.

Configuring a Report Header and Footer

You can add a header and a footer to a report. You can also modify an 
existing header and footer or return to the default header and footer (blank).

You can add a header or footer in one of the following ways: 

➤ Configure a global report header and footer in the Infrastructure Settings 
Manager. 

The global report header and footer has the following characteristics:

➤ The text of the header/footer has to be valid HTML.

➤ The changes take effect immediately.

➤ The change is applied to all the customizable reports.

➤ The header/footer is static. It remains displayed on the page while you 
scroll the report lines.
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For example, if you specify the header <b>Today’s Results</b>, the header 
appears with a bold font.

As another example, if you specify the footer <center>Per User</center> the 
report shows the footer aligned to the center of the report.

For details on configuring a global header and footer, see “Configure the 
Global Report Header and Footer” on page 79.

➤ Configure a default header and footer for all Custom and Trend reports in the 
Report Manager. For details, see “Default Header/Footer Dialog Box” on 
page 118.

➤ Configure a header and footer for a specific user report via the selected 
report wizard in the Report Manager. For details, see “Header/Footer Page” 
on page 157 (for Custom Reports), or “Header/Footer Page” on page 198 (for 
Trend Reports).

The report header and footer you add for the specific user report in the 
appropriate wizard overrides the default header and footer configured for all 
custom and trend reports in the Report Manager. The default header and 
footer configured for all custom and trend reports via the Set default header 
/ footer for Custom & Trend reports button in the Report Manager overrides 
the global report header and footer configured in the Infrastructure Settings 
Manager. 

Tasks
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Customize Report Settings in the Infrastructure Settings 
Manager

You can perform the following report customization settings in the 
Infrastructure Settings Manager:

➤ Specify the Default Browser. For details, see “Specify the Default Browser” 
on page 78.

➤ Configure the Global Report Header and Footer. For details, see “Configure 
the Global Report Header and Footer” on page 79.

➤ Configure Report Generation Settings. For details, see “Configure Report 
Generation Settings” on page 80.

➤ Customize the Global Reports Display. For details, see “Customize the 
Global Reports Display” on page 81.

➤ Configure the Maximum Number of Data Units Exportable to PDF. For 
details, see “Configure the Maximum Number of Data Units Exportable to 
PDF” on page 81.

➤ Configure the Maximum Number of Rows Per Table. For details, see 
“Configure the Maximum Number of Rows Per Table” on page 82.

➤ Customize the Specific Reports Display. For details, see “Customize the 
Specific Reports Display” on page 82.

Specify the Default Browser
You can specify the default browser to view reports in. 

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting-Display area.

 3 Click the Edit button next to the Default Browser setting to open the 
Default Browser dialog box.
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 4 Set the Value field as required:

➤ select true to enable Internet Explorer

➤ select false to enable another browser

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Global Report Header and Footer
You can configure the global header and footer that appears for all reports.

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 To specify a header:

➤ Click the Edit button next to the Display static report header setting to 
open the Display static report header dialog box.

➤ In the Value box, enter the text of the header.

➤ Click Save to save the changes.

To restore default settings, click the Restore Default button.

 4 To specify a footer:

➤ Click the Edit button next to the Display static report footer setting to 
open the Display static report footer dialog box.

➤ In the Value box, enter the text of the footer.

➤ Click Save to save the changes.

To restore default settings, click the Restore Default button.

Note: The header and footer configured either using the Set default header 
/ footer for all Custom & Trend reports button or the User Report Wizard in 
the Report Manager overrides the global report header and footer. 



Chapter 3 • Customizing Reports

80

Configure Report Generation Settings
You can configure HP Business Availability Center to generate reports 
automatically after selecting the report from the menu or to generate reports 
only on demand from within the report. 

To configure these settings, users with appropriate administrative privileges 
should perform the changes described in the procedure below.

Note: You must log in again for the changes to take effect.

To configure report generation settings for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting-Display area.

 3 Click the Edit button next to the Generate reports automatically setting to 
open the Generate Reports Automatically dialog box.

 4 Set the property value as required:

➤ select true to enable automatic report generation

➤ select false to disable automatic report generation

 5 Click Save.

To remove automatic report generation, set the property back to false.

To restore default settings, click the Restore Default button.
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Customize the Global Reports Display
You can customize the appearance of your reports by configuring display 
elements to be applied to all reports.

To customize the global display for reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Global reports display customization 
setting to open the Global reports display customization dialog box.

 4 Enter the XML script in the Value field for the report components you want 
to customize. A sample configuration file is located at: 

<HP Business Availability Center root 
directory>\HPBAC\AppServer\webapps\site.war\WEB-
INF\rfw\conf\internal\rfw-presentation.xml

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Maximum Number of Data Units 
Exportable to PDF
You can configure the maximum number of data units that can be 
presented when exporting hierarchic reports in .pdf format. 

To configure the maximum amount of data units exportable to .pdf:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Maximum number of data units exportable 
to .pdf setting to open the Maximum number of data units exportable to 
.pdf dialog box.
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 4 Enter the number of data units you want to set as the maximum number 
exportable to a hierarchic .pdf report in the Value field.

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Configure the Maximum Number of Rows Per Table
You can configure the maximum number of rows that are presented when 
generating a table in a report.

To configure the maximum number of rows per table:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Maximum number of rows per table 
setting to open the Maximum number of rows per table dialog box.

 4 Enter the maximum number of rows in the Value field you want displayed 
in the table. 

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.

Customize the Specific Reports Display
You can customize the appearance of your reports by configuring display 
elements to be applied to specific reports. 

To customize the display for specific reports:

 1 Select Admin > Platform > Setup and Maintenance > Infrastructure Settings 
> Foundations.

 2 Select Reporting to open the Reporting - Display area.

 3 Click the Edit button next to the Specific report display customization 
setting to open the Specific reports display customization dialog box.
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 4 Enter the XML script in the Value field for the report components you want 
to customize. A sample configuration file is located at: 

<HP Business Availability Center root 
directory>\HPBAC\AppServer\webapps\site.war\WEB-
INF\rfw\conf\applications\*-presentation.xml

 5 Click Save to save your settings.

To restore default settings, click the Restore Default button.
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4
Reports Log

HP Business Availability Center logs all activities related to reports as well as 
errors that occur when generating reports. Such activities include: creating a 
new report, generating a report, modifying report filters, drilling down in 
reports, and so forth. 

This chapter includes:

Concepts

 ➤  Reports Log - Overview on page 85

 ➤  Reports Log Level on page 87

Tasks

 ➤  Set the Reports Log Level on page 88

Reference

 ➤  Reports Log Structure on page 88

Concepts

Reports Log - Overview

HP Business Availability Center records all activities related to specific 
reports in a reports log. The activities that are logged are: 

➤ Errors. For details, see “Logging Errors” on page 86.

➤ Any other activity performed on the report. For details, see “Logging 
Activities” on page 86.
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The reports log records activities for all HP Business Availability Center 
reports, except for legacy reports. For a list of available HP Business 
Availability Center reports, including legacy reports, see “Legacy Reports” 
on page 36.

The reports log is located at <HP Business Availability Center root 
directory>\log\EJBContainer\reports.log.

Each error and activity is recorded using a specific format – for details about 
the reports log format, see “Reports Log Structure” on page 88.

Logging Errors

Logging occurs for any error during:

➤ report initialization.

➤ report customization – for details on customizing reports, see “Customizing 
Reports” on page 75.

➤ report rendering (creating the report display).

Logging Activities

Logging occurs for any action related to reports. The actions that are logged 
are: 

➤ creating a new report

➤ generating a report

➤ updating the filter of a report that is included in a custom report

➤ drilling down in a report and between reports

➤ updating the filter of a report

➤ printing a generated report, exporting it using email, or opening it in 
Microsoft Excel file format or in PDF format. For details on these actions, see 
“Format Options” on page 68.
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Reports Log Level

Depending on the log level you specify, the following information can be 
recorded in the reports log: 

➤ debugging information

➤ activities performed on reports

➤ warning messages

➤ error messages

➤ fatal errors

The log levels have the following hierarchy: DEBUG, INFO, WARN, ERROR, 
and FATAL, where DEBUG represents the lowest level and FATAL the highest 
level. The default level is ERROR.

The log level hierarchy means that if you select one of the levels, the report 
includes all the information related to that level and the levels above it, as 
follows:

Tasks

Level Reports log 

DEBUG Includes debugging information, activities 
performed on reports, warning messages, error 
messages, and fatal errors.

INFO Includes activities performed on reports, warning 
messages, error messages, and fatal errors.

WARN Includes warning messages, error messages, and 
fatal errors.

ERROR Includes error messages, and fatal errors.

FATAL Includes fatal errors.
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Set the Reports Log Level

You set the Reports log level to record the reports information that you want 
to track.

To set the Reports Log level:

 1 Open the <HP Business Availability Center root 
directory>conf\core\Tools\log4j\EJB\topaz.properties file with a text 
editor.

 2 Search for the following line: 
log4j.category.com.mercury.am.bac.core.reports= ${<loglevel>}, 
reports.appender

 3 Change <loglevel> to DEBUG, INFO, WARN, ERROR, or FATAL. 

 4 Save the file.
Reference

Reports Log Structure

The reports log includes entries for each activity or error. Each entry has the 
following structure:

 

2005-08-24 11:25:07,590 [TP-Processor1] (NewReportAction.java:66) <loglevel> - 
MERQ-120238: USER ACTION started
----------------------------------------=----------------------------------------
Action= <action>
User= <user> (id:<id>)
Report ID= <report_id>;  State ID: <state_id>
----------------------------------------=----------------------------------------
2005-08-24 11:25:15,980 [TP-Processor1] (DisplayAction.java:77) <loglevel> - MERQ-
120242: USER ACTION ended
----------------------------------------=----------------------------------------
User= <user> (id:<id>)
Report ID= <report_id>;  State ID: <state_id>
Duration=    <duration> ms  (init:6141;  render:3859)
Time filter=  View: <view>; From:<from_day_time>; To: <to_day_time>; Every: 
<periodicity>
----------------------------------------=---------------------------------------- 
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where:

➤ <log_level> represents the level that you selected – for details about the log 
level, see “Set the Reports Log Level” on page 88.

➤ <action> is the type of activity that has been logged:

➤ New report. The user created a new report from a menu.

➤ Generate. The user clicked the Generate button.

➤ CustomSaveFilter. The user clicked OK in the filter of new reports when 
creating a custom report.

➤ Update filter. The user modified the filter in one of the reports.

➤ Navigate. The user drilled down in a report or between reports.

➤ Export. The user exported a report to Excel, .PDF, .CSV, or e-mail formats.

➤ <user> is the login name.

➤ <id> is for internal use.

➤ <report_id> is the report requested by the user action.

➤ <state_id> is for internal use.

➤ <duration> is the number of milliseconds the server took to perform the 
user action.

➤ The time filter that was used in the activity includes the following 
information:

➤ <view> indicates the filter that was selected. This information is for 
internal use.

➤ <from_day_time> indicates when the activity started. This information is 
for internal use.

➤ <to_day_time> indicates when the activity ended.

➤ <periodicity> indicates the sampling periodicity. This information is for 
internal use.
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For example, the following entry specifies that a new report CMDBOverTime 
has been created by the admin user: 
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5
Report Manager

This chapter includes the main concepts, tasks, and reference information 
for the Report Manager.

This chapter includes:

Concepts

 ➤  Report Manager Overview on page 94

 ➤  Saving a Report as a PDF to the Report Manager on page 95

 ➤  Favorite Filters on page 96

 ➤  Report Schedules on page 96

 ➤  Excel Reports on page 97

Tasks

 ➤  Work With the Report Manager — Workflow on page 98

 ➤  Work With the Report Manager — Scenario on page 100

 ➤  Create a Schedule on page 106

Reference

 ➤  Report Manager User Interface on page 107

Troubleshooting and Limitations on page 125
Concepts
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Report Manager Overview

The Report Manager is a central location where you can manage selected 
reports and report objects from throughout HP Business Availability Center. 
You can also create User Reports - customized reports containing user-
defined data and formatting that can help you focus on specific aspects of 
your organization's application and infrastructure resource performance. 
The Report Manager enables you to create and manage the following:

Report or Report 
Object

Description

Favorite Filters Used to regenerate a report with predefined filters. For 
details, see “Favorite Filters” on page 96.

Custom Reports Reports consisting of selected components (individual 
application reports) that enable you to focus on the data 
you are most interested in tracking. For details, see 
“Custom Reports” on page 127. 

Trend Reports Reports that present a comparison of multiple 
measurements from several profiles collected by Business 
Process Monitor, Real User Monitor, and SiteScope. This 
enables you to analyze how various internal HP Business 
Availability Center factors affect system performance. For 
details, see “Trend Reports” on page 175.

Service Reports A report based on data from data sources from the Service 
Level Management, Dashboard, or other applications. For 
details, see “Service Report” on page 205.

Schedules Schedule a report or report object to be sent to specified 
individuals at set times. For details, see “Report 
Schedules” on page 96.

Custom Links A link to open a Web page in a browser window. For 
details, see “New Custom Link Page” on page 113.

Excel Reports Customized reports in HP Business Availability Center 
that take advantage of the charting abilities of Microsoft 
Excel. For details, see “Excel Reports” on page 97.
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Saving a Report as a PDF to the Report Manager

You can save the data of selected reports to the Report Manager, for viewing 
on other occasions, or for sending to other users. Reports are stored as PDF 
files in the Report Manager, and the report is saved with data valid at the 
time the report is saved. This is the case even if data subsequently changes, 
or more data accrues to the report. 

You can save all reports to the Report Manager, except for HP Business 
Availability Center Legacy Reports. For a list of HP Business Availability 
Center Legacy Reports, see “Legacy Reports” on page 36.

Annotations A snapshot of selected reports and highlight important 
areas of the report by drawing shapes, lines, and adding 
text to the snapshot. For details, see “Report Annotation” 
on page 44.

Note: Annotations are created outside the Report 
Manager, in the specific report in which you are working.

Email Send reports and report objects to selected individuals 
using email. For details, see “Email Dialog Box” on 
page 119.

PDFs Store a PDF of selected HP Business Availability Center 
reports, to access at a later time. For details, see “Saving a 
Report as a PDF to the Report Manager” on page 95.

Report or Report 
Object

Description
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Favorite Filters

Favorite Filters enable you to save a report filter and reuse it for future 
generating of the report. The filter you create can be used only for the same 
report for which it was created. Filters include the time range, location, 
views, CIs, resource definitions, and granularity for which the report is 
generated, as well as profiles, active filters, configuration items (CIs) and Key 
Performance Indicators (KPIs) configured for the report. For details on 
creating a Favorite Filter, see “Favorite Filters Wizard” on page 107.

You can also create a Favorite Filter from the specified report page. For 
details on the user interface for performing this task, see “Save Filter to 
Favorites Dialog Box” on page 69. 

Report Schedules

You configure schedules to enable specified recipients to automatically 
receive reports, through email, at regularly defined intervals.

You can schedule Favorite Filters, Custom Reports, Trend Reports, and 
Service Reports defined in the Report Manager, or reports saved from the 
specific report page. To do so, you must have View permissions for the 
Recipients resource and Add permissions for the Scheduled Reports resource. 
For details on assigning user permissions, see “Assign Permissions” in 
Platform Administration.

For details on configuring report schedules, see “Create a Schedule” on 
page 106.

By default, the value that appears in the From field in the email containing 
the scheduled report is HPBAC_Alert_Manager@<HP Business Availability 
Center server name>. You can modify the value by selecting Admin > 
Platform > Setup and Maintenance > Infrastructure Settings and the 
Scheduled Reports context in the Foundations tab. Modify the value E-mail 
sender or Scheduled Reports e-mail sender address (to include an email 
address in the From field). For details on modifying values, see 
“Infrastructure Settings Manager Page” in Platform Administration.
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To correctly view scheduled reports received in Microsoft Outlook 2003, in 
Tools > Options > Security > Zone Settings, select Internet; click Custom 
Level and specify the following settings in the Security Settings dialog box: 

➤ Download signed ActiveX control = Prompt

➤ Run ActiveX controls and plug-ins = Enable

➤ Script ActiveX controls marked safe for scripting = Enable

➤ In the Reset to list, select Medium

Administrators can manage configured report schedules using the Report 
Schedule Manager tab, located at Admin > Platform > Report Schedule 
Manager. For details on managing report schedules using the Report 
Schedule Manager tab, see “Report Schedule Manager” in Platform 
Administration.

Excel Reports

You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel. Excel 
reports display various types of data collected by HP Business Availability 
Center data collectors. The reports can be viewed with Microsoft Excel or 
any spreadsheet program capable of reading files with the .xls format. You 
can also upload Excel reports that were created using the .xlsx format. For 
details on creating a Microsoft Excel Report, see “Create a Microsoft Excel 
Report - Workflow” on page 317.

Note: Contact HP Software-as-a-Service Support for details on implementing 
Microsoft Excel reports in HP Software-as-a-Service. 

Tasks
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Work With the Report Manager — Workflow

This task describes how to create, manage, and distribute reports using the 
Report Manager.

For a scenario of this task, see “Work With the Report Manager — Scenario” 
on page 100.

This task includes the following steps:

➤ “Create a Favorite Filter” on page 98

➤ “Create a Custom Report” on page 98

➤ “Create a Trend Report” on page 98

➤ “Create a Service Report” on page 99

➤ “Create a Custom Link” on page 99

➤ “Create an Excel Report” on page 99

➤ “View a User Report” on page 99

➤ “Email a User Report” on page 99

 1 Create a Favorite Filter
You can create a filter for reports, save it, and apply it to the specified report. 
For details on creating a Favorite Filter, see “Favorite Filters Wizard” on 
page 107.

 2 Create a Custom Report
You can create a customized report with components that you select to 
present the data most relevant to you. For details on creating a Custom 
report, see “Custom Report Wizard” on page 136.

 3 Create a Trend Report
You can configure a report which compares multiple measurements from 
various profiles, enabling you to analyze how various internal HP Business 
Availability Center factors affect system performance. For details on creating 
a Trend report, see “Trend Report Wizard” on page 190.
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 4 Create a Service Report
You can create a custom report that displays selected data from data sources 
of the Service Level Management, Dashboard, or other applications. For 
details on creating a Service report, see “Configure a Service Report in the 
Report Manager – Workflow” on page 219.

 5 Create a Custom Link
You can create a link to open a web page in a browser window. For details on 
creating a Custom Link, see “New Custom Link Page” on page 113.

 6 Create an Excel Report
You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel. For 
details on creating an Excel report, see “Create a Microsoft Excel Report - 
Workflow” on page 317.

 7 View a User Report
You can view HP Business Availability Center report or report objects by 
selecting the item in the Report Manager table and clicking the View Report 
button on the Report Manager Main Page.

 8 Email a User Report
You can send a Favorite Filter, Custom report, Trend report, or Service report 
to selected users using email. For details, see “Email Dialog Box” on 
page 119.

For details on how to create a schedule for a report or report object to be 
sent to specified individuals at set times, see “Create a Schedule” on 
page 106.
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Work with the Report Manager — Scenario

This scenario describes how to create, manage, and distribute reports and 
report objects using Report Manager. 

For a task of this scenario, see “Work with the Report Manager — Workflow” 
on page 98.

This scenario includes the following steps:

➤ “Creating a Favorite Filter” on page 100

➤ “Creating a Custom Report” on page 101

➤ “Creating a Trend Report” on page 103

➤ “Creating a Service Report” on page 104

➤ “Creating a Custom Link” on page 104

➤ “Creating an Excel Report” on page 104

➤ “Emailing a User Report” on page 104

➤ “Viewing a Report Saved to the Report Manager” on page 104

 1 Creating a Favorite Filter
John Smith is the CEO for ABC Software Company. He wants to see the data 
output of the Triage report for a specific CI for the past month. In the Report 
Manager, he clicks the New button and selects New Favorite Filter. In the 
Favorite Filters Wizard, he configures a Favorite Filter by selecting the Triage 
report in the Business Process Monitor list of reports, and 
configures the Time Range and Granularity bar to generate or view the report. 
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The report generated by the Favorite Filter appears as follows:

 2 Creating a Custom Report
The information that John most needs to see is the Availability Over Time 
and Response Time Over Time reports.

In the Report Manager, John clicks the New button, selects New Custom 
Report and navigates to the Report Components page where he selects the 
Business Process sub category in the End User Management category, and then
the User Experience Reports in the Category field, and Availability Over Time 
in the Type field to add the report component to his Custom report. 

In the same way, John adds  the Response Time Over Time report to the same 
Custom Report. 
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The Custom report is displayed as follows:



Chapter 7 • Report Manager

103

 3 Creating a Trend Report
John also wants to receive a daily report comparison of Transaction 
Response Time and Availability data within Business Process Monitor. 
In the Report Manager, he clicks the New button, selects New Trend Report 
and navigates to the Select Measurements page, and clicks the Add New 
Component button to open the Measurement Selection page. In that page, 
he selects Business Process Monitor in the Monitor type list, and the 
relevant profile, transaction, location, group, and the Availability counter, 
and clicks Add Measurement. In the same way, he adds the relevant
profile, transaction, location, group, and the 
Transaction Response Time counter. He configures a measurement's color 
by clicking the Color Swatch next to the relevant measurement on the 
Select Measurements page in the Trend Report Wizard. For user interface 
details, see “Trend Report Wizard” on page 192.

The resulting report is as follows:
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 4 Creating a Service Report
John wants to view data collected from the Dashboard KPIs data source. He 
clicks the New button, selects New Service Report and configures a Service 
report, as described in “Configure a Service Report in the Report Manager – 
Workflow” on page 221.

 5 Creating a Custom Link
John creates a link to a select report page by clicking the New button, 
selecting New Custom Link, and entering the URL of the report page he 
wants to view.

 6 Creating an Excel Report
John wants to view his report data in a more organized format, and decides 
to use Microsoft Excel for this purpose. He follows this procedure: 

 a Opens Microsoft Excel and creates a Microsoft Excel report, as described 
in “Create a Microsoft Excel Report - Workflow” on page 319.

 b Navigates to the Report Manager, clicks the New button, selects New 
Excel Report, and browses to the file he saved. The Excel report is saved 
to the Report Manager.

 7 Emailing a User Report
John wants to send his Custom report to an associate to show him the data 
that has been collected. He selects the Custom report in the Report Manager 
and clicks the Send Email Now button to choose a recipient from the Email 
dialog box and send the Custom report using email.

 8 Viewing a Report Saved to the Report Manager
One of John’s associates has saved an annotated report to the Report 
Manager, and John wants to view the report areas that have been 
highlighted by the annotations. He selects the annotated report in the 
Report Manager list of reports and clicks the View Report button to view the 
report’s annotations. 



Chapter 7 • Report Manager

105

The annotated report appears as follows: 
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Create a Schedule

This task describes how to create a scheduled report to enable specific 
recipients to automatically receive reports, through email, at regularly 
defined intervals.

This task includes the following steps:

➤ “Prerequisites” on page 106

➤ “Create a Schedule” on page 106

➤ “Results” on page 106

 1 Prerequisites
Ensure that you have at least one Favorite Filter, Custom report, Trend 
report, or Service report in the Report Manager. For details on configuring 
reports and report objects, see “Work With the Report Manager — 
Workflow” on page 98.

 2 Create a Schedule

 a Click the Create new schedule for selected reports button.

 b Enter the requested information in the Create New Schedule dialog box. 
For details on creating a new schedule in the Create New Schedule Dialog 
Box, see “Create New Schedule Dialog Box” on page 121.

 3 Results
The configured schedule’s status is indicated in the Scheduling column of 
the Report Manager. 

Click the link in the Scheduling column to open the Schedule Management 
dialog box and manage the configured schedules. For details on the 
Schedule Management dialog box, see “Schedule Management Dialog Box” 
on page 124.

Reference
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Report Manager User Interface

This section describes:

 ➤  Favorite Filters Wizard on page 107

 ➤  New Custom Link Page on page 113

 ➤  New Excel Report Page on page 113

 ➤  Report Manager Main Page on page 114

Favorite Filters Wizard

Filter Properties Page

Description Enables you to create a predefined filter with which you 
can regenerate the specified report. 

To access: Click the New button  in the Report 
Manager and select New Favorite Filter.

Important 
Information

Favorite Filters cannot be applied to legacy reports. For a 
list of legacy reports, see “Legacy Reports” on page 36.

Included in Tasks “Generate Reports” on page 45

Wizard Map The Favorite Filters Wizard contains:

Filter Properties Page > Filter Setting Page > Report 
Preview Page

Description Enables you to choose the report for which you want to 
assign a Favorite Filter, and to configure the name, 
description, and access level of the filter. 

To access: Click the New button  in the Report 
Manager and select New Favorite Filter.

Important 
Information

General information about the wizard is available at 
“Favorite Filters Wizard” on page 107.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filter Setting Page

GUI Element (A–Z) Description

Filter description Optionally, enter a description for the filter. 

Filter name Enter a descriptive name for the filter.

Save filter as Choose the access level for the favorite filter:

➤ Private. The filter is available only to the user who 
configured it, or to an administrator.

➤ Public. The filter is available to any user with 
appropriate permissions. For details on user 
permissions and the privileges they provide, see “User 
Management Operations” in Platform Administration.

Select report Click to select from the list of reports from which you 
can assign a Favorite Filter. For details on the available 
reports, see “HP Business Availability Center Reports” on 
page 16.

Description Enables you to configure parameters for the filter.

To access: Click the New button  in the Report 
Manager and select New Favorite Filter.

Important 
Information

General information about the wizard is available at 
“Favorite Filters Wizard” on page 107.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page
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The following elements are included:

Select CI/View Dialog Box

Set View-specific Report Dialog Box

GUI Element (A–Z) Description

<Filters> The active filters displayed on the Filter Setting page 
depend on the report you have chosen. The various filter 
options are described in the documentation for the 
specific report you are viewing. For a list of all 
HP Business Availability Center reports, see “HP Business 
Availability Center Reports” on page 16.

Time Range and 
Granularity Bar

Choose the date, time frame, and granularity for the 
filter. For details, see “Time Range and Granularity Bar” 
on page 70.

Description Select the required CI or view. Opens the Select CI/View 
dialog box. For details, see “Working with View Explorer” 
in Model Management.

To access: Click the CI/View link.

Important 
Information

The CI/View link is available only in the Change report.

Description Enables you to generate a report of the selected Report 
TQL query based on a specific view rather than the entire 
CMDB.

To access: Select the Favorite Filter of a Topology report 
and click the Edit button . In the Filter Settings page, 
click the Set View-Specific Report link.

Important 
Information

The Set View-specific Report link is available only in 
Topology reports.
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Save to History DB Option

Selected View Dialog Box

Configuration Items Dialog Box

Description Enables you to create a schedule to send the Favorite 
Filter to specified individuals at specific intervals.

To access: Select the Favorite Filter of a Topology report 
and click the Edit button . In the Filter Settings page, 
select the Save to History DB option.

Important 
Information

The Set View-specific Report link is available only in 
Topology reports.

Description Select the required view. Opens the Selected View dialog 
box. 

To access: Click the Selected View link.

Important 
Information

The Selected View link is available only in Asset, Host 
Dependency, or Change reports.

Description Enables you to select the CIs to be included in the 
report for which you are configuring the Favorite Filter. 

To access: Click the Configuration Items link on the 
Filter Setting page of the Favorite Filter dialog box. 

For details on the elements contained in the 
Configuration Items dialog box, see “Configuration 
Items Dialog Box” in Using Dashboard.

Important 
Information

➤ The Configuration Items link is available only for 
selected Dashboard and End User Management 
reports.

➤ The availability of the tabs in the Configuration 
Items dialog box depends on the specific report you 
are generating. For details, see the description of the 
specific report with which you are working. 
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KPIs Dialog Box

Active Filters Dialog Box

Description Enables you to select the KPIs on which to run the 
Favorite Filter, for the duration of a Web session. 

To access: Click KPIs on the Filter Setting page in the 
Favorite Filters wizard.

For details on the elements contained in the KPIs 
dialog box, see “KPIs Dialog Box” in Using Dashboard.

Important 
Information

➤ The KPIs dialog box is available only for selected 
Dashboard reports. 

➤ The availability of the tabs in the KPIs dialog box 
depends on the specific report you are generating. 
For details, see the description of the specific report 
with which you are working. 

Description Enables you to set filters to determine which specific 
report components are to be included in the Favorite 
Filter. 

To access: Click the Active Filters link on the Filter 
Setting page in the Favorite Filters Wizard.

Active filters are saved across reports. For details on 
Active Filters, see “Active Filters Dialog Box” in Using End 
User Management.

Important 
Information

➤ The Active Filters link is available for Real User 
Monitor and Business Process Monitor reports.

➤ The availability of the tabs in the Active Filters dialog 
box depends on the specific report you are generating. 
For details, see the description of the specific report 
with which you are working. 
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Applications Dialog Box

Report Preview Page

Description Enables you to select the applications to be included in 
the Favorite Filter.

To access: Click the Applications link on the Filter Setting 
page of the Favorite Filters Wizard.

For details on the elements contained in the Applications 
dialog box, see “Applications Dialog Box” in Using End 
User Management.

Important 
Information

➤ The Applications link is available only for Real User 
Monitor reports. 

➤ In the Global Statistics report, you select an 
application from the dropdown list in the Application 
field.

Description Displays a snapshot of the generated report, based on the 
parameters configured for the filter.

To access: Click the New button  in the Report 
Manager and select New Favorite Filter.

Important 
Information

➤ The Report Preview Page only displays the report and 
does not enable any functionality on the report 
snapshot.

➤ General information about the wizard is available at 
“Favorite Filters Wizard” on page 107.

Wizard Map Filter Properties Page > Filter Setting Page > Report 
Preview Page
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New Custom Link Page

The following elements are included:

New Excel Report Page

Description Enables you to create a custom link to open a web page in 
a browser window.

To access: Click the New button  in the Report 
Manager and select New Custom Link.

To view the linked site, select the Custom Link in the 
Report Manager table, and click the View Report button 

. 

GUI Element (A-Z) Description

Name Enter a descriptive name for the custom link.

URL Enter the URL of the web page you to which you want to 
create a link.

Description Enables you to upload a Microsoft Excel report that 
includes HP Business Availability Center data to the 
Report Manager. 

To access: Click the New button  in the Report 
Manager and select New Excel Report.

Important 
Information

Before you can upload an Excel report, you must:

➤ create a Web query file that you then import into 
Excel.

➤ create the report itself in Excel. 

For details, see “Create a Microsoft Excel Report - 
Workflow” on page 317.
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The following elements are included:

Report Manager Main Page

Included in Tasks “Create a Microsoft Excel Report - Workflow” on 
page 317

“Create a Microsoft Excel Web Query File” on page 318

“Generate a Report with Microsoft Excel” on page 318

Useful Links “Excel Reports” on page 97

GUI Element (A-Z) Description

Description Type a description of the report as you want it to appear 
in the Report Manager table.

Excel File Type the path to the saved Excel file you want to add, or 
use the Browse function to browse to the file. You can 
add .xls or .xlsx files. 

Report Name Type a name for the report as you want it to appear in the 
Report Manager table.

Description Enables you to manage the contents of the Report 
Manager and perform a variety of actions, including: 

➤ View, edit, and clone existing components. 

➤ Configure new user reports and Favorite Filters.

➤ Email reports and Favorite Filters.

➤ Create a schedule for selected reports to run.

To access: Select Applications > User Reports > Report 
Manager.

Important 
Information

You can filter the contents of the Report Manager by 
entering or selecting values in the cells under each 
column heading.

Useful Links “Annotation Tool Window” on page 50
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The following elements are included:

GUI Element (A–Z) Description

Click to view the selected report or report object. 

Divides a table of data into pages. You move from page to 
page by clicking the relevant button:

➤ To view more items, click the Next page or Last page 
buttons.

➤ To view previous items in the list, click the Previous 
page or First page buttons.

Click to create a new report or report object. Choose from 
the following options:

➤ New Favorite Filter. For details, see “Favorite Filters 
Wizard” on page 107. 

➤ New Custom Report. For details, see “Custom Report 
Wizard” on page 136.

➤ New Trend Report. For details, see “Trend Report 
Wizard” on page 190.

➤ New Service Report. For details, see “Service Report 
Builder Wizard” on page 227.

➤ New Custom Link. For details, see “New Custom Link 
Page” on page 113. 

➤ New Excel Report. For details, see “New Excel Report 
Page” on page 113.

Click to edit the selected report or Favorite Filter. 

Note: Clicking this button opens the selected report or 
report object’s  wizard. 

Click to create a copy of the report object. You can then 
edit parameters in the wizard of the selected report or 
report object.

Note: Any schedules configured for a specific report or 
report object are not cloned when selecting this option. 
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Click to delete the report or report object.

Note: Deleting a report causes all schedules configured 
for the report to also be deleted. 

Click to email the selected report or report object. For 
details, see “Email Dialog Box” on page 119.

Click to create a schedule to send the report or report 
object to specified individuals at specific intervals. For 
details, see “Create New Schedule Dialog Box” on 
page 121. 

Click to open the Schedule Management dialog box and 
manage schedules configured for the selected report or 
report object. For details, see “Schedule Management 
Dialog Box” on page 124.

A user with Administrator permissions can view and 
manage all schedules for all reports from the Report 
Schedule Manager. For details, see “Report Schedule 
Manager” in Platform Administration. 

Click to delete all schedules from the selected report.

Click to resume all schedules for the selected report.

Click to pause all schedules for the selected report. 

Click to configure a default header and footer for all 
custom and trend reports in the Report Manager. For 
details, see “Default Header/Footer Dialog Box” on 
page 118.

Click to refresh the Report Manager page.

Click to reset the width of the columns to the default 
setting. 

GUI Element (A–Z) Description
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Click to select columns to be visible in the table. For 
details, see “Working with Tables” in Reference 
Information.

Description The description of the report or report object. The value 
of this field is entered as entered during configuration of 
the report or report object. 

Note: This element is not displayed for Custom and 
Trend reports. 

Details Displays information on the report or report object 
according to the selected report type, as follows: 

➤ Favorite Filter. The name of the report (value of the 
Report Name field) that the Filter is associated with. 

➤ Custom Report. The titles of the components added to 
the report in the Custom Report Wizard.

➤ Trend Report. The value of the Name field for the 
measurements added to the Trend report in the Trend 
Report Wizard.

The Details field is empty for Custom Links, Excel 
Reports, and Service Reports.

Name The name of the report or report object.

Owner The user who created the report or report object.

Privilege The privilege level of the report or report object. The 
available values are:

➤ Private. The report or report object is available only to 
the user who configured it, or an administrator.

➤ Public. The report or report object is available to 
administrators or any user with appropriate 
permissions.

Note: This element is not displayed for Custom reports, 
Trend reports, and Custom links, which by default have 
the Public privilege level.

GUI Element (A–Z) Description
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Default Header/Footer Dialog Box

The following elements are included:

Scheduling Indicates if schedules are configured for the selected 
report or filter, and displays a link to the list of schedules 
(if they exist). 

Click the indicated schedules link to open the Schedules 
Management dialog box and manage schedules for the 
selected item. For details on the user interface, see 
“Schedule Management Dialog Box” on page 124. 

Note: A user with Administrator permissions can view 
and manage all schedules for all reports from the Report 
Schedule Manager. For details, see “Report Schedule 
Manager” in Platform Administration. 

Type The type of report or report object displayed. 

Description Enables you to create a default header and footer to be 
displayed for all custom and trend reports.

To access: Click the Set default header/footer for all 
Custom & Trend Reports button  on the Report 
Manager Main Page.

Important 
Information

The header and footer configured in the Default 
Header/Footer dialog box overrides the header and footer 
configured on the Infrastructure Settings page.

GUI Element (A-Z) Description

Footer HTML Enter the footer text with valid HTML tags.

Header HTML Enter the header text with valid HTML tags. 

Preview Click to preview the configured header and footer.

GUI Element (A–Z) Description
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Email Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to send the selected report or report object 
using email.

To access: Click the Email button  on the Report 
Manager Main Page. 

Important 
Information

You must have View permissions to email a report.

GUI Element (A-Z) Description

Attachment type Select the type of report attachment to be used. The 
available attachment types are: 

➤ Embedded. The report or report object is embedded 
into the body of the email.

➤ Attached. The report or report object is sent as an 
external attachment with the email. 

➤ Zipped. The report or report object is sent as a .zip file 
attachment. 

Format Select the format of the report. 

Recipients Section of the Email dialog box that enables you to select 
recipients to receive the email. For details, see “Recipients 
Area” on page 120.

Report Coverage 
Time

Section of the Email dialog box that enables you to 
configure the time frame to be monitored by the report. 
For details, see “Report Coverage Time Area” on 
page 120. 

Note: This field is enabled only when selecting a Custom 
or Trend Report.

Select language Select the language of the report attachment. The server 
from which the schedule is being sent must support the 
selected language for the report to display properly.
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Report Coverage Time Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Recipients Area

The following elements are included:

GUI Element (A–Z) Description

Click to move the report coverage time range back the 
time frame specified in the View field. 

Click to move the report coverage time range ahead the 
time frame specified in the View field. 

<Time zone drop 
down>

Select the time zone from which the report generation 
time is to take effect. 

From Click to select the start date and time for the generated 
report.

To Click to select the end date and time for the generated 
report. 

View Select the time frame that the emailed report is to cover. 

GUI Element (A–Z) Description

Click to move recipients to the Selected Recipients pane. 
You must select recipients in the Available Email 
Recipients pane before clicking this button. 

Click to de-select recipients by highlighting and move 
them to the Available Email Recipients pane. You must 
highlight recipients in the Selected Recipients pane 
before clicking this button.

Available Email 
Recipients

The list of configured recipients who are currently not 
selected to receive email on the report or report object. 
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Create New Schedule Dialog Box

New Recipient Click to add a new recipient to receive email of the report 
or report object. For details, see “Recipient Properties 
Wizard” in Alerts.

Selected Recipients The list of configured recipients who are currently 
selected to receive email on the report or report object.

Description Enables you to schedule a report to be sent to specified 
individuals at specific intervals. 

To access: 

You access the Create New Schedule dialog box in one of 
the following ways:

➤ Click the Create new schedule for selected reports 
button  on the Report Manager main page.

➤ Click the New button  in the Schedules 
Management dialog box, accessible by clicking the 
listed schedules in the Scheduling column.

Note: This dialog box is also accessible by navigating to 
Admin > Platform > Report Schedule Manager, and 
clicking the Edit Selected Schedule button . For 
details on the Report Schedule Manager, see “Report 
Schedule Manager” in Platform Administration. 

Included in Tasks “Create a Schedule” on page 106

Useful Links “Report Schedules” on page 96

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Generate data for 
the past X hours

Select the number of previous hours for which the report 
should be generated. 

Note: This option is enabled only when the Daily 
recurrence pattern is selected for Custom and Trend 
reports. 

Range of recurrence Configure the start and end time of the schedule, as 
follows: 

➤ Start. Click to configure the date for the schedule to 
start. 

➤ No end date. Select for the schedule to run 
indefinitely.

➤ End by. Click to configure the date for the schedule to 
end. 

Recipients Configure recipients to receive the report at the 
scheduled time. For details on configuring recipients, see 
“Recipients Area” on page 120.

Recur every day on Select the days of the week on which the report is to run.



Chapter 5 • Report Manager

123

Recurrence Pattern ➤ For a Favorite Filter and Service Report, enables you to 
select how often the report or report object is to be 
sent.

➤ For a Custom Report and Trend Report, enables you to 
select how often the report is to be sent and enables 
you to select the time frame for when the report data 
is to be generated. 

You also select the following configurations:

➤ How often the report is to run. Choose from:

➤ Daily 

➤ Weekly

➤ Monthly

➤ Quarterly

➤ Days of the week the report is to run, if you chose 
Daily or Weekly. 

➤ The first or last day of every month or quarter, if you 
chose Monthly or Quarterly.

➤ The specific day of the month or quarter, if you chose 
Monthly or Quarterly.

Report generation 
time 

Set the time for the report generation to begin, and the 
time zone in which the generation should take place.

Select language Select a language for the schedule to be sent. 

Note: The server from which the schedule is being sent 
must support the selected language for the report to 
display properly.

Time Zone Select a time zone according to whose time the schedule 
is to be sent.

GUI Element (A–Z) Description
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Schedule Management Dialog Box

The following elements are included:

Description Enables you to manage configured schedules. 

To access: 

➤ Click the link in the Scheduling column next to the 
relevant item on the Report Manager Main Page. 

➤ Click the Manage schedules list button  on the 
Report Manager Main Page.

Useful Links “Create New Schedule Dialog Box” on page 121

GUI Element (A–Z) Description

Click to create a new schedule for the selected report or 
report object. For details on creating schedules, see 
“Create New Schedule Dialog Box” on page 121. 

Click to resume the selected schedule according to its 
configured running time.

Click to pause the selected schedule. 

Click to delete the selected schedule. 

Note: Deleting the schedule does not delete the report or 
report object.

Generation Time The time (in the indicated time zone) that the schedule is 
to be generated. 

Recipients The recipients configured to receive the selected 
schedule.
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Troubleshooting and Limitations

This section describes troubleshooting and limitations of the Report 
Manager.

Custom Links

➤ When entering the URL, do not enter a URL that is redirected, as a 
redirected link may cause a runtime error or the application to log out. Enter 
only URLs that are accessed directly upon linking.

➤ If the specified Web page includes JavaScript code that attempts to access 
the top frame, the browser displays an “access denied” error. To avoid this 
issue, set your browser to ignore JavaScript errors.

Excel Reports

➤ Users who have permissions to view Microsoft Excel reports but who do not 
have permissions on specific profiles are able to view data from those 
profiles only if they are included in an Excel report.

➤ Microsoft Excel reports cannot return more than 10,000 records due to a 
Microsoft Excel limitation when using Web queries. Possible workarounds 
include:

Recurrence The recurrence pattern for the selected schedule.

Status The current status of the schedule, displayed with an 
icon indicating one of the following statuses:

➤ Active. 

➤ Paused. 

Note: If an error status is indicated, see the scheduler log 
located in: 

<HP Business Availability Center root 
directory>\hpbac\log\schedulergw\scheduler.log>

GUI Element (A–Z) Description
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➤ split the request to several consecutive queries

➤ group data using larger time range chunks

➤ use filter parameters to fetch specific data

Report Schedules and Email Reports
When attempting to schedule or email multiple reports or report objects at 
the same time, you must ensure that your selections are from the same 
group. The items are grouped as follows: 

➤ Favorite Filter and Service Report

➤ Custom Report and Trend Report



127

6
Custom Reports

This chapter includes the main concepts, tasks, and reference information 
on Custom reports.

This chapter includes:

Concepts

 ➤  Custom Reports - Overview on page 127

 ➤  Understanding the Header/Footer Page in the Custom Report Wizard 
on page 131

Reference

 ➤  Custom Reports User Interface on page 132

Troubleshooting and Limitations on page 158
Concepts

Custom Reports - Overview

Custom reports consist of components—individual application reports that 
enable you to focus on the data you are most interested in tracking. Each 
Custom report consists of components from different HP Business 
Availability Center applications.

You select components from the relevant applications, and then configure 
settings for each component, including format (chart or table), layout, and 
time settings. You also specify active filters, which enable you to design the 
report to focus on the specific information that you most want to track (for 
example, business-critical transactions or critical alerts). In addition, you 
can add a custom header and footer to the report. 
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You configure Custom reports from the Custom Report Wizard, located in 
the Report Manager. For details on configuring Custom report components, 
see “Custom Report Wizard” on page 136.

Note: When a Custom report based on a Custom time range (selected in the 
time range and granularity bar) contains Service Level Management 
components, the time ranges used for these components are adjusted to fit 
Service Level Management tracking periods. For more information, see 
“Time Ranges in Service Level Management Component Reports” on 
page 128.

Time Ranges in Service Level Management Component 
Reports
When a Custom report is set to use a global time period for all components 
(so that the time range and granularity bar is displayed at the top of the 
Custom report), and you select to base the report on a Custom time range 
(selected in the View box), the time range you define might not fit the 
tracking periods for any Service Level Management components included in 
the report. 

In this case, the time range for each Service Level Management component 
is automatically adjusted to correlate with Service Level Management 
tracking periods. The adjustment is made based on the From and To dates 
defined for the time range.

For over time reports (CIs Over Time, CI Over Time vs. Target), the 
automatic adjustment for both dates is to the nearest hour or nearest 
midnight, as appropriate. 
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Note: The granularity supported for these report components is every 1 
hour, week, month, or year, as appropriate for the time range, with a 
maximum of 60 data points. For example, if you select a granularity of 1 day 
for a time range of a year, this would generate 365 data points, so the 
component report cannot be generated. 

For all other Service Level Management reports, the adjustment is made as 
follows: 

➤ If the difference between the From and To date is under 2 hours, the time is 
adjusted to show the hour that starts from the From date and time (rounded 
back to the nearest hour).

➤ If the difference between the From and To date is at least 2 hours, but under 
2 days, the time is adjusted to show the day that starts from the From date 
(rounded back to the nearest midnight).

➤ If the difference between the From and To date is at least 2 days, but under 2 
weeks, the time is adjusted to the week that starts from the From date 
(rounded back to the first weekday of that week).

➤ If the difference between the From and To date is at least 2 weeks, but under 
61 days, the time is adjusted to the month that starts from the From date 
(rounded back to the first day of that month).

➤ If the difference between the From and To date is from 61 days to 121 days, 
the time is adjusted to the quarter that starts from the From date (rounded 
back to the first day of that quarter).

➤ If the difference between the From and To date is 122 days or more, the time 
is adjusted to the year that starts from the From date (rounded back to the 
first day of that year).

The adjusted time range used for the Service Level Management component 
is displayed at the top of the component report. (The settings in the time 
range bar remain as defined.) 
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In the following images, the custom time range for My Custom Report is set 
for 1.5 hours—from 4:40 pm to 6:10 pm. In the CI Status report component, 
the time range has been automatically adjusted to the hour from 4:00 pm - 
5:00 pm; In the CIs Over Time report component, the time range has been 
automatically adjusted to the two hour period from 4:00 pm - 6:00 pm:
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Understanding the Header/Footer Page in the Custom 
Report Wizard

You can add a custom header and footer to your Custom report, using the 
Header/Footer page in the Custom Report Wizard. The custom header and 
footer can include free text, HTML tags used to mark up the text, hypertext 
links, JavaScript, as well as references to external resources such as images, 
Flash files, and so on. If you do not mark up the text, it is formatted 
according to the browser defaults. 

You add the Custom Header and Footer into the Report Header and Report 
Footer panes, respectively.

HP Business Availability Center adds the HTML header to the report below 
the report filter, and the HTML footer at the end of the report, immediately 
before closing the body tag. 

Note: 

➤ The header and footer you configure on the Header/Footer page overrides 
the default header and footer configured from the Set default 
header/footer for all Custom & Trend reports button in the Report 
Manager. 

➤ Use caution when marking up the header and footer fields, as some 
HTML code may affect the behavior of HP Business Availability Center. 
For example, a linked URL may contain JavaScript that causes the URL to 
"break out" of frames. Make sure you use valid HTML.

➤ It is recommended that you perform an external check of the HTML code 
used in the header and footer, as HP Business Availability Center does not 
perform any validity checks on the header and footer content.

For details on the Header/Footer page, see “Header/Footer Page” on 
page 157. 

Reference
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Custom Reports User Interface

This section describes:

 ➤  Custom Report Output on page 133

 ➤  Custom Report Wizard on page 136
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Custom Report Output

This is an example of a Custom report:

Description Displays the Custom report created in the Custom Report 
Wizard. You create Custom reports to view the data that 
you are most interested in tracking.

To access: Select a Custom report in the Report Manager 
main page and click the View Report button . 

The information displayed in the Custom report is 
dependent on the report components you added when 
configuring the report in the Custom Report Wizard.

Useful Links “Custom Reports - Overview” on page 127

“Custom Report Wizard” on page 136
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.
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<Header/Footer> The header and footer of the report that was configured 
in one of the following locations: 

➤ The Header/Footer page of the Custom Report Wizard. 
For details, see “Header/Footer Page” on page 157.

➤ The Default Header/Footer dialog box which is 
displayed after clicking the Set default header/footer 
for all Custom & Trend Reports button  on the 
Report Manager main page. For details, see “Default 
Header/Footer Dialog Box” on page 118.

➤ The static report header and static report footer 
configured in the HP Business Availability Center 
Infrastructure Settings. 

To configure the static report header and footer, select 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose the Customer Settings 
tab and the Foundations context, select Reporting, 
and locate the Display static report header and 
Display static report footer entries in the Reporting - 
Display table. Modify the Customer’s Value to the 
desired header and footer, as appropriate. 

Note: 

➤ Settings configured in the Header/Footer page of the 
Custom Report Wizard override settings configured in 
the Default Header/Footer dialog box. 

➤ Settings configured in the Default Header/Footer 
dialog box override settings configured in the 
HP Business Availability Center Infrastructure Settings. 

<Report 
Components>

The title of the report component, as configured in the 
Custom Report Wizard. The specific report components 
are described in the documentation for the specific report 
that you are viewing. For a list of all HP Business 
Availability Center reports, see “HP Business Availability 
Center Reports” on page 16.

GUI Element (A-Z) Description
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Custom Report Wizard 

Report Properties Page

Description Enables you to create customized reports that present the 
data most relevant to you.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Custom Report.

Important 
Information

If you configure user-level or global-level report filters to 
filter specific transactions, locations, or groups from 
reports after creating a Custom report, the filtered values 
still appear in the reports. To remove any newly filtered 
values from existing Custom reports, you must remove 
and re-add the components containing the elements for 
which filters have been set, and save the report.

Wizard Map The Custom Report Wizard contains:

Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page

Useful Links “Custom Reports - Overview” on page 127

Description Enables you to configure general properties for your 
Custom report.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New 
Custom Report.

Important 
Information

General information about the wizard is available in 
“Custom Report Wizard” on page 136.

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page
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The following elements are included:

Report Components Page

GUI Element (A–Z) Description

Automatic 
Generation

Choose an automatic generation setting for your report. 
Select from the following options:

➤ Do not generate the report automatically. Select to 
ensure that the report is generated only on demand.

➤ Refresh the report every x minutes. Select to generate 
and refresh the report every x minutes. Select the 
number of minutes from the drop down box.

Insert a page break 
after each 
component when 
printing the report

Select to insert a page break after each report component 
when printing the report.

Page Title Enter a title for the Custom report.

Report Name Enter a descriptive name for the Custom report. 

Note: Leaving this field blank causes the value to 
automatically default to the value of the Page Title field. 

Time Period Choose whether you want to enable one time period for 
all components, or a separate time period for each 
component.

Description Enables you to add components that contain the data 
most important to you to the Custom report.

To access: Enter parameters on the Report Properties page 
in the Custom Report Wizard.

Important 
Information

General information about the wizard is available in 
“Custom Report Wizard” on page 136.

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page
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The following elements are included:

GUI Element (A–Z) Description

Click to open the Add Component dialog box and add a 
component to the customized report. For details, see 
“Add Component Dialog Box” on page 139.

Click to configure filters for the selected component. For 
details, see “Filters Dialog Box” on page 155.

Click to reset the width of columns in the report 
components table. 

Click to select columns to be visible on the report 
components table. For details, see “Working with Tables” 
in Reference Information.

Entity The profile, if applicable, to which the report component 
belongs. 

Report The type of report component selected. 

Time Frame Displays a method for time range display for the 
component. 

➤ Global. One time range is applied to all report 
components. This is displayed if you chose Use one 
time period for all reports in the Time Period field on 
the Reports Properties page.

➤ <Time Interval>. The interval at which the report is to 
be generated. This is displayed if you chose Use 
separate time period for each report in the Time 
Period field on the Reports Properties page. 

Title The title of the report, as configured on the Component 
Properties page.

Width Displays the size of the report component, as configured 
on the Component Properties page:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.
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Add Component Dialog Box

The following elements are included:

Description Enables you to choose a component type and specific 
report to be included in your Custom report. 

To access: Click the Add New Component button  on 
the Report Components page in the Custom Report 
Wizard. 

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page

Useful Links “Custom Report Wizard” on page 136

“Report Components Page” on page 137

GUI Element (A–Z) Description

Select Component Select the specific component you want added to your 
Custom report. For details, see “Select Component Pane” 
on page 140. 

Select Component 
Category

Select the type of report component you want added to 
your Custom report. 

You must click the expand button next to the application 
contexts to view the available categories to choose from.

For details on the available reports components, see 
“HP Business Availability Center Reports” on page 16.
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Select Component Pane

Description Enables you to configure components to be included in 
your Custom report. 

To access: Click the New Component Button  on the 
Report Components page of the Custom Report Wizard 
and choose a component category from the Select 
Component Category pane. Configure your component 
in the Select Component pane. 

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page

Important 
Information

➤ Before selecting the Service Report Builder in the User 
Reports context, you must first create a Service Report 
in the Report Manager to enable you to add Service 
Reports as a component to your Custom Report. For 
details, see “Configure a Service Report in the Report 
Manager – Workflow” on page 219.

➤ Not all elements are available for all report 
components within each context.
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End User Management Components

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Category Select a report category. 

Note: This field is available only for Business Process 
reports in the End User Management context. 

The available report categories are: 

➤ Performance Update Reports, located in “Additional 
Custom Reports” on page 161.

➤ User Experience Reports (Real User Monitor and 
Business Process Monitor reports), located in Using End 
User Management.

The individual reports are then selected in the Type field.

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then configure how long ago the 
data for the report should be generated in the Start field. 
If you selected Use global setting for all reports when 
defining the report properties, this field reads Use global 
settings. 

Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Profile Select a profile for the Custom report component. 
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Report Select a report from the Report list. The available reports 
are displayed based on the component category chosen, 
as follows: 

➤ Business Process Monitor Enhanced

➤ Response Time by Percentile Report

➤ Triage Raw Data Report

➤ Triage Report

➤ Real User Monitor 

➤ End User Over Time Report

➤ End User Summary Report

➤ End Users by Page Report

➤ End Users by Transaction Report

➤ Event Analysis Report

➤ Event Count Over Time Report

➤ Event Summary Report

➤ Page Over Time Report

➤ Page Summary Report

➤ Pages by Server Summary Report

➤ Server Over Time Report

➤ Server Summary Report

➤ Servers by Page Summary Report

➤ TCP Application Summary Report

➤ Transaction Over Time Report

➤ Transaction Summary Report

➤ Real User Monitor (Old)

➤ Broken Links

➤ Most Active End Users

➤ Most Popular Pages

➤ Pages with Most Errors

➤ Pages with Slowest Server Time

➤ Slowest End Users

GUI Element (A–Z) Description
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Size Select the size for the report component to be displayed:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page. 

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use global setting for all 
reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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Type Select the report type that you want to add to the 
Custom report, based on the component category you 
chose:

➤ Performance Update Reports

➤ Performance Update Summary 

➤ Performance of Locations 

➤ Performance of Transactions 

➤ Transaction Availability 

For details, see “Performance Update Report” on 
page 162. 

➤ User Experience Reports, located in Using End User 
Management:

➤ Availability Over Time Report

➤ Breakdown Over Time Report

➤ Breakdown Summary Report

➤ Min./Max. Response Time Report

➤ Overall Performance by Profiles. For details, see 
Multi-Profile Summary Report.

➤ Overall Performance of 3 Worst Locations (multi-
profile). For details, see Performance of Locations. 

➤ Overall Performance of 3 Worst Profiles (multi-
profile). For details, see Multi-Profile Summary 
Report. 

➤ Performance Matrix Report

➤ Profile Summary Report in Additional Reports

➤ Response Time – 90th Percentile Report in 
Additional Reports

➤ Response Time by Percentile Report

➤ Response Time Over Time Report

For details, see “Business Process Reports Overview” on 
page 160. 

GUI Element (A–Z) Description
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System Availability Management Components

The following elements are included (listed alphabetically):

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. These options are not available for all reports. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

Width Select the width of the frame size for the component. 

GUI Element (A–Z) Description

Display Select whether you want HP Business Availability Center 
to display the best- or worst-performing monitors, and 
choose the number of monitors to be displayed in the 
report in the Monitors list.

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then configure how long ago the 
data for the report should be generated in the Start field. 
If you selected Enable time period per component when 
defining the report properties, select the time period for 
which HP Business Availability Center initially generates 
the report in the Interval list. 

GUI Element (A–Z) Description
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Monitor Title Specify the monitors (by their title, as defined in 
SiteScope) on which you want the Custom report data to 
be based.

Leave empty to instruct HP Business Availability Center 
to base the report on all values. 

You can use the asterisk symbol (*) as a wildcard to 
instruct HP Business Availability Center to base the 
report on a subset of all values. For example, to name all 
CPU monitors in SiteScope with the naming convention 
cpu_<servername>, specify cpu* to instruct HP Business 
Availability Center to include all CPU monitors in the 
Custom report.

Note: 

➤ It is not recommended to enter a wildcard as the first 
character in a string because HP Business Availability 
Center is unable to use the Index tables when 
querying the database, thus slowing report generation 
times. 

➤ This field is available only for the SiteScope Monitor 
Performance component category.

Monitor Type Select the monitor on which you want the Custom report 
data to be based. To base the report on all monitors, 
choose All types.

Note: This field is available only for the SiteScope 
Monitor Performance component category.

Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

GUI Element (A–Z) Description



Chapter 6 • Custom Reports

147

147

Profile Select a profile for the Custom report component. 

Note: This field is available only for the SiteScope 
Monitor Performance component category. 

Report Displays Cross-Performance, to add the Cross-
Performance report component to the Custom report. 

Server Name Specify the servers on which you want the Custom report 
data to be based.

Leave empty to instruct HP Business Availability Center 
to base the report on all values. 

Note: This field is available only for the SiteScope 
Monitor Performance component category.

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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User Report Components

The following elements are included (listed alphabetically):

Type Select a specific SiteScope report component to add to 
your Custom report. Choose from the following reports, 
located in Using System Availability Management: 

➤ Overall Performance Report. For details on this report, 
see “Overall Performance Report” in Using System 
Availability Management.

➤ SiteScope Data Over Time Report. For details on this 
report, see “SiteScope Data over Time Report” in Using 
System Availability Management.

➤ SiteScope Profile Summary Report, contained in the 
Group Performance Report. For details on the Group 
Performance report, see “SiteScope Data over Time 
Report” in Using System Availability Management.

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

GUI Element (A–Z) Description

Height Select the height of the frame size for the component. 

Important: Keep in mind the required frame size for 
correctly viewing the Web page content being accessed. 

Interval If you selected Use separate time period for each report 
when defining the report properties, select the time 
frame for which HP Business Availability Center should 
generate the report. You then configure how long ago the 
data for the report should be generated in the Start field. 
If you selected Enable time period per component when 
defining the report properties, this field reads Use global 
settings.

GUI Element (A–Z) Description
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Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select to add the Custom Query Builder report 
component. For details on the Custom Query Builder 
report, see “Custom Query Builder” on page 285.

Report Title Enter a descriptive title for the report. 

Note: This field is available only for the Service Report 
Builder component. 

Select Report Select a report to be included as a component for your 
Custom report. 

Note: This field is available only for the Service Report 
Builder component. 

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

GUI Element (A–Z) Description
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URL Select to create a report that calls a specified URL. For 
example, you can integrate links to external charts 
generated by third-party EMS software into the Custom 
report. You specify the URL as well as any parameters that 
you want the URL to process at runtime. 

HP Business Availability Center provides two templates 
that you can use as the arguments for parameters that 
process report times: 

➤ Start Time. Uses the argument $$startTime$$ to return 
the start time for the report.

➤ End Time. Uses the argument $$endTime$$ to return 
the end time for the report.

Example: A URL that uses parameters to return the chart 
type and start time of a report is:

http://www.myapp.com?graph=responsetime;starttime=$
$startTime$$ 

Note: 

➤ If the specified Web page includes JavaScript code that 
attempts to access the top frame, the browser displays 
an "access denied" error. To avoid this issue, set the 
browser to ignore JavaScript errors.

➤ Type the URL of the Web page you want HP Business 
Availability Center to display in the report. If the URL 
includes parameters, specify them as required. 

➤ To use one of the predefined arguments with a 
parameter in the URL, place the insertion point in the 
URL where you want to add the argument, select the 
required argument from the URL runtime templates 
list, and click Add Template.

➤ This field is available only when the URL component 
category is selected. 

GUI Element (A–Z) Description
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Dashboard Report Components

The following elements are included (listed alphabetically):

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

Width Select the width of the frame size for the component. 

Important: Keep in mind the required frame size for 
correctly viewing the Web page content being accessed.

GUI Element (A–Z) Description

Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your Custom report. 
The available reports are located in Using Dashboard and 
are displayed according to the selected component 
category, as follows: 

➤ Business Dashboard

➤ KPIs Distribution Over Time Report

➤ KPIs Summary Report

➤ KPIs Trend Report

➤ General

➤ KPIs Over Time Report

GUI Element (A–Z) Description



Chapter 6 • Custom Reports

152

152

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Select how long ago the data for the report should be 
generated. The granularity for this field is measured 
according to what you chose in the Interval field.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

View As Select Graph or Table, depending on the format in which 
you want HP Business Availability Center to display the 
report. 

In a report with multi-tab layout, all tabs are displayed 
one after another.

GUI Element (A–Z) Description
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Alert Report Components

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your Custom report. 
Choose from the following reports, located in Alerts:

➤ Actual vs. Baseline Suggested Alerts Report

➤ Actual vs. Baseline Suggested Alerts – Detailed Report

➤ Alerts Count Over Time Report

➤ Alerts Log Report

➤ Baseline Suggested Alerts Log Report

➤ Configuration Item Status Alerts Report

➤ SLA Status Alerts Report

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 



Chapter 6 • Custom Reports

154

154

Service Level Management Components

The following elements are included (listed alphabetically):

GUI Element (A–Z) Description

Position Select the position for the component within the Custom 
report, relative to the other components. Selecting 1 
instructs HP Business Availability Center to place the 
component at the top of the list (for the first component, 
you must select 1).

Note: For a component to appear in the Narrow format 
(as configured in the Size field), you must have two 
Narrow components positioned consecutively.

Report Select the report you want added to your Custom report. 
Choose from the following reports, located in Using 
Service Level Management:

➤ CI Impact Report

➤ CI Over Time vs. Target Report

➤ CI Status Report

➤ CI Summary Report

➤ CIs Over Time Report

➤ Outage Breakdown Report

➤ Outage Distribution Report

➤ Outage Summary Report

➤ SLA Status Report

➤ SLAs Summary Report

➤ Time Range Comparison Report

Size Select the size to be displayed for the report component:

➤ Wide. The component is displayed across the whole 
page.

➤ Narrow. The component is displayed across half the 
page.
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Filters Dialog Box

Start Time Select the default time period for which HP Business 
Availability Center initially generates the report. 

You can select this time period only if you selected Use 
separate time period for each report when defining the 
report properties. If you selected Use one time period for 
all reports, this field displays Use global settings. 

Title Type the descriptive title that you want to appear in the 
report components table, or accept the default. 

Description Enables you to configure filters for the selected 
component. 

To access: Click the Edit Filter button  on the Reports 
page in the Custom Report Wizard. 

Note: 

➤ This dialog box may have the heading Component 
Filters for certain components.

➤ The Edit Filter button is not enabled for the Service 
Report Builder and URL components in the User 
Reports category. 

GUI Element (A–Z) Description
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Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page

Important 
Information

➤ The elements displayed in this dialog box depend on 
the particular report you have selected. For details on 
the elements that are displayed, see the relevant 
documentation for the selected report.

➤ For a component that includes a time range 
comparison, the Component Filters window includes 
a Time Ranges option where you set the time ranges to 
be compared in the report. 

When the Custom report is set to Use global settings 
for all components, the available time ranges include 
Global Time. The global time range is determined by 
the time range selected when the report is generated, 
or by the time range set by the report schedule. 

➤ If you do not have access permissions to the profile in 
the component (or to at least one of the profiles in a 
multi-profile component), or if the profile has been 
removed from the database, you cannot edit 
component filters.

For details on setting report filters, see “Configure 
Report Filters Globally” in Platform Administration, 
“Report Filters Page” in Using End User Management, 
and “Active Filters Dialog Box” in Using End User 
Management.
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Header/Footer Page

Reports Preview Page

Description Enables you to add a Custom header or footer to your 
Custom report.

To access: Enter parameters on the Report Properties and 
Report Components pages in the Custom Report Wizard.

Important 
Information

➤ The header and footer you configure on the 
Header/Footer page overrides the default header and 
footer configured from the Set default header/footer 
for all Custom & Trend reports button  in the 
Report Manager. 

➤ General information about the wizard is available at 
“Favorite Filters Wizard” on page 107.

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page

Description Displays the Custom report according to the properties 
configured in the Custom Report Wizard. 

To access: Enter parameters on the Report Properties, 
Report Components, and Header/Footer pages in the 
Custom Report Wizard.

Important 
Information

➤ General information about the wizard is available in 
“Custom Report Wizard” on page 136.

➤ Note to HP Software-as-a-Service Customers:

If you selected Do not generate the report 
automatically in the Automatic Generation field on 
the Report Properties page, you must click the 
Generate button to view the report data.

Wizard Map Report Properties Page > Report Components Page > Add 
Component Dialog Box > (Filters Dialog Box) > 
Header/Footer Page > Reports Preview Page
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Troubleshooting and Limitations

This section describes Troubleshooting and Limitations of Custom reports, 
divided into the following sections:

➤ General. General limitations of Custom reports.

➤ Report Components. Limitations relating to individual report components. 

General
This section describes general limitations of Custom reports.

➤ Within any one specific component, HP Business Availability Center can 
display only those profiles that have the same settings for outlier values. 
Therefore, in the Custom Report Wizard, you should select a set of profiles 
that have the same setting for outlier values. For details on modifying 
outlier value settings for a profile, see “Transaction Threshold Settings” in 
Using End User Management.

➤ After creating Custom reports, if you then configure user or global-level 
report filters to filter specific transactions, locations, or groups from reports, 
the filtered values still appear in the reports. To remove any newly filtered 
values from existing Custom reports, you must remove and re-add the 
components containing the elements for which filters have been set, and 
save the report.
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Report Components
This section describes limitations relating to individual reports components.

➤ When configuring the Service Level Management report component and 
selecting Use global settings for all components, if a global time range is 
selected (at report generation) that does not match the time ranges of the 
SLA filtered in the Service Level Management component, the following 
message is displayed upon report generation: No associated tracking periods 
exist.

➤ If you have upgraded from a previous version of HP Business Availability 
Center and have a Custom report containing the Response Time by 
Percentile Report component who’s time period ends in the past (for 
example, two days ago, three days ago, and so forth), the time range for the 
report defaults to the shortest predefined time range that includes the 
previous setting. For example, for a report that was configured to end two 
days ago, the Past Week time range is used. For a report that was configured 
to end eight days ago, the Past Month time range is used. This limitation 
applies only if you have selected the Use separate time period for each 
report option in the Report Properties page of the Custom Report Wizard.

➤ To see data in the report after adding Business Dashboard components, you 
must select CIs and KPIs in the filter.
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7
Additional Custom Reports

This chapter describes reports that cannot be accessed directly from any 
application but that can be added to Custom reports to provide additional 
information. 

This chapter includes:

Concepts

 ➤  Additional Custom Reports - Overview on page 161

 ➤  Performance Update Report on page 162

 ➤  Profile Summary Report on page 162

 ➤  Response Time – 90th Percentile Report on page 163

 ➤  Overall Performance Report on page 165

Reference

 ➤  Additional Custom Reports - User Interface on page 165
Concepts

Additional Custom Reports - Overview

The Additional Custom reports cannot be accessed directly from any 
application, but they can be added to Custom reports to provide additional 
information. Additional Custom reports display information about 
transaction response times and availability for Business Process Monitor 
profiles. For details on Custom reports, see “Custom Reports” on page 127.

For details on working with reports, see “Working in Reports” on page 39.
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The following reports are available:

➤ Performance Update Report on page 162

➤ Profile Summary Report on page 162

➤ Response Time – 90th Percentile Report on page 163

➤ Overall Performance Report on page 165

Performance Update Report

The Performance Update report is a scheduled report that is configured to be 
sent to specified recipients, through email, on a periodic basis. The report 
includes key metrics on the performance of the transactions and locations 
defined in a specific profile.

You define transaction thresholds—to specify the OK, Warning, and Poor 
range for each transaction—when you create a profile. You can also modify 
the transaction threshold ranges, as well as the default outlier value of 45 
seconds, from End User Management Administration. For details, see “Edit 
Transaction Monitor Page” in Using End User Management.

You add components of the Performance Update report to Custom reports. 
For details on the Performance Update Report User Interface, see 
“Performance Update Report Output” on page 166.

Profile Summary Report

The Profile Summary displays an overview of the transaction response time 
and availability for each Business Process Monitor profile that you add to 
the report. For details on configuring Custom reports and their components, 
see “Custom Report Wizard” on page 136.

For details on the Profile Summary Report User Interface, see “Profile 
Summary Report Output” on page 169.
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Response Time – 90th Percentile Report

The Response Time – 90th Percentile report does not appear in any 
application and can be added only to Custom reports to provide additional 
information. For details on configuring Custom reports, see “Custom Report 
Wizard” on page 136.

The Response Time – 90th Percentile displays, for each indicated point in 
time, the specific response time value that 90 percent of all measured 
response time values are equal to or below. You can view the data in either 
chart or table format.

When calculating each point along the chart (or value in the table), 
HP Business Availability Center considers all transaction instances between 
the given point in time and the following point. For example, when 
displaying the report in the "Day" resolution, HP Business Availability 
Center divides the x-axis (or table) per hour. The value at each point along 
the chart (or in each cell in the table) represents the 90th percentile for the 
following hour.

In the above chart, 90% of the transactions that ran between 9:00 AM and 
9:59 AM had response times equal to or below 23.757.
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The Response Time – 90th Percentile data helps you identify response time 
problems and pinpoint their source. Because the data excludes response 
times above the 90th percentile (the highest 10 percent of response times), 
non-representative or non-typical transaction instances (for example, 
transactions that run during a server reboot) are eliminated. Thus, the data 
provides a more accurate picture of transaction performance over the 
defined time period.

By breaking down the data by transaction, location, or group across 
different time frames, you can identify exactly where and when transaction 
response times are too slow. For example, you might determine that 
response times in the 90th percentile for transactions from a specific 
location are consistently high over the course of several hours. This might 
indicate a problem somewhere along the network between that location and 
the monitored Web site.

You can further analyze the Response Time – 90th Percentile data as 
described below:

➤ place your cursor over any small square along the chart to view a tooltip 
containing details about the specific response time value that 90 percent of 
all response time values were equal to or below.

➤ modify the report time frame and click Generate to generate the modified 
report.

➤ drill down in the chart view. Click any time point in the chart to increase 
the time resolution for the selected transaction, location, or group. Click 
any drill down link to the right of the report, to focus on that transaction, 
location, or group.

➤ drill down in the table view. Click any link in a column or row header to 
focus on a specific time frame, transaction, location or group.

➤ select the table view in the Custom Report Manager to display the report in 
table format.

The table displays, for each point in time, the specific response time value 
that 90 percent of all response time values were equal to or below. You can 
view the table broken down by transaction, location, or group.
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➤ Apply component filters in the Custom Report Manager. Click the Edit 
Filters button, and select or clear check boxes to view the report filtered by 
specific transactions, locations, or groups.

Overall Performance Report

The Overall Performance report is a System Availability Management report 
which displays a quick snapshot of the performance of the monitored 
infrastructure machines in the selected SiteScope profiles. It can be added 
only from the Custom Report Wizard, and cannot be accessed from the 
System Availability Management context. For details on the Overall 
Performance Report, see “Overall Performance Report” in Using System 
Availability Management. 

Reference

Additional Custom Reports - User Interface

This section describes:

 ➤  Performance Update Report Output on page 166

 ➤  Profile Summary Report Output on page 169

 ➤  Response Time – 90th Percentile Report Output on page 171
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Performance Update Report Output

This is an example of the Performance Update Report:
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays key metrics on the performance of the 
transactions and locations defined in a specific profile.

To access: You view the Performance Update report either 
in your email client or in a Web browser. You can view 
the Performance Update report from a Custom report to 
which the Performance Update report component has 
been added. 

Useful Links “Performance Update Report” on page 162

“Custom Reports” on page 127

GUI Element (A–Z) Description

<Common report 
elements>

For details, see “Common Report Elements” on page 56.

Report Title and 
Frequency

Displays the title of the report, and in parentheses the 
report frequency.

Time Zone and Time 
Frame for Report

Displays the configured time zone relative to GMT, as 
well as the time frame of the report. For a reference list of 
GMT time zones for locations throughout the world, see 
“GMT Time Zones” in Reference Information.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Outlier transaction 
reporting status>

Describes whether HP Business Availability Center 
ignores outlier transactions in reports, or treats them as 
failed transactions (this setting is defined during profile 
definition in End User Management Administration).

Alerts Sent Displays the total number of alerts sent, including the 
number of critical severity alerts, for the measured 
period.

Availability Displays the percentage of transactions that succeeded 
(did not fail) during the measured period.

Failed Transactions Displays the total number of failed transactions for the 
measured period.

Outlier Transactions Displays the total number of outlier transactions for the 
measured period.

Performance of 
Locations

Displays, for the measured period and for each location, 
the percentage of transactions that fell into each defined 
transaction threshold range, (OK, Warning, and Poor), 
the percentage of failed transaction instances, the total 
number of transactions, and the percentage of outlier 
transactions.

Performance of 
Transactions

Displays, for the measured period and for each 
transaction, average transaction response time, the 
percentage of transaction instances that fell into each 
defined transaction threshold range, (OK, Warning, and 
Poor), the percentage of failed transaction instances, the 
total number of transaction instances, and the 
percentage of outlier transaction instances.

Performance Update 
Summary

Displays the transaction availability and total alerts sent 
for the measured period. 

Profile name Displays the Business Process profile upon which the 
report is based.
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Profile Summary Report Output

This is an example of the Profile Summary Report:

Total Transactions Displays the total number of transactions run during the 
measured period.

Transaction 
Availability

Displays the availability rate for each transaction in the 
profile, for the measured period. If a description of the 
transaction is set, the description is displayed (this 
setting is defined during transaction monitor 
configuration in End User Management Administration).

Description Displays an overview of the transaction response time 
and availability for each Business Process Monitor profile 
that you add to the Custom report. 

To access: You can view the Profile Summary report in 
the Custom report to which the Profile Summary report 
component has been added. 

Important 
Information

If you apply active filters, only the selected transactions, 
locations, and groups are included in the report. For 
details on applying active filters, see “Active Filters 
Dialog Box” in Using End User Management.

Useful Links “Profile Summary Report” on page 162

“Custom Reports” on page 127

GUI Element (A–Z) Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<Common report 
elements>

For details, see “Common Report Elements” on page 56.

Performance Displays the performance level for the selected profile, 
indicated by a colored icon. 

Profile Name Displays the Business Process profile upon which the 
report is based. 

You can click the profile name to generate a Transaction 
Analysis report for the profile. For details, see 
“Transaction Analysis Report” in Using End User 
Management.

Transaction 
Availability

Displays the availability of the transactions running on 
the selected profile, indicated by a colored icon. For 
details on the color codes, see “Report Content” on 
page 170.

GUI Element (A–Z) Description

<Gray Icon> ➤ Performance. Indicates that no transaction data is 
defined. 

➤ Transaction Availability. N/A

<Green Icon> ➤ Performance. Indicates that each transaction's average 
response time fell within the OK threshold level. 

➤ Transaction Availability. Indicates that no transactions 
failed.

<Profile Name> The name of the Business Process profile upon which the 
report is based. 
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Response Time – 90th Percentile Report Output

This is an example of the Response Time - 90th Percentile Report:

<Red Icon> ➤ Performance. Indicates that at least one transaction's 
average response time fell within the Critical threshold 
level. 

➤ Transaction Availability. Indicates that at least one 
transaction failed. 

<Yellow Icon> ➤ Performance. Indicates that at least one transaction's 
average response time fell within the Minor threshold 
level, but no transaction's average response time fell 
within the Critical threshold level. 

➤ Transaction Availability. N/A

GUI Element (A–Z) Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, for each indicated point in time, the specific 
response time value that 90 percent of all measured 
response time values are equal to or below. 

To access: You can view the Response Time - 90th 
Percentile Report in the Custom report to which the 
Response Time - 90th Percentile report component has 
been added. 

Important 
Information

You can apply component filters in the Custom Report 
Wizard by clicking the Edit Filter button , and select 
or clear check boxes to view the report filtered by specific 
transactions, locations, or groups.

Useful Links “Response Time – 90th Percentile Report” on page 163

“Custom Reports” on page 127

GUI Element (A–Z) Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

Profile The Business Process profile upon which the report is 
based.
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Report Content - Graph View

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content - Table View

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

<drill down link> Click any drill down link to the right of the report to 
focus on that transaction, location, or group.

<small square on 
chart>

➤ Place your cursor over any small square along the 
graph to view a tooltip containing details about the 
specific response time value that 90 percent of all 
response time values were equal to or below.

➤ Click any time point in the graph to increase the time 
resolution for the selected transaction, location, or 
group.

Response Time (sec.) The time, in seconds, for which the report data is 
generated.

Time Range The time frame that the report data is generated over. 
The intervals displayed depend on the granularity chosen 
in the Every field. 

GUI Element (A–Z) Description

<Date and Time> The date and time that the data is generated for in the 
given transaction. The time interval depends on the 
granularity selected in the Every field. 

<Transaction Name> The name of the transaction in the profile being 
monitored.

<Values in Table> The specific response time value that 90 percent of all 
response time values were equal to or below for the given 
point in time. 
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8
Trend Reports

This chapter includes the main concepts, tasks, and reference information 
for Trend reports.

This chapter includes:

Concepts

 ➤  Trend Reports - Overview on page 176

 ➤  Understanding the Trend Report Scale on page 177

 ➤  Adding Measurements to a Trend Report on page 177

 ➤  Understanding the Header/Footer Page in the Trend Report Wizard 
on page 178

Tasks

 ➤  Modify the Maximum Number of Report Measurements on page 180

Reference

 ➤  Trend Reports User Interface on page 181

Troubleshooting and Limitations on page 199
Concepts
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Trend Reports - Overview

Trend reports enable you to compare multiple measurements from several 
profiles, based on data collected by Business Process Monitor, Real User 
Monitor, and SiteScope. You can also add custom monitor data—including 
Real User Monitor data—to Trend reports.

Combining measurements for several monitors on the same chart enables 
you to analyze: 

➤ Analyze the relationship between transaction response time and availability. 

➤ Analyze the relationship between network and server health.

➤ Analyze the same set of measurements over two time periods (for example, 
you can compare measurements for the past hour and the hour before that).

➤ Monitor infrastructure machine performance over a selected time range.

When viewing Trend reports, you can: 

➤ Display data using different data aggregation methods and according to 
different groupings.

➤ Adjust the scale used when displaying a measurement. 

➤ Add a custom header and footer to the report.

➤ View raw data when choosing a time range of two days or less. 

When HP Business Availability Center generates the Trend report, it displays 
data in time segments that differ depending on the time granularity you 
select in the Time Range and Granularity bar. For details on using the Time 
Range and Granularity bar, see “Time Range and Granularity Bar” on 
page 70.

Trend reports are configured in the Trend Report Wizard, accessible from the 
Report Manager in the User Reports context. For details on configuring a 
Trend report, see “Trend Report Wizard” on page 190.

You view existing Trend reports by selecting a Trend report in the Report 
Manager and clicking the View Report button. For details on the Trend 
report User Interface, see “Trend Report Output” on page 182.
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Understanding the Trend Report Scale

Measurement values in the Trend report are displayed along the y-axis using 
a normalized scale. By default, HP Business Availability Center automatically 
sets the scale factor for each measurement. If required, you can manually 
modify the scale factor for any measurement in the table on the Select 
Measurements page, for example, to better view multiple measurements 
whose data values span a wide range. For details, see “Select Measurements 
Page” on page 192.

When you manually modify the scale factor, HP Business Availability Center 
scales measurement values by dividing the actual value by the value chosen 
in the scale list. Thus, a value of 100 with a scale setting of 0.1 is shown as 
1000 along the y-axis. A value of 100 with a scale setting of 10 is shown as 
10 along the y-axis.

For example, if at a given point in time Measurement A (whose scale value is 
set to "Auto") has a value of 10 and Measurement B (whose scale value is set 
to 0.1) has a value of 90, the y-axis displays a range from 0-1000 to 
accommodate both values. If both measurements’ scale settings are set to 
"Auto," the y-axis value ranges from 0-100.

Adding Measurements to a Trend Report

You add measurements to a Trend report using the Measurement Selection 
page of the Trend Report Wizard. You can compare the measurements in a 
Trend report for the selected time range to the same set of measurements 
over a similar time period, but for a different start date. For example, to 
compare performance over two consecutive days, you could generate a 
Trend report for one day starting Dec. 12 at midnight, and then generate the 
comparison data for one day starting Dec. 11 at midnight. 

You can add up to 20 measurements to a Trend report. 
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Measurement Selection
On the Measurement Selection page in the Trend Report Wizard, 
measurements are grouped into tables by monitor type. You can optionally 
adjust the name and color of configured measurements, as well as the scale 
factor for each measurement in the Scale field on the table. For details on 
the Trend report scale, see “Understanding the Trend Report Scale” on 
page 177. 

Measurement filters differ per monitor category. Depending on the monitor 
type you choose, HP Business Availability Center displays various filters by 
which you determine which measurements are to appear in the Trend 
report. You must select an entry from each list. 

For each monitor category, HP Business Availability Center displays the 
counters (measurements) that are relevant to the selected groups or data 
types. You select the relevant counter (measurement) to add to your Trend 
report.

For details on adding measurements to a Trend report, see “Select 
Measurements Page” on page 192. 

Understanding the Header/Footer Page in the Trend 
Report Wizard

You can add a Custom Header and Footer to your Trend report, using the 
Header/Footer page in the Trend Report Wizard. The Custom Header and 
Footer can include: 

➤ Free text

➤ HTML tags used to mark up the text

➤ Hypertext links

➤ JavaScript

The Custom Header and Footer can also include references to external 
resources such as images, Flash files, and so on. If you do not mark up the 
text, it is formatted according to the browser defaults. 
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You add the Custom Header and Footer into the Report Header and Report 
Footer panes, respectively.

HP Business Availability Center adds the HTML header to the report directly 
below the report filter, and the HTML footer at the end of the report, 
immediately before closing the body tag. 

Note: 

➤ The header and footer you configure on the Header/Footer page 
overrides the default header and footer configured using the Set default 
header/footer for all Custom & Trend reports button in the Report 
Manager. 

➤ Use caution when marking up the header and footer fields, as some 
HTML code may affect the behavior of HP Business Availability Center. 
For example, a linked URL may contain JavaScript that causes the URL to 
"break out" of frames. Make sure you use valid HTML.

➤ It is recommended that you perform an external check of the HTML code 
used in the header and footer, as HP Business Availability Center does 
not perform any validity checks on the header and footer content.

For details on the Header/Footer page, see “Header/Footer Page” on 
page 198.

Tasks
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Modify the Maximum Number of Report Measurements

This task describes how to modify the maximum number of measurements 
displayed in a Trend report.

To modify the maximum number of measurements displayed in a Trend 
report:

 1 Access the HP Business Availability Center Infrastructure Settings Manager, 
by navigating to Admin > Platform > Setup and Maintenance > 
Infrastructure Settings.

 2 Select the Applications context. 

 3 Choose End User Management/System Availability Management from the 
list. 

 4 Locate the End User Management/System Availability Management - Data 
table. 

 5 Change the value in the Max Trend Report Measurements setting, as 
necessary. 

Reference
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Trend Reports User Interface

This section describes:

 ➤  Trend Report Output on page 182

 ➤  Trend Report Wizard on page 190
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Trend Report Output

This is an example of a Trend report:

Description Displays a data comparison of multiple measurements 
from several profiles collected by Business Process 
Monitor and SiteScope. Trend reports enable you to 
analyze the effect of various aspects of your system on 
transaction response time. 

To access: Select Applications > User Reports > Report 
Manager, select a Trend report in the table and click the 
View Report button  to view the Trend report.

Choose the View as Graph tab to view the Trend report 
data in graph format. 

Choose the View as Table tab to view the Trend report 
data in table format.

Useful Links “Trend Reports - Overview”
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Report Settings
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Report Content as Graph
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

Every Click to set a granularity by which to view the report. For 
details on setting the granularity of reports, see “Time 
Range and Granularity Bar” on page 70.

Raw Data Click to view every instance of data output for the 
selected transaction. 

Note: 

➤ A point on the graph appears when there is a change 
in the data value or measurement frequency from the 
previous time point on the graph. However, if there 
has been no change in either of these areas over the 
course of one hour, a point is nevertheless displayed 
on the graph.

➤ A straight line on the graph with no points indicates 
the following:

➤ There has been no change in the value of the 
incoming data from the previous time point on the 
graph.

➤ There has been no change in the frequency that the 
incoming data is measured in since the previous 
time point on the graph.

➤ A gap in the graph indicates that no data has been 
retrieved for the specific time period.
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GUI Element (A-Z) Description

<data points> The time intervals that data is displayed for, based on the 
chosen granularity. For example, if you chose to view 
data every hour from March 18, 2008 at 2:00 PM to 
March 19, 2008 at 2:00 PM, the x-axis displays points of 
data for every hour from the report’s start time to its end 
time. If Raw data is chosen instead of a granularity, every 
instance of a change in data output for the select 
transaction is displayed. 

Comparison Time The time range with which the selected Trend report is 
being compared. 

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

The Comparison Time graph contains: 

➤ y-axis. The value of the y-axis, as configured on the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 70.

Report Time The time range of the generated report. The Report Time 
graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 70.
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Selected Measurements Table

The Selected Measurements table contains the following elements (not all 
elements appear for all monitor types; unlabeled GUI elements are shown in 
angle brackets):

Selected 
Measurements

The measurements chosen for the Trend report, grouped 
by monitor type, as configured in the Trend Report 
Wizard. For details, see “Selected Measurements Table” 
on page 185. 

Time Comparison The time frames for which data is to be compared. This 
table contains the following elements: 

➤ <left most column>. Lists the table on which the time 
comparison is being measured.

➤ From. The time that the data comparison in the 
selected Trend report is to start.

➤ To. The time that the data comparison in the selected 
Trend report is to end.

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

GUI Element (A-Z) Description

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report, as configured in the Trend Report Wizard. Click 
the color swatch to customize the color. 

Aggregation The data aggregation method for the selected 
measurement.

Group The monitor group, as defined in the host properties.

Location The location of the host machine. 

Note: This field is visible only for Business Process 
Monitor measurements.

Measurement The measurement being monitored by the Trend report. 

GUI Element (A-Z) Description
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Name The name of the Trend report. 

Tooltip: The full name of the Trend report, as per the 
counter and transaction configured on the Measurement 
Selection page. 

Profile The monitor profile with which the selected 
measurement is associated. 

Scale The scale setting configured in the Trend Report Wizard 
which HP Business Availability Center divides by the 
actual measurement value. Thus, a value of 100 with a 
scale setting of 0.1 is shown as 1000 along the y-axis. A 
value of 100 with a scale setting of 10 is shown as 10 
along the y-axis.

Transaction The monitor transaction with which the selected 
measurement is associated.

Used Aggr. Data Displays the aggregation table from which data was 
taken. Options are: 

➤ Daily 

➤ Hourly

Note: This option is not relevant for raw data.

GUI Element (A-Z) Description
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Report Content as Table
When the View as Table option is chosen, the elements displayed depend on 
whether you have chosen to view aggregated data or raw data:

Aggregated Data Elements

The following elements are displayed when the Every option is selected on 
the Time Range and Granularity Bar (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report, as configured in the Trend Report Wizard. Click 
the color swatch to customize the color. 

<measurement name 
headers>

The measurement name headers correspond to the 
selections made on the Measurement Selection page, 
accessible from the Select Measurements page in the 
Trend Report Wizard. For details, see “Measurement 
Selection Page” on page 193.

Note: <measurement name headers> are displayed only 
when the Every option is selected on the Time Range and 
Granularity bar. For details on the Time Range and 
Granularity bar, see “Time Range and Granularity Bar” 
on page 70.

<time intervals> Data output for the displayed time. 

Note: <time intervals> are displayed only when the Every 
option is selected on the Time Range and Granularity 
bar. For details on the Time Range and Granularity Bar, 
see “Time Range and Granularity Bar” on page 70.
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Report Time The time range of the generated report. The Report Time 
graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
Bar. For details on the Time Range and Granularity 
Bar, see “Time Range and Granularity Bar” on page 70.

Selected 
Measurements

The measurements chosen for the Trend report, grouped 
by monitor type, as configured in the Trend Report 
Wizard. For details, see “Selected Measurements Table” 
on page 185. 

Time Comparison The time frames that data is to be compared for. This 
table contains the following elements: 

➤ Name. The name of the transaction being measured.

➤ <Date and Time> The data and time that the data is 
being measured for. The data and time entries that 
appear are dependent on the configurations set on the 
Time Range and Granularity bar. For details on the 
Time Range and Granularity Bar, see “Time Range and 
Granularity Bar” on page 70

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

GUI Element (A-Z) Description
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Raw Data Elements

The following elements are displayed when the Raw Data option is selected 
on the Time Range and Granularity bar:

The last two tables are the same as in aggregated. The difference is in Time, 
Measurement, and Value.

GUI Element (A-Z) Description

Comparison Time The time range which the selected Trend report is being 
compared with. 

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

The Comparison Time Graph contains: 

➤ y-axis. The value of the y-axis, as configured in the 
Trend Properties page in the Trend Report Wizard.

➤ <time stamp>. The time range and granularity for 
which report data is displayed, based on the 
configurations set on the Time Range and Granularity 
bar. For details on the Time Range and Granularity Bar, 
see “Time Range and Granularity Bar” on page 70.

Report Time The time range of the generated report, based on the 
configurations set on Time Range and Granularity bar. 
This table displays the following elements: 

➤ Time. The time that the selected data is generated for 
in the Trend report.

➤ Measurement. The measurement being monitored by 
the Trend report. 

➤ Value. The value of the data in the specific 
measurement being monitored by the Trend report.
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Trend Report Wizard

Selected 
Measurements

Displays tables of the measurements selected on the 
Measurement Selection Page, accessed from the Select 
Measurement page of the Trend Report Wizard. For 
details, see “Measurement Selection Page” on page 193.

Time Comparison The time frames that data is to be compared for. This 
table contains the following elements: 

➤ <left most column>. Lists the table on which the time 
comparison is being measured.

➤ From. The time that the data comparison in the 
selected Trend report is to start.

➤ To. The time that the data comparison in the selected 
Trend report is to start.

Note: This table is visible only if you selected the 
Comparison Time check box on the Trend Properties 
page of the Trend Report Wizard.

Description Enables you to configure a Trend report in the Report 
Manager to compare multiple measurements from 
various monitors. 

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New Trend 
Report.

Wizard Map Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page

Useful Links “Trend Reports - Overview” on page 176

GUI Element (A-Z) Description
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Trend Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure properties for your Trend 
report.

To access: Select Applications > User Reports > Report 
Manager, click the New icon  and select New Trend 
Report.

Important 
Information

General information about the wizard is available in 
“Trend Report Wizard” on page 190.

Wizard Map The Trend Report Wizard contains:

Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page

GUI Element (A-Z) Description

Comparison start 
time

Click the checkbox to enable comparison of the 
measurements in the Trend report over multiple time 
periods. Click the date and time link to select a date and 
time for the comparison data to be measured. 

Example: To compare performance over two consecutive 
days, you could generate a Trend report for one day 
starting Dec. 12 at midnight, and then generate the 
comparison data for one day starting Dec. 11 at 
midnight. 

Page title Enter a descriptive name for the report. This name 
appears at the top of the report display page.

Report name Specify a report name to appear in the Report Manager.

Default value: The page title value. 

Y-axis label Enter the required label of the Y-axis. This text is used for 
the Y-axis in report charts.
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Select Measurements Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the measurements to display in the 
merged report chart. 

To access: Enter information in the Trend Properties page 
of the Trend Report Wizard.

Important 
Information

➤ The fields displayed on the tables that appear on this 
page are configured on the measurement selection 
page. For an explanation of these fields, see 
“Measurement Selection Page” on page 193.

➤ General information about the wizard is available in 
“Trend Report Wizard” on page 190.

Wizard Map Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 

GUI Element (A-Z) Description

Click to open the Measurement Selection page and add 
measurements to your Trend report. For details, see 
“Measurement Selection Page” on page 193.

<color box/color 
swatch>

Displays the color of the selected measurement in the 
report. Click the color swatch to customize the color. 

Aggregation The data aggregation method for the selected 
measurement.

Group The monitor group, as defined in the host properties.

Location The location of the host machine. 

Note: This field is visible only for Business Process 
Monitor measurements.

Measurement The measurement being monitored by the Trend report. 
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Measurement Selection Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Name The name of the Trend report. 

Tooltip: The full name of the Trend report, as per the 
counter and transaction configured on the Measurement 
Selection page. 

Profile The monitor profile that the selected measurement is 
associated with. 

Scale The scale setting by which HP Business Availability 
Center divides by the actual measurement value. Thus, a 
value of 100 with a scale setting of 0.1 is shown as 1000 
along the y-axis. A value of 100 with a scale setting of 10 
is shown as 10 along the y-axis. For details on adjusting 
the Trend report scale, see “Understanding the Trend 
Report Scale” on page 177.

Transaction The monitor transaction that the selected measurement 
is associated with.

Description Enables you to select measurements to add to your Trend 
report, per monitor type.

To access: Click the Add Measurements button  on 
the Select Measurements page of the Trend Report 
Wizard. 

Useful Links “Trend Report Wizard” on page 190

GUI Element (A-Z) Description

Click to activate the search for the data in the Contains 
box.

Contains Enter the measurement you want to search for in the 
selected filter.

GUI Element (A-Z) Description
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Data Aggregation 
Method

Select a data aggregation method. 

HP Business Availability Center calculates the data to 
display for each time segment based on the data 
aggregation method you choose:

➤ Average. For each time segment, calculates and 
displays the average of all data collected during that 
segment.

➤ Maximum. For each time segment, displays the single 
highest data value that occurred during that segment.

➤ Minimum. For each time segment, displays the single 
lowest data value that occurred during that segment.

➤ Count. For each time segment, displays the number 
(count) of data values that occurred during that 
segment.

➤ Sum. For each time segment, displays the sum of data 
values that occurred during that segment.

Group by Select a format by which to group results. 

➤ Transaction. Results are shown per transaction.

➤ Location. Results are shown per host machine 
location.

➤ Group. Results are shown per group, as defined in the 
host properties.

Note: This field is visible only if you chose the Business 
Process Monitor monitor type. 

GUI Element (A-Z) Description
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Monitor Type Select the type of monitor whose filters you want to 
select measurements from to include in the Trend report. 
The available monitors are:

➤ Business Process Monitor. Transaction-related data 
collected by the Business Process Monitor. For details 
on Business Process Monitor filters, see “Business 
Process Monitor Filters” on page 196.

➤ WebTrace. WebTrace or traceroute data collected by 
the Business Process Monitor.

➤ SiteScope. Infrastructure machine-related data 
collected by SiteScope. 

➤ Real User Monitor. Network and server performance 
and availability data in real time collected by the Real 
User Monitor.

Real User Monitor Trend reports analyze the trend of 
performance and availability data for the servers, 
pages, transactions, and end users that you configure 
for monitoring.

Note. The data types listed under Real User Monitor 
(Pages, Transactions, End Users) are the same as the 
RUM Pages, RUM Transactions, and RUM End Users 
data types listed in the Custom monitor type list. 
Selecting them from the Real User Monitor monitor 
type list saves having to define measurement filters for 
them in the Measurement Filters page. 

➤ Custom. Custom monitor data for which a filter has 
been defined in the Measurement Filters page. For 
details, see “Working with Measurement Filters” in 
Platform Administration.

GUI Element (A-Z) Description
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Business Process Monitor Filters

The following elements are included (listed alphabetically):

WebTrace Filters

The following elements are included (listed alphabetically):

GUI Element (A-Z) Description

Counter Transaction response time, transaction breakdown, and 
transaction availability data collected by Business Process 
Monitor. 

Group Defined groups to which hosts were assigned during 
profile creation.

Location Defined host locations (machines on which HP Business 
Availability Center Business Process Monitor Agent is 
running). 

Profile Business Process Monitor profiles.

Transaction Defined transactions in scripts assigned to profiles.

GUI Element (A-Z) Description

Counter WebTrace/traceroute data collected by Business Process 
Monitor.

Location Defined host locations (machines on which HP Business 
Availability Center Business Process Monitor Agent is 
running). 

Profile Business Process Monitor profiles.
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SiteScope Filters

The following elements are included (listed alphabetically):

Real User Monitor Filters

The following elements are included (listed alphabetically):

GUI Element (A-Z) Description

Group Tree Defined SiteScope groups and subgroups for the profile.

Measurement SiteScope monitor and measurement information, 
displayed using the following syntax: 

monitor title | monitored server | counter

Profile SiteScope profiles (one per SiteScope).

Top Groups Defined top-level SiteScope groups for the profile.

GUI Element (A-Z) Description

Data Type The type of data. Data types include:

➤ Pages. The pages that have been configured for 
monitoring by Real User Monitor.

➤ Transactions. The transactions that have been 
configured for monitoring by Real User Monitor.

➤ End Users. The end users that have been configured 
for monitoring by Real User Monitor.

Groups Groups of pages/transactions/end users as defined in End 
User Management. For details on configuring groups, see 
“Real User Monitor Administration” in Using End User 
Management.

Items The pages/transactions/end users of the selected groups; 
this is the actual filter that is to be used.

Measurements All measurements defined for the selected data type.
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Custom Filters

The following elements are included (listed alphabetically):

Header/Footer Page

GUI Element (A-Z) Description

Data Type The type of data for which the measurement filter is 
created.

Dimension The name of a specific filter field.

Dimension Values A specific instance of a field in custom data chosen when 
defining a measurement filter. You use dimension values 
to group data in a Trend report.

Filter Category Defined groups, created in the Measurement Filters page 
in Platform Administration, that help organize 
measurement filters into manageable groupings. For 
details on Measurement Filters, see “Working with 
Measurement Filters” in Platform Administration.

Filter Name The name of the measurement filter, created in the 
Measurement Filters page in Platform Administration, 
used to filter incoming custom data. For details on 
Measurement Filters, see “Working with Measurement 
Filters” in Platform Administration.

Measurement The available measurements for the selected data type.

Description Enables you to add a custom header or footer to your 
Trend report.

To access: Enter parameters on the Trend Properties and 
Select Measurements pages in the Trend Report Wizard.

Important 
Information

General information about the wizard is available in 
“Trend Report Wizard” on page 190.

Wizard Map Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 

Useful Links “Understanding the Header/Footer Page in the Trend 
Report Wizard” on page 178
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The following elements are included:

Preview Report Page

Troubleshooting and Limitations

➤ After creating Trend reports, if you then configure user or global-level report 
filters to filter specific transactions, locations, or groups from reports, the 
filtered values still appear in the reports. To remove any newly filtered 
values from existing Trend reports, you must remove and re-add the 
components containing the elements for which filters have been set, and 
save the report.

➤ Permissions are granted by system administrators through the User 
Management interface, and can be enabled or revoked at any time. Thus, 
permissions to modify a Trend report that you create may be removed by 
the administrator at a later time.

GUI Element (A-Z) Description

Footer HTML Enter the text for the Footer. 

Header HTML Enter the text for the Header. 

Description Displays the Trend report according to the properties 
configured in the Trend Report Wizard. 

To access: Enter parameters on the Trend Properties, 
Select Measurements, and Header/Footer pages in the 
Trend Report Wizard.

Important 
Information

➤ You can view the report either in Graph or Table 
format by clicking the appropriate tab. 

➤ General information about the wizard is available in 
“Trend Report Wizard” on page 190.

Wizard Map Trend Properties Page > Select Measurements Page > 
Header/Footer Page > Preview Report Page 
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➤ Transactions whose response times exceed their outlier value (set in 
Transaction Threshold Settings in System Availability Management) are 
always displayed in Trend reports as failed transactions, even if the Ignore 
outlier data in reports setting is selected for the profile to which the 
transactions belong.
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9
Accessing Custom and Trend Reports 
Using a URL

This chapter describes the concept of accessing Custom and Trend reports 
directly in a web browser, from outside of HP Business Availability Center. 

This chapter includes:

Concepts

 ➤  Accessing Custom and Trend Reports Using a URL on page 202
Concepts
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Accessing Custom and Trend Reports Using a URL 

You can build a URL that opens a defined Custom or Trend report directly in 
the browser, without being located in the HP Business Availability Center 
context.

Build the URL using the following syntax - the order of the parameters is not 
important:

The parameters whose values must be provided are described below:

➤ createSession. Mandatory. Use: true.

➤ offlineCustomerId. Default: 1. In a multi-customer environment, the 
customer ID may be different. Mandatory.

➤ outputFormat. Mandatory. Use: 1.

➤ timeZoneId. The time zone of the user location. Use the <country>/<town> 
format. If you use timeZoneId, do not use the gmtOffset parameter.

➤ filterProfileId. This field is needed for historical reasons. You can use any 
value (for example: 999).

➤ actionForward. Mandatory. Use: report.

➤ timeFrame. Use this parameter only for Custom Reports with the Use global 
settings for all reports option selected in the first page of the Custom Report 
wizard. In other reports or in Custom Reports with the Use global settings 
for all reports option cleared, the time range is already configured in the 
relevant report filter or in the filter of each component of the Custom 
Report. You can use: Custom (in that case, specify the time range using 
startTime and endTime parameters), or Day, Week, or Year (in that case, 
specify either the startTime or the endTime).

http://<ServerName>/topaz/OfflineReportsServlet?createSession=true
&offlineCustomerId=1&outputFormat=1&timeZoneId=<timeZone>
&filterProfileId=999&actionForward=report&timeFrame=<timeFrame>
&startTime=<startTime>&endTime=<endTime>&requestType=offline
&userlogin=<userLoginName>&userpassword=<userLoginPassword>
&gmtOffset=<gmtOffset>&useVIP=true&skipNavBar=true
&offlineLocaleLanguage=<language_code>&webinfra_doMHTzip=false&reportName=
Report_<reportID>&stepUnit=<stepUnit>&stepValue=<stepValue>
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➤ startTime/endTime. Start time/end time for the report. The date should use 
the format YYYYMMDDHHmm. The month index start from 0, so to view 
data from 21.06.2010 8:41 the start time should be: 201005210841. To 
understand when to use this parameter, see the description of timeFrame.

➤ requestType. Mandatory. Use: offline.

➤ userlogin/userpassword. Valid user/password login name. Warning: If you 
do not use a https protocol, your password might be exposed to network 
sniffers.

➤ gmtOffset. The user location’s GMT offset in minutes. If you use gmtOffset, 
do not use the timeZone parameter.

➤ useVIP. Mandatory. Use: true.

➤ skipNavBar. Mandatory. Use: true.

➤ offlineLocaleLanguage. Optional. Represents the locale language used to 
display the report. Use the lowercase 2-character ISO-639 language code. For 
example: en (for English). 

➤ webinfra_doMHTzip. Use: false to zip the attachment (for example to zip 
the PDF).

➤ reportName. Use the format: Report_<reportId>. The 
CR_CUSTOM_REPORT_ID value for the report, as specified in the 
CUSTOM_REPORTS table in the management database.

➤ ServerName. The name of the Business Availability server (Gateway Server 
in a distributed architecture). Mandatory.

➤ stepUnit/stepValue. Optional. Use stepUnit to specify the report time frame 
granularity, depending on the time range selected for the report. Use 
StepValue to quantify the number of stepUnits to use for the report time 
frame granularity. For example: if the report time range is a week, specify 
stepUnit=day and stepValue=1. It is recommended to use day or hour.

For example:
http://<ServerName>/topaz/OfflineReportsServlet?createSession=true
createSession=true&offlineCustomerId=1&outputFormat=1&filterProfileId=999
&timeFrame=Day&requestType=offline&userlogin=admin&userpassword=admin
&gmtOffset=120&useVIP=true&startTime=201005210000&skipNavBar=true
&offlineLocaleLanguage=en&webinfra_doMHTzip=false&actionForward=report
&reportName=Report_1
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Service Report

This chapter provides information on the Service report.

This chapter includes:

Concepts

 ➤  Service Report Overview on page 206

 ➤  Dimensions and Measurements on page 206

 ➤  Service Report Formats on page 210

 ➤  Status Function Automatic Measurements on page 213

 ➤  Tips and Tricks on page 215

Tasks

 ➤  Configure a Service Report in the Report Manager – Workflow on page 219

 ➤  Create a Customized Measurement on page 221

Reference

 ➤  Service Report User Interface on page 225

Troubleshooting and Limitations on page 281
Concepts
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Service Report Overview

Service reports are Custom reports that display selected data from data 
sources of the Service Level Management, Dashboard, or other applications. 

You can create a Service report by:

➤ Adding the Service report portlet to a page or a module in My BSM and then 
configuring the portlet. For details, see “Configure a Service Report Portlet 
in My BSM – Workflow” in Using My BSM.

➤ Creating a Service report in Report Manager. For details on performing this 
task, see “Configure a Service Report in the Report Manager – Workflow” on 
page 219. The Service report can then be added to a Custom report in the 
Report Manager. For details about adding components to a Custom report, 
see “Report Components Page” on page 137.

Note: Service reports created in My BSM are independent from Service 
reports created in the Report Manager: when you create a Custom report, 
you see only the Service reports created in the Report Manager.

Dimensions and Measurements

The Service report uses data from the CMDB and Profile databases 
corresponding to the data source of the different applications. These 
databases are configured for Online Analytical Processing (OLAP) and 
employ a multidimensional data model. The multidimensional data model 
creates a matrix of measurements and dimensions (cube) that maps and 
links them in a specific way for each application.

This section includes the following topics:

➤ “About Dimensions and Measurements” on page 207

➤ “Impact of the Dimensions/Measurement Selection on the Report Structure” 
on page 208
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➤ “Impact on the Type of Selection: Single Selection or Multiple Selection” on 
page 208

About Dimensions and Measurements
When you configure a Service report as a portlet in My BSM or as a 
component in a Custom report, you specify the source of the data, and you 
select the data source dimensions and measurements that you want to 
display in the report.

For example, when you create an SLA in Service Level Management, you 
specify the properties, such as SLA name, customer, and provider, that you 
use to get information about the status of the SLA. All the properties can be 
used as dimensions in Service reports for the Service Level Management 
application. For details about the SLA properties, see “Agreement Wizard” in 
Using Service Level Management.

The measurements that are available depend on the data source and on the 
data source dimensions that you selected. The measurements are the 
parameters of the dimensions. For example, the measurements of the SLA 
dimension are the attributes of the SLA: Customer, Provider, Value, 
Objectives, and so on.

When you select one or more data sources in the Service report wizard, the 
dimensions and the measurements are linked by a map. Those links have an 
impact on the elements that you can select when building the report and on 
the possible location of those elements in the report. For details about the 
maps, see the “Impact of the Dimensions/Measurement Selection on the 
Report Structure” on page 208.

Note: When you select more than one data source in the Service Report 
Builder wizard, the dimensions and measurements maps are combined.
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Impact of the Dimensions/Measurement Selection on the 
Report Structure
Some measurements automatically assume a specified position (row header, 
column header, orthogonal) in the Service report; for example in the Service 
Level Management - SLA Status Data data source, the SLA Overall Status 
measurement has a one-to-one link to the SLA dimension and is 
automatically orthogonal to the SLA dimension in the report. Special maps 
provide the relationships between dimensions and measurements. For 
details, see the map sections in “Select a Data Source Page” on page 230.

Other measurements (such as Forecast Status, or SLA Breached Date) have a 
one-to-many relation with multiple dimensions. In addition, they are linked 
to the same dimensions (they are in the same box in the map). Therefore, 
they do not have an automatic position in the report, and you must select 
where you want them to be displayed by selecting As column headers or As 
row headers. 

Impact on the Type of Selection: Single Selection or 
Multiple Selection
If you select a dimension (SLA) and a measurement (SLA Overall Status) that 
are simply linked to each other in the dimensions and measurements map, 
the Dimensions Filter displays a multiple-selection for the SLA dimension. 
This is because there is only one customer for each SLA. The values you can 
select from are the available SLAs.
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If you select a measurement (SLA Forecast Status) that is linked to several 
dimensions in the map (Forecast Based on Tracking Period, SLA, and 
Tracking Period) and you have selected only one dimension (SLA) in the 
Dimensions Selection page, the Dimensions Filter displays all the other 
dimensions that are mapped to the measurement. This is because of the 
multidimensional data model of the databases where the data is located. To 
access the SLA Forecast Status measurement data relevant to the SLA 
dimension that you selected, you must also provide the values for the other 
dimensions in the data model. For details about the map, see “Service Level 
Management - SLA Status Data Dimensions and Measurements Map” on 
page 236.

The dimension you selected in the Select Dimensions page (SLA) is multi-
selection and you must make a choice from among the available 
dimensions. Each of the other dimensions linked to the selected 
measurement is single-selection (fixed dimension). 

Multi-selection is different for each dimension.
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Service Report Formats

You can format the Service report by selecting columns and row headers, by 
adding different column types in the same table, customizing the report 
structure, adding calculated columns, and combining data from multiple 
sources, such as SLM and additional data sources.

The Service report can have the following formats:

➤ Pivot table. You can use dimensions and measurements to create multiple 
column or row headers and you can choose where to locate them in the 
table. For example, a pivot table can have the following structure:

➤ Deeper hierarchy. You can select several dimensions to be the column 
headers and more than one dimension to be the rows header. For example, a 
deeper hierarchy table with 3 headers is as follows:

➤ Measurements per dimension. For each dimension, you can select what you 
want to display: values, status, objectives, background status color, and so 
on. An example of such a table is as follows:
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Note: In the regular cells of a table, numeric content is right-aligned and 
text content is left-aligned. In header cells, the cell content is centered.

➤ Charts. You can display the report as a Line, Pie, Area, Bar, or Stacked Bar 
chart. You can also use the 3D and/or Flash technology to format the chart. 
For example:

➤ 3D:

➤ 3D and Flash:

➤ Area chart without Flash:

➤ Area chart with Flash:
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Other Possible Structures
A Service report can display:

➤ The value of the measurement:

➤ The status of the measurement:

➤ Both the value and status of the measurement. You can choose between the 
following structures:

➤ Vertical merge (select As column headers):

Availability Performance

24x7
Business 
Hours

24x7
Business 
Hours

CI1 90 80 90 70

CI2 10 20 10 30

Availability Performance

24x7
Business 
Hours

24x7
Business 
Hours

CI1 Breached Minor 
breached

Met Met

CI2 Exceeded Met Exceeded Met

Availability Performance

24x7 Business Hours 24x7 Business Hours

Value Status Value Status Value Status Value Status

CI1 90 Breached 80 Minor 
breached

90 Met 70 Met

CI2 10 Exceeded 20 Met 10 Exceeded 30 Met
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➤ Horizontal merge (select As Row headers):

Status Function Automatic Measurements

When you use the Status function to create a calculated measurement, the 
following additional measurements are automatically created:

➤ <Compare_measurement_selection> (<new_measurement_name> as 
background). This measurement displays the value of the measurement you 
selected in the Compare measurement list and the status of the 
measurement when compared to the thresholds you selected in To 
threshold as the background color for the cell in the table.

Availability Performance

24x7
Business 
Hours

24x7
Business 
Hours

CI1 Value 90 80 90 70

Status Breached Minor 
breached

Met Met

CI2 Value 10 20 10 30

Status Exceeded Met Exceeded Met
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➤ <new_measurement_name>. This measurement displays the status of the 
measurement you selected in the Compare measurement list when 
compared to the thresholds you selected in To threshold as the name of the 
threshold.

➤ <new_measurement_name> (<new_measurement_name> as background). 
This measurement displays the status of the measurement you selected in 
the Compare measurement list when compared to the thresholds you 
selected in To threshold as the name of the threshold and as the background 
color for the cell in the table.

➤ <new_measurement_name> as background. This measurement displays the 
status of the measurement you selected in the Compare measurement list 
when compared to the thresholds you selected in To threshold as the 
background color for the cell in the table.
214



Chapter 10 • Service Report
Tips and Tricks

This section includes tips and tricks that you can use when creating a Service 
report.

General

➤ Selecting the Enable automatic preview option enables you to see the 
changes you make to the report before you generate the report.

➤ Click CTRL and use the mouse to perform a multi-selection of dimensions or 
measurements.

➤ When you create a Service report based on the Service Level Management 
data sources, you can display data for the Targets measurements, only if all 
the CIs included in the same SLA have the same threshold. Data is displayed 
if all the thresholds are linked to the SLAs, CIs/Services, and KPIs 
dimensions, and if all the Calendar and Target measurements are the same.

➤ After you have created a Service report, you can clone it by copying and 
pasting it in the tree of pages. For details, see “Edit Page Dialog Box” in Using 
My BSM. For an example of why you might clone a Service report, see 
“Example – Create a Service Report for Online and for Print” on page 220.
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Select Dimensions Page

➤ It is recommended, when creating a Service report, to distribute the 
dimensions between the Rows and the Columns. In the measurement maps, 
check the dimensions that are linked to the measurements you are selecting. 
Then, try to distribute those dimensions between the rows and columns. For 
example, if you want to display the KPI Value and All Targets measurements 
and you have selected the Calendar, CI, and SLA dimensions, it is 
recommended not to have CI and SLA both in rows or columns but rather, 
to have one of them in rows and one of them in columns.

➤ Reports in which you have moved the majority of the dimensions to the 
Columns box are wide, which might cause printing problems. Reports in 
which you have moved the majority of the dimensions to the Rows box are 
long.

➤ If you have selected the SLAs and Calendar dimensions, and you want to 
display data for lots of SLAs, it is recommended to set SLAs in Rows and 
Calendar in Columns. If you want to display data for many time intervals 
but for a limited number of SLAs, it is recommended to set SLAs in Columns 
and Calendar in Rows.
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Select Measurements Page

➤ To create a narrower report, move the measurements to the Rows box if you 
have moved the majority of the dimensions to the Columns box (or vice 
versa). A new measurement then adds one more row to the report.

➤ The order of the measurements in the Available Measurements box in the 
Select Measurements page is by order of importance and not by alphabetical 
order.

➤ If you see the error message: Some of the selections are incompatible and 
cause problems in the report structure (or Errors were encountered while 
trying to build the report), change the order of the selected dimensions in 
the Select Dimensions page or the order of the measurements in the Select 
Measurements page. If that does not work, change the order of the 
selections in the Rows and Columns boxes in the Select Dimensions page.

➤ If you add a calculated measurement and regular measurements to a report, 
the regular measurements always appear before the calculated, 
independently of the order you selected in the selection lists.

Calculated Measurement

➤ It is important to add a meaningful description when you create a new 
measurement, because the description appears as a tooltip in the report and 
describes what the measurement represents: the measurements that are 
used, the type of calculation, the dimension on which the calculation is 
based, and so on. For example, the difference between the SLA KPI value and 
the target Exceeded, compared by Time interval.

➤ To ensure that you are using the Difference calculated measurement in the 
correct way, it is recommended to add the measurements you selected in the 
First measurement and in the Second measurement boxes to the report and 
to verify that the Difference calculation is done in the correct order. If it is 
not, switch the measurements you selected from the First measurement to 
the Second measurement boxes and vice versa.
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➤ All dimensions that you did not select in the Select Dimensions page can be 
used as the base for an aggregation measurement, but you do not have to 
necessarily select multiple values in the Select Dimensions Filter page. For 
example, if you have selected the SLA and CI dimensions in rows and the 
KPIs in columns, you can perform an aggregation over the Time Interval or 
the Calendar dimensions, which were not selected. In the Select Dimensions 
Filter page, both dimensions are multi-selection, but you can select multiple 
values for one dimension and one value for the other dimension; for 
example, Last week and every one week.

Select Dimensions Filter Page
To immediately see the impact of adding other dimensions to a report, click 
Preview or select the Enable automatic preview option. A mock-up of the 
report is displayed in the page lower box.

Tasks
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Configure a Service Report in the Report Manager – 
Workflow

You can add a Service report to the Report Manager. You configure the 
Service report using a wizard.

This task includes the following steps:

➤ “Install Flash to Format the Report Using Flash Technology – Optional” on 
page 219

➤ “Configure a Service Report in Report Manager” on page 219

➤ “Add a Service Report to a Custom Report” on page 220

➤ “Change the First Day of Month Setting – Optional” on page 220

➤ “Display the Service Report” on page 220

 1 Install Flash to Format the Report Using Flash Technology – 
Optional
To render the Service report charts using Flash, you must have the 
Macromedia Flash Player installed on your local machine. If you do not, the 
browser displays a message containing instructions on how to download 
Flash Player.

 2 Configure a Service Report in Report Manager
To configure a Service report in the Report Manager, select Applications > 
User Reports > Report Manager, click the New button and select New 
Service Report in the dropdown menu to open the Service Report Builder 
wizard. 

Use the Service Report Builder wizard to configure the following 
information: 

➤ Report properties

➤ Report format

➤ Data sources for the report

➤ Report dimensions
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➤ Report measurements

➤ Report dimensions

While creating the Service report, you can also create new measurements 
that you can use immediately in the report.

For details on creating a Service report, see “Service Report Builder Wizard” 
on page 227.

 3 Add a Service Report to a Custom Report
Once a Service report is available in the Report Manager, you can add it to a 
Custom report. For details, see “Custom Report Wizard” in Reports.

Example – Create a Service Report for Online and for Print

If the Service report portlet displays correctly online, but is too wide to be 
printed, you can clone it. In the cloned report, you can change the location 
of the dimensions or their order to create a printable report that includes the 
same data as the online report.

 4 Change the First Day of Month Setting – Optional
To change the first day of the month setting (default is 1), select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Foundations, select Calendar, and locate the First day of month entry in the 
Calendar - Calendar Options table. Change the value to any value between 1 
and 31.

Note: Changing the First day of month setting affects Service reports and all 
other Dashboard components.

 5 Display the Service Report
To display the Service report, select Applications > User Reports, select the 
relevant Service report and click the View Report button.
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Create a Customized Measurement

You can create a customized measurement that performs an aggregation 
(Average, Max, Min, Sum, Best, Worst, Count Status, or Status Percentage) or 
performs a calculation (Difference, Difference by percentage, Status, or 
Trend) based on selected measurement values. After you create the new 
measurement, you can use it in the Service Report Builder like a regular 
measurement. For details, see “Create Measurement Dialog Box” on 
page 267.

Example – Display the Trend Between Values

To display the trend of each instance of the time interval:

 1 Access the Service report wizard. 

 2 In the Select a Data Source page, select SLM - SLA KPI Data and click Next. 

 3 In the Select Dimensions page, move SLA and CI to the Rows box, Time 
Range to the Columns box, and click Next. 

 4 In the Select Measurement page, click the Create Measurement button. 

 5 In the Create Measurement dialog box, enter Trend on time interval in the 
Measurement name box, select the Calculated Measurement type, select 
Trend in the Select function list, select Time Range (column’s header) in the 
Select Dimension list, KPI Status (Time Range 1) in the First Measurement 
list, and KPI Status (Time Range 2) in the Second Measurement list in the 
Function Parameters area, and click OK. 

 6 Add the KPI Status (as text and background) measurement and move it 
before the Trend on time interval measurement.

 7 In the Select Measurement page, click Preview. The preview displays the 
trend of the SLAs between two time intervals.

 8 Adjust the appropriate dimension filters and save the report.
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Example – Display How Far an SLA is From Exceeding Its Target

To display how far the SLA is from exceeding its target:

 1 Access the Service report wizard.

 2 In the Select Data source page, select SLM - SLA KPI Data and click Next.

 3 In the Select Dimensions page, move CI and SLA to the Rows box, Time 
Range to the Columns box, and click Next.

 4 In the Select Measurement page, click the Create Measurement button. 

 5 In the Create Measurement dialog box, enter Diff value from target in the 
Measurement name box, select the Calculated Measurement type, select 
Difference by percentage in the Select function list, select SLA (row headers) 
in the Select Dimension list, KPI Value (SLA 1) in the First Measurement list, 
and Deviation From Target (SLA 1) in the Second Measurement list in the 
Function Parameters area, and click OK.

 6 In the Select Measurement page, click Preview. The preview displays how far 
the SLA is from the exceeded value in percentages.

 7 You can also display the measurements (KPI Value, or Deviation From 
Target, and Exceeded) on which you base the calculation:

 8 Select the appropriate dimension filters and save the report.
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Example – Fine-Tune SLAs

Instead of adjusting the SLA thresholds in the Service Level Management 
application directly, create a Service report based on the appropriate Service 
Level Management data sources, and create a new measurement based on 
the Status function. Fine-tune the function thresholds to check the SLA over 
a specific time period until you get the required results. You can then use 
those thresholds in the Service Level Management application.

Example – Drill Into SLAs Data

The smallest status duration for an SLA is five minutes. If a customer has 
multiple SLAs and you want to see when the objective exceeds 98 you can 
create a Service report with the Status function, and set the threshold to 98. 
The report displays the status information and not the real SLA 
measurement. The tooltip displays the real name of the calculated 
measurement.

Example – Simulate a Tracking Period That Starts and Ends on 
Mondays

Usually, the tracking period is from the first day of the previous 
month/week to the first day of the current month/week. You can create a 
report that provides information from the third day (Monday) of the 
previous month/week to the third day of the current month/week.

To simulate a tracking period that starts and ends on Mondays:

 1 Access the Service report wizard.

 2 In the Select Datasource page, select SLM - SLA KPI Data and click Next.

 3 In the Select Dimensions page, move CI to the Rows box, SLA to the 
Columns box, and click Next.

 4 In the Select Measurement page, click Create Measurement. 

 5 In the Create Measurement dialog box, enter My Average Value in the 
Measurement name box, select the Aggregated Measurement type, select 
Average in the Select function list, select KPI Value in the Select 
measurement list, and click OK. 

 6 In the Select Measurement page, the My Average Value measurement is 
automatically moved to the Selected Measurements box. Click Next. 
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 7 In the Select Dimension Filters page:

➤ For the CI Mandatory Dimension, select a view, and the appropriate CIs.

➤ For the SLA Mandatory Dimension, select SLA1 IRD and SLA2 IRD.

➤ For the Time Ranges Mandatory Dimension, select Over Time, Week 
where you select the date to be from the 3rd day to the 3rd day and Every 
day. The hour is automatically changed to midnight.

➤ For the KPIs Mandatory Dimension, select Availability and Performance.

➤ For the Calendar Mandatory Dimension, select 24x7.

 8 Click Finish, OK, and Save.

 9 Open My BSM and display the report.

 10 Click the Funnel button to display the report filter. It indicates that the 
report starts and ends on Mondays.

Reference
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Service Report User Interface

This section describes:

 ➤  Service Report on page 225

 ➤  Service Report Builder Wizard on page 227

Service Report 
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the Service report you configured in a Service 
report portlet in My BSM or as a report in the Report 
Manager.

To access:

➤ In My BSM, select the page where the Service report 
portlet is located. The portlet contains the configured 
Service report.

➤ Select Applications > User Reports, select the relevant 
Service report, and click the View button .

Important 
Information

The report displays the data and the format selected 
when creating the report using the Service Report Builder 
wizard. 

Included in Tasks “Configure a Service Report Portlet in My BSM – 
Workflow” in Using My BSM

“Configure a Service Report in the Report Manager – 
Workflow” on page 219

GUI Element (A-Z) Description

In My BSM, click the Funnel button to display the values 
of the dimensions selected in the Dimension Filters page 
that are not directly displayed in the report. 

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

<Dimension filter 
elements>

In the Report Manager, displays the values of the 
dimensions selected in the Dimension Filters page that 
are not directly displayed in the report. 
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Service Report Builder Wizard

Service Report Properties Page

Description Enables you to configure a Service report. You select 
the data source on which you want to base the Service 
report data, the dimensions and measurements that are 
to appear in the report, and the structure of the report.

To access: 

➤ In My BSM, click Launch Service Report Builder in 
the Filter area of the Edit Preferences page of a 
Service report portlet.

➤ In the Report Manager, click New  and select 
New Service Report.

Included in Tasks “Configure a Service Report Portlet in My BSM – 
Workflow” in Using My BSM

“Configure a Service Report in the Report Manager – 
Workflow” on page 219

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) > (Edit Chart Properties 
Dialog Box) > Select the Dimension Filters Page > 
Summary Page

Description Enables you to enter the name and description of the 
Service report.

Important 
Information

➤ This page is displayed only when you access the 
Service report from the Report Manager.

➤ General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) >(Edit Chart Properties Dialog 
Box) > Select the Dimension Filters Page > Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Select a Display Type Page

GUI Element (A–Z) Description

Report description Enter a description of the report. The description appears 
in the list of available reports in the Report Manager.

Report name Enter the name of the report. The name appears in the 
list of available reports in the Report Manager.

This field is mandatory.

When you clone a report in the Report Manager, the 
name of the cloned report is automatically changed to 
Copy of <cloned_report_name>.

Save report as Select one of the following options:

➤ Private. Only the report organizer can view the report. 

➤ Public. All users with appropriate permission levels can 
view the report. This is the default.

Description Enables you to select the type of format you want to use 
to display the report. The report can be displayed as a 
table or as a chart.

Important 
Information

General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) >(Edit Chart Properties Dialog 
Box) > Select the Dimension Filters Page > Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A–Z) Description

Chart Select this option to display the list of the different charts 
available to render the report.

Display 3D Select this option to display the selected chart format 
with a 3-dimensional look. 

Example:

➤ When you select Pie and Display 3D:

➤ When you select Pie, Display 3D, and Flash:
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Select a Data Source Page

Flash Select this option to display the selected chart format 
using Flash technology.

Note: To display the report using Flash technology, you 
must have Flash installed.

Example:

Note: You can select both Display 3D and Flash. See the 
description of the Display 3D option for an example.

Pie, Bar, Line, 
Stacked Bar, Area

Select the type of chart you want to use to display the 
report.

Note: You can select Area only if you also select Flash.

Pivot table Select this option to display the report as a pivot table. 
This option is selected by default.

Description Enables you to select one or more data sources on 
which you want to base the Service report data.

Important 
Information

➤ You can select more than one data source. 

➤ For details on the impact of the data source 
selection, see “Dimensions and Measurements” on 
page 206.

➤ General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Limitations: See the details in “Troubleshooting and 
Limitations” on page 281.

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) >(Edit Chart Properties 
Dialog Box) > Select the Dimension Filters Page > 
Summary Page

GUI Element (A-Z) Description

Business Process 
Insight Data

Select to build the report using data from Business 
Process Insight. For details about the data source 
dimensions, measurements, and the relations between 
time, see “Business Process Insight Data Dimensions 
and Measurements Map” on page 240.

Dashboard KPIs data Select to build the report using business-related CIs, 
based on historical data from the associated Dashboard 
KPIs. For details about the data source dimensions, 
measurements, and the relations between time, see 
“Dashboard KPIs Data Source Dimensions and 
Measurements Map” on page 238.

Over Time Additional 
data

Select to build the report using dimensions and 
measurements, such as Number of tickets and Number 
of measurements, from multiple data sources. For 
details about the data source dimensions, 
measurements, and the relations between time, see 
“Over Time Additional Data Dimensions and 
Measurements Map” on page 245.

Service Level 
Management - SLA 
KPI data

Select to build the report using CIs, KPIs, SLA 
dimensions, and the Time and Calendar 
measurements, from Service Level Management. For 
details about the data source dimensions, 
measurements, and the relations between time, see 
“Dashboard KPIs Data Source Dimensions and 
Measurements Map” on page 238.
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Service Level Management - SLA KPI Data Dimensions and 
Measurements Map
The dimensions and measurements map for the SLA KPI data source 
includes the following elements:

Service Level 
Management - SLA 
Status data

Select to build the report using SLAs, Tracking Period, 
and Time dimensions, and SLA Status for Previous 
Periods, SLA Current Status, and SLA Current Status By 
Time Periods, and SLA Forecast measurements. For 
details about the data source dimensions, 
measurements, and the relations between time, see 
“Service Level Management - SLA Status Data 
Dimensions and Measurements Map” on page 236.

TransactionVision 
data

Select to build the report using data from 
TransactionVision. For details about the data source 
dimensions, measurements, and the relations between 
time, see “TransactionVision - Data Dimensions and 
Measurements Map” on page 247.

GUI Element (A-Z) Description
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Depending on the dimensions and measurements you select, make either a 
single selection or multiple selection for each dimension’s values. For 
details, see “Impact on the Type of Selection: Single Selection or Multiple 
Selection” on page 208.

Dimensions

The dimensions are:

GUI Element (A-Z) Description

Calendar The business-day structure. It can be:

➤ 24hx7d

➤ Business Hours

CI The CI you want to display in the report.

KPI The KPI you want to display in the report.

SLA The Service Level Agreement you want to display in the 
report.

Time Range The time range for which you want to see information.
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Measurements

The measurements are:

Measurement 
Group

GUI Element (A-Z) Description

Additional 
Values Group

All Additional 
Values

Select to display all the enabled additional measurements 
in the report. For details about additional values, see 
“Additional Values in Reports” in Using Service Level 
Management.

Note: 

➤ To modify the default list of enabled additional values 
displayed per KPI, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose 
Applications, select Service Level Management, and 
locate the Additional Values entry in the Service Level 
Management - SLM Admin table. Set the value to true 
for a KPI and an additional value when you want to 
display that additional value parameter for the KPI. If 
an additional value is not included for a specific KPI, it 
is not available for that KPI. 

➤ The PNR KPI appears in the Additional Values settings 
for internal purposes. Do not modify it.

KPI Value and 
Status Group

KPI Status The KPI status.

KPI Status (as text 
and background)

The KPI status and the KPI status compared to the 
objective displayed as the colored background of the 
report cell.

KPI Status as 
background

The KPI status compared to the objectives displayed as 
the colored background of the report cell.

KPI Value The KPI value.

KPI Value (KPI 
Status as 
background)

The KPI value and the KPI status displayed as the colored 
background of the report cell. The KPI status is calculated 
according to the objectives.
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Target 
Measurements

All Targets The percentage of time the value of the selected KPI was 
in the range defined for all targets.

Breached The percentage of time the value of the selected KPI was 
in the range defined for the Breached target.

Breached (Status as 
background)

The percentage of time the value of the selected KPI was 
in the range defined for the Breached target, and the KPI 
status as the colored background of the report cell.

Exceeded The percentage of time the value of the selected KPI was 
in the range defined for the Exceeded target.

Exceeded (Status as 
background)

The percentage of time the value of the selected KPI was 
in the range defined for the Exceeded target, and the KPI 
status as the colored background of the report cell.

Met The percentage of time the value of the selected KPI was 
in the range defined for the Met target.

Met (Status as 
background)

The percentage of time the value of the selected KPI was 
in the range defined for the Met target, and the KPI 
status as the colored background of the report cell.

Minor Breached The percentage of time the value of the selected KPI was 
in the range defined for the Minor Breached target.

Minor Breached 
(Status as 
background)

The percentage of time the value of the selected KPI was 
in the range defined for the Minor Breached target, and 
the KPI status as the colored background of the report 
cell.

Measurement 
Group

GUI Element (A-Z) Description
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Service Level Management - SLA Status Data Dimensions 
and Measurements Map
The dimensions and measurements map for the SLA Status data source 
includes the following elements:

Dimensions

The dimensions are:

GUI Element (A-Z) Description

Forecast Based On 
Tracking Period

The forecast calculated for the analysis period based on 
the assumption that the SLA performs in the future as 
it did during this analysis period. 

SLA The available SLAs that are defined for your site.

For details on single or multiple selection, see “Impact 
on the Type of Selection: Single Selection or Multiple 
Selection” on page 208.

Time Range The time range for which you want to see information.

Tracking Period The tracking periods that are used to track agreement 
status and compile data. The tracking periods define 
the granularity available in Service Level Management 
reports.
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Measurements

The measurements are:

GUI Element (A-Z) Description

Forecast Status (as 
text and 
background)

The status of the forecast, and the Forecast status 
compared to the objective as the colored background 
of the report cell.

SLA Breached Date The SLA breached date from the forecast report. 

SLA Forecast Status The status of the forecast.

SLA Forecast Status 
as background

The status of the forecast compared to the objective as 
the colored background of the report cell.

SLA Historical Status The historical status for the selected time range.

SLA Historical Status 
(as text and 
background)

The value of the Historical Status, and the status 
compared to the objective as the colored background 
of the report cell.

SLA Historical Status 
as background

The Historical Status compared to the objective as the 
colored background of the report cell.

SLA Overall Status The status used to compare to the forecast for a selected 
SLA and selected time range.

SLA Overall Status 
(as text and 
background)

The value of the Overall Status, and the status 
compared to the objective as the colored background 
of the report cell.

SLA Overall Status as 
background

The status of the Overall Status compared to the 
objective as the colored background of the report cell.

SLA Status The current status of the SLA for the selected time 
range.

SLA Status (as text 
and background)

The value of the Status, and the status compared to the 
objective as the colored background of the report cell.
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Dashboard KPIs Data Source Dimensions and 
Measurements Map
The dimensions and measurements map for the Dashboard KPIs data source 
includes the following elements:

Dimensions

The dimensions are:

SLA Status as 
background

The status compared to the objective as the colored 
background of the report cell.

Time Comparison Enter a label for the dimension in the Label box.

Select the tracking range and granularity for the report. 
For details, see “Time Range and Granularity Bar” on 
page 70.

GUI Element (A-Z) Description

CI The configuration item you want to display in the 
report.

KPI The KPIs you want to display in the report.

GUI Element (A-Z) Description
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Measurements

The measurements are:

Status The status of the KPI.

Time Range The time range for which you want to see information.

GUI Element (A-Z) Description

Event Count (#) The number of events with the selected status that 
occurred in the selected time range.

Event Count (#) 
(Status as 
background)

The number of events with the selected status that 
occurred in the selected time range, and the Status as 
the colored background of the report cell. The status 
represents the status dimension instance (OK, FAILED, 
and so on).

Status Duration 
(hh:mm:ss)

The length of time in hours, minutes, and seconds, 
during which the KPI had the selected status.

Status Duration 
(hh:mm:ss) (Status 
as background)

The length of time in hours, minutes, and seconds, 
during which the KPI had the selected status, and the 
status compared to the objective as the colored 
background of the report cell.

Status Percentage 
(%)

The length of time during which the KPI had the 
selected status divided by the selected time range in 
percentage.

Status Percentage 
(%) (Status as 
background)

The length of time during which the KPI had the 
selected status divided by the selected time range in 
percentage, and the status compared to the objective as 
the colored background of the report cell.

GUI Element (A-Z) Description
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Business Process Insight Data Dimensions and 
Measurements Map
The dimensions and measurements map for the Business Process Insight Data 
data source are listed in the tables below.

Dimensions

The dimensions are:

Measurements

Some measurements are relevant for different types of CIs. Others are 
relevant for all types of CIs. The measurements that are relevant for the type 
of CI you select in the Select Dimension Filters page are as follows:

The measurements are described in the following sections.

GUI Element (A-Z) Description

CI The configuration item you want to display in the 
report. 

Time Range The time range for which you want to see information.

Selected Node CIT / 
Measurement Group

Measurement Group Sample Type

Business Process Health Measurements Group bpi_process_t

Common Measurements Group

BPI 
Monitor

Duration Duration Measurements Group bpi_duration_t

Common Measurements Group

Value / 
Custom

Value Measurements Group bpi_value_t

Common Measurements Group

BPI Business Process 
Step

Common Measurements Group bpi_step_t
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Common Measurements Group

Measurement 
Group

Measurement Description

Common 
Measurement 
Group

Avg. Backlog Value The total value of all currently open instances, 
divided by the total number of instances.

Avg. Backlog Count (#) The number of currently open instances divided by 
the total number of instances.

Completed Instances 
(#)

The sum of all completed instances.

Completed Instances 
Total Value

The total value of all completed instances.

Completed Instances 
Avg. Value

The total value of all completed instances divided by 
the total number of completed instances.
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Duration 
Measurement 
Group

Avg. Duration (sec) The sum of the duration of all completed instances 
divided by the number of completed instances.

Weighted Avg. 
Duration (sec)

The sum of the duration of all completed instances, 
each multiplied by its weight, and divided by the 
number of completed instances.

Min. Duration (sec) The minimum duration of all completed instances.

Max. Duration (sec) The maximum duration of all completed instances.

Total Duration Critical 
Violated Instances (#)

The total duration of all violated samples with Critical 
status.

Total Duration Critical 
Violated Instances (#, 
Status as background)

The total duration of all samples with Critical status, 
and the status compared to the objective as the 
colored background of the report cell.

Total Duration Major 
Violated Instances (#)

The total duration of all samples with Major status.

Total Duration Major 
Violated Instances (#, 
Status as background)

The total duration of all samples with Major status, 
and the status compared to the objective as the 
colored background of the report cell.

Total Duration Minor 
Violated Instances (#)

The total duration of all violated samples with Minor 
status.

Total Duration Minor 
Violated Instances (#, 
Status as background)

The total duration of all violated samples with Minor 
status, and the status compared to the objective as the 
colored background of the report cell.

Total Duration Non-
Violated Instances (#)

The total duration of all non-violated samples.

Total Duration Non-
Violated Instances (#, 
Status as background)

The total duration of all non-violated samples with 
Minor status, and the status compared to the objective 
as the colored background of the report cell.

Total Duration Warning 
Violated Instances (#)

The total duration of all violated samples with 
Warning status.

Total Duration Warning 
Violated Instances (#, 
Status as background)

The total duration of all violated samples with 
Warning status, and the status compared to the 
objective as the colored background of the report cell.

Measurement 
Group

Measurement Description
242



Chapter 10 • Service Report
Value 
Measurement 
Group

Total Monitor Value The total value of all samples that were sent during 
the specified time period.

Avg. Monitor Value The total value of all samples that were sent during 
the specified time period divided by the number of 
currently completed samples.

Weighted Avg. Monitor 
Value

The total value of all samples that were sent during 
the specified time period, each multiplied by its 
weight, divided by the number of currently 
completed samples.

Min. Value The minimum value of all samples that were sent 
during the specified time period.

Max. Value The maximum value of all samples that were sent 
during the specified time period.

Total Value Critical 
Violated Instances (#)

The total value of all violated samples with Critical 
status.

Total Value Critical 
Violated Instances (#, 
Status as background)

The total value of all samples with Critical status, and 
the status compared to the objective as the colored 
background of the report cell.

Total Value Major 
Violated Instances (#)

The total value of all samples with Major status.

Total Value Major 
Violated Instances (#, 
Status as background)

The total value of all samples with Major status, and 
the status compared to the objective as the colored 
background of the report cell.

Total Value Minor 
Violated Instances (#)

The total value of all violated samples with Minor 
status.

Total Value Minor 
Violated Instances (#, 
Status as background)

The total value of all violated samples with Minor 
status, and the status compared to the objective as the 
colored background of the report cell.

Measurement 
Group

Measurement Description
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Measurement 
Group

Measurement Description

Value 
Measurement 
Group 
(continued)

Total Value Non-
Violated Instances (#)

The total value of all non-violated samples.

Total Value Non-
Violated Instances (#, 
Status as background)

The total value of all non-violated samples with 
Minor status, and the status compared to the objective 
as the colored background of the report cell.

Total Value Warning 
Violated Instances (#)

The total value of all violated samples that currently 
have the Warning status.

Total Value Warning 
Violated Instances (#, 
Status as background)

The total value of all violated samples that currently 
have the Warning status , and the status compared to 
the objective as the colored background of the report 
cell.

Health 
Measurement 
Group

Avg. of Blocked 
Instances (#)

The sum of the number of all instances with Blocked 
status, divided by the total number of instances.

Avg. of Blocked 
Instances (#, Status as 
background)

The sum of the number of all instances with Blocked 
status, divided by the total number of instances, and 
the status compared to the objective as the colored 
background of the report cell.

Avg. of Healthy 
Instances (#)

The sum of the number of all instances with Healthy 
status, divided by the total number of instances.

Avg. of Healthy 
Instances (#, Status as 
background)

The sum of the number of all instances with Healthy 
status, divided by the total number of instances, and 
the status compared to the objective as the colored 
background of the report cell.

Avg. of At Risk Instances 
(#)

The sum of the number of all instances with AtRisk 
status, divided by the total number of instances.

Avg. of At Risk Instances 
(#, Status as 
background)

The sum of the number of all instances with AtRisk 
status, divided by the total number of instances, and 
the status compared to the objective as the colored 
background of the report cell.
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Over Time Additional Data Dimensions and 
Measurements Map
The dimensions and measurements map for the Over Time Additional Data 
data source includes the following elements:

Measurement 
Group

Measurement Description

Health 
Measurement 
Group 
(continued)

Avg. Value of Blocked 
Instances

The total cost of all instances with Blocked status, 
divided by the total number of instances.

Avg. Value of Blocked 
Instances (Status as 
background)

The total cost of all instances with Blocked status, 
divided by the total number of instances, and the 
status compared to the objective as the colored 
background of the report cell.

Avg. Value of Healthy 
Instances

The total cost of all instances with Healthy status, 
divided by the total number of instances.

Avg. Value of Healthy 
Instances (Status as 
background)

The total cost of all instances with Healthy status, 
divided by the total number of instances, and the 
status compared to the objective as the colored 
background of the report cell.

Avg. Value of At Risk 
Instances

The total cost of all instances with AtRisk status, 
divided by the total number of instances.

Avg. Value of At Risk 
Instances (Status as 
background)

The total cost of all instances with AtRisk status, 
divided by the total number of instances, and the 
status compared to the objective as the colored 
background of the report cell.
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Dimensions

The dimensions are:

Measurements

The measurements are:

GUI Element (A-Z) Description

CI The configuration item or service.

Time Range The time range for which you want to see information.

GUI Element (A-Z) Description

# of tickets The number of tickets (open incidents) that were 
opened with the selected severity during the selected 
time period. 

To specify the severity, you must first specify the rule 
that is used to calculate the number of tickets.

To specify the rule, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate 
the Number of open Incidents rule entry in the 
Dashboard Application - Business Impact table. Enter 
the value of the rule you want to use. A list of rules and 
rule numbers are available in the Repositories (to access 
the Repositories, select Admin > Dashboard > 
Repositories > Business Rules).

To specify the severity you want to use, edit the rule’s 
properties in the Repositories. 

# of users The number of users, calculated by Real User Monitor, 
using the specified CI during the selected time period.
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TransactionVision - Data Dimensions and Measurements 
Map
The data is retrieved from the Business Transaction Monitor monitor 
sample. For details about the sample, see “Data Sample for 
TransactionVision” in Reference Information.

The dimensions and measurements map for the TransactionVision data 
source includes the following elements:

Dimensions

The dimensions are:

Measurements

The measurements are:

GUI Element (A-Z) Description

CI The configuration item or service.

Time Range The time range for which you want to see information.

GUI Element (A-Z) Description

Average Backlog 
Value

The total financial value of the transactions that are 
currently running in TransactionVision, divided by the 
number of samples sent during the specified time 
period. By default, a sample represents 5 minutes of 
data.

Average Value The average financial value of the transactions that ran 
in TransactionVision, in the sample. By default, a 
sample represents 5 minutes of data.

Average Value of 
Delays

The average financial value of the transactions that 
accessed TransactionVision, with delays, in the sample. 
By default, a sample represents 5 minutes of data.
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Average Value of 
Exceptions

The average financial value of the transactions that 
accessed TransactionVision, with an exception, in the 
sample. By default, a sample represents 5 minutes of 
data.

A transaction with an exception is a transaction that 
did not follow the straight-through process defined by 
the user.

Average Value of 
Failures

The average financial value of failed transactions in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data.

Transactions are classified as failed when they match 
the attribute or pattern defined as failure in 
TransactionVision.

Avg. Backlog The number of transactions that are currently running 
in TransactionVision, divided by the number of 
samples sent during the specified time period. By 
default, a sample represents 5 minutes of data.

Avg. Duration (sec) The sum of the response time of the transactions that 
ran in TransactionVision, divided by the total number 
of transactions, in the sample. By default, a sample 
represents 5 minutes of data.

Delays (#) The total number of delayed (late) transactions in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data. 

Transactions are classified as late when their response 
time exceeds the defined threshold in 
TransactionVision. 

Exceptions (#) The total number of transactions that accessed 
TransactionVision, with exceptions, in the sample. By 
default, a sample represents 5 minutes of data. 

A transaction with an exception is a transaction that 
did not follow the straight-through process defined by 
the user.

GUI Element (A-Z) Description
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Failures (#) The total number of failed transactions in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data. 

Transactions are classified as failed when they match 
the attribute or pattern defined as failure in 
TransactionVision.

Max. Duration (sec) The maximum response time of the transactions that 
ran in TransactionVision in the sample. By default, a 
sample represents 5 minutes of data.

Min. Duration (sec) The minimum response time of the transactions that 
ran in TransactionVision in the sample. By default, a 
sample represents 5 minutes of data.

Total Value The total value of the transactions that ran in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data.

Total Volume (#) The total number of transactions that ran in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data.

Value of Delays The total financial value of delayed (late) transactions 
in TransactionVision, in the sample. By default, a 
sample represents 5 minutes of data. 

Transactions are classified as late when their response 
time exceeds the defined threshold in 
TransactionVision. 

GUI Element (A-Z) Description
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Select Dimensions Page

Value of Exceptions The total financial value of the transactions that 
accessed TransactionVision, with an exception, in the 
sample. By default, a sample represents 5 minutes of 
data.

A transaction with an exception is a transaction that 
did not follow the straight-through process defined by 
the user.

Value of Failures The total financial value of failed transactions in 
TransactionVision, in the sample. By default, a sample 
represents 5 minutes of data.

Transactions are classified as failed when they match 
the attribute or pattern defined as failure in 
TransactionVision.

Description Enables you to select the dimensions you want to 
display in the report, and whether they are to appear in 
a column or a row.

Important 
Information

➤ The information displayed on this page depends on 
the type of display you selected in the Select a 
Display Type page.

➤ General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Tips and Tricks: Before using this page, see “Tips and 
Tricks” on page 215.

Limitations: See “Troubleshooting and Limitations” on 
page 281.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > 
(Create Measurement Dialog Box) >(Edit Chart 
Properties Dialog Box) > Select the Dimension Filters 
Page > Summary Page

GUI Element (A-Z) Description
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When You Use the Pivot Table Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The elements listed in the table below are displayed 
when you select Pivot table in the Select a Display Type 
page.

GUI Element (A-Z) Description

Select a dimension in the Available dimensions area 
and click the forward arrow to move the dimension to 
the Columns or Rows area.

Select a dimension in the Rows or Columns area and 
click the arrow to move the dimension back to the 
Available dimensions area.

 Change the order of the dimensions in the Columns or 
Rows area by clicking the up and down arrows. By 
default, the dimensions are listed in alphabetical order.

Available Dimensions Select the appropriate dimension and select where you 
want to put it in the report by clicking the forward 
arrow to the Columns or Rows area.

Use the following guidelines to select the dimensions:

➤ If you select only one dimension and move it to the 
Rows (Columns) area, the dimension’s 
measurements appear as columns (rows) in the 
Service report.

➤ If you select two dimensions, it is recommended to 
move one dimension to the Rows area and the other 
dimension to the Columns area.

➤ If you select more than two dimensions, there is no 
restriction to the location of the dimensions.

The available dimensions depend on the data source 
you selected. For a description of the dimensions, see 
“Select a Data Source Page” on page 230.
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Clear Click the Clear button to return the dimensions in the 
Columns or Rows area back to the Available 
Dimensions area.

Columns Displays the dimensions that are to appear as column 
headers in the report.

Enable automatic 
preview

You can display a preview of the report by selecting 
Enable automatic preview. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview feature is 
disabled on the next wizard page.

Preview Click the Preview button to review the page. The 
preview shows the report structure with randomly 
generated data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: The preview report displays randomly generated 
data and background color for illustration purposes 
only, and, when applicable, two placeholder values for 
each selected dimension.

Rows Displays the dimensions that are to appear as row 
headers in the report.

GUI Element (A-Z) Description
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When You Use the Pie Chart Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The elements listed in the table below are displayed 
when you select Pie in the Select a Display Type page.

GUI Element (A-Z) Description

Select a dimension in the Available dimensions area 
and click the forward arrow to move the dimension to 
the Slices area.

Select a dimension in the Slices area and click the 
arrow to move the dimension back to the Available 
dimensions area.

 Change the order of the dimensions in the Slices area 
by clicking the up and down arrows. By default, the 
dimensions are listed in alphabetical order.

<legend> Displays the automatically selected colors that 
represent each dimension or combination of 
dimensions.

Available Dimensions Lists the dimensions you selected in the Select 
Dimensions page. 

The available dimensions depend on the data source 
you selected. For a description of the dimensions, see 
“Select a Data Source Page” on page 230.

Clear Click the Clear button to clear all the selections on the 
page.
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Enable automatic 
preview

You can display a preview of the report by selecting 
Enable automatic preview. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the report preview.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview feature is 
disabled on the next wizard page.

GUI Element (A-Z) Description
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Preview Click the Preview button to review the page. The 
preview shows the report structure with randomly 
generated data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: The preview report displays randomly generated 
data and background color for illustration purposes 
only, and, when applicable, two placeholder values for 
each selected dimension.

Slices Mandatory: Move at least one dimension to the Slices 
area.

For example, if you move:

➤ One dimension to the Slices box, each sector of the 
pie chart represents a different value of the 
dimension.

➤ More than one dimension to the Slices box, each 
sector of the pie chart represents a combination of 
the values of each selected dimensions. For example, 
if you select dimensions CI and KPI, the pie chart 
includes sectors for each group of dimensions as 
follows: ci1, kpi1; ci1, kpi2; ci2, kpi1; ci2; kpi2.

GUI Element (A-Z) Description
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When You Use the Bar Chart Format

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The elements listed in the table below are displayed 
when you select Bar in the Select a Display Type page.

GUI Element (A-Z) Description

Select a dimension in the Available dimensions area 
and click the forward arrow to move the dimension to 
the X-Axis or Series area.

Select a dimension in the X-Axis or Series area and click 
the arrow to move the dimension back to the Available 
dimensions area.

 Change the order of the dimensions in the X-Axis or 
Series area by clicking the up and down arrows. By 
default, the dimensions are listed in alphabetical order.

<legend> Displays the automatically selected colors that 
represent each dimension or combination of 
dimensions.

Available Dimensions Lists the dimensions you selected in the Select 
Dimensions page. 

The available dimensions depend on the data source 
you selected. For a description of the dimensions, see 
“Select a Data Source Page” on page 230.

Clear Click the Clear button to clear all the selections on the 
page.
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Enable automatic 
preview

You can display a preview of the report by selecting 
Enable automatic preview. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview feature is 
disabled on the next wizard page.

Preview Click the Preview button to review the page. The 
preview shows the report structure with randomly 
generated data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the report preview.

Note: The preview report displays randomly generated 
data and background color for illustration purposes 
only, and, when applicable, two placeholder values for 
each selected dimension.

GUI Element (A-Z) Description
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Series The X-axis marks represent the combinations of all the 
values of the dimensions you moved to the X-Axis box.

For each mark, the group of bars represent the 
combinations of all the values of the dimensions you 
moved to the Series box.

Example: You moved CI in the X-Axis box, and KPI and 
Status to the Series box. The result is as follows:

Note: If you move dimensions to the Series box, you 
can select only one measurement in the Select 
Measurements page.

GUI Element (A-Z) Description
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X-Axis Mandatory: Move at least one dimension to the X-Axis 
box.

The X-axis marks represents the combinations of all 
the values of the dimensions you moved to the X-Axis 
box.

Example: If you move:

➤ One dimension to the X-Axis box, the values of the 
dimension are displayed on the X-axis.

➤ More than one dimension to the X-Axis box, each 
combination of the dimensions is represented by 
one mark in the X-axis.

GUI Element (A-Z) Description
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When You Use the Line/Stacked Bar/Area Chart Formats

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The elements listed in the table below are displayed 
when you select Line/Stacked Bar/Area in the Select a 
Display Type page.

GUI Element (A-Z) Description

Select a dimension in the Available dimensions area 
and click the forward arrow to move the dimension to 
the X-Axis or Series area.

Select a dimension in the X-Axis or Series area and click 
the arrow to move the dimension back to the Available 
dimensions area.

 Change the order of the dimensions in the X-Axis or 
Series area by clicking the up and down arrows. By 
default, the dimensions are listed in alphabetical order.

<legend> Displays the automatically selected colors that 
represent each dimension or combination of 
dimensions

Available Dimensions Lists the dimensions you selected in the Select 
Dimensions page. 

The available dimensions depend on the data source 
you selected. For a description of the dimensions, see 
“Select a Data Source Page” on page 230.

Clear Click the Clear button to clear all the selections on the 
page.
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Enable automatic 
preview

You can display a preview of the report by selecting 
Enable automatic preview. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled.

Any change made to the top part of the page 
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview feature is 
disabled on the next wizard page.

Preview Click the Preview button to review the page. The 
preview shows the report structure with randomly 
generated data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: The preview report displays randomly generated 
data and background color for illustration purposes 
only, and, when applicable, two placeholder values for 
each selected dimension.

GUI Element (A-Z) Description
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Series The X-axis marks represents the combinations of all 
the values of the dimensions you moved to the X-Axis 
box.

For each mark, the group of bars represent the 
combinations of all the values of the dimensions you 
moved to the Series box.

Example: You moved CI in the X-Axis box and KPI and 
Status to the Series box. 

Note: If you move dimensions to the Series box, you 
can select only one measurement in the Select 
Measurements page.

GUI Element (A-Z) Description
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X-Axis Mandatory: Move at least one dimension to the X-Axis 
box.

The X-axis marks represents the combinations of all 
the values of the dimensions you moved to the X-Axis 
box.

Example: If you move:

➤ One dimension to the X-Axis box, the values of the 
dimension are displayed on the X-axis.

➤ More than one dimension to the X-Axis box, each 
combination of the dimensions is represented by 
one mark in the X-axis.

GUI Element (A-Z) Description
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Select Measurements Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the measurements you want to 
display in the report and whether they should appear 
in rows or columns.

The measurements that are listed in the Available 
Measurements area depend on the dimensions you 
selected in the Dimensions Selection page. For details, 
see “Dimensions and Measurements” on page 206.

Important 
Information

➤ You must select at least one measurement.

➤ The dimensions and measurements of each 
application are mapped differently. For details, see 
“Dimensions and Measurements” on page 206 or 
“Select the Dimension Filters Page” on page 277.

➤ General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Tips and Tricks: Before using this page, see “Tips and 
Tricks” on page 215.

Limitations: See “Troubleshooting and Limitations” on 
page 281.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > 
(Create Measurement Dialog Box) > (Edit Chart 
Properties Dialog Box) > Select the Dimension Filters 
Page > Summary Page

GUI Element (A-Z) Description

Select a measurement in the Available Measurements 
area to move the measurement to the Selected 
Measurements area.

Select a measurement in the Selected Measurements 
area and click to move the measurement back to the 
Available Measurements area.
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Click to create a customized measurement in the 
Create Measurement dialog box. For details, see 
“Create Measurement Dialog Box” on page 267.

See limitations in “Troubleshooting and Limitations” 
on page 281.

Select a customized measurement and click to edit the 
measurement in the Create Measurement dialog box. 
For details, see “Create Measurement Dialog Box” on 
page 267.

Click to open the Edit Chart Properties dialog box. For 
details, see “Edit Chart Properties Dialog Box” on 
page 274.

Note: This button is not available for Pie charts.

 Change the order of the measurements in the Selected 
Measurements area by clicking the up and down 
arrows. By default, the measurements are listed in 
alphabetical order.

Available 
Measurements

Select the appropriate measurement and click the right 
arrow to move the measurement to the Selected 
Measurements area.

The available measurements depend on the data source 
you selected. For a description of the measurements, 
see “Select a Data Source Page” on page 230.

Clear Click the Clear button to clear all the selections on the 
page.

Enable automatic 
preview

You can display a preview of the report by selecting 
Enable automatic preview. When you edit an existing 
Service report, Enable automatic preview is 
automatically selected and the Preview button is 
disabled. Any change made to the top part of the page 
automatically generates the preview report.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview is disabled 
on the next wizard page.

GUI Element (A-Z) Description
265



Chapter 10 • Service Report
Preview Click the Preview button to review the page. The 
preview shows the report structure with the column 
and row headers; it does not display data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. Any change made to the 
top part of the page automatically generates the 
preview report.

Note: 

➤ The preview report displays randomly generated 
data and background color for illustration purposes 
only, and two placeholder values for each selected 
dimension and measurement.

➤ The preview box displays a chart that represents all 
the possible combinations of the selected 
dimensions displayed for each measurement that 
you select.

Selected 
Measurements

The list of measurements you have selected. 

Note: For some measurements (such as Value, or 
Status), select where you want the measurements to be 
displayed in the report by selecting As column headers 
or As row headers. For details, see “Dimensions and 
Measurements” on page 206.

Limitation: You cannot select both a regular 
measurement and a measurement with a background 
at the same time when selecting to display a Service 
report as a Chart.

GUI Element (A-Z) Description
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Create Measurement Dialog Box

Description Enables you to add a calculated or aggregated 
measurement based on the measurements you selected 
in the Select Measurements page. 

To access: Click the Create Measurement button  
on the Select Measurements page in the Service Report 
Builder wizard.

Important 
Information

➤ After you create a new measurement, you are 
returned to the Select Measurements page where 
the new measurement is automatically moved to the 
Select Measurements box. Any measurements you 
selected before you created the new measurement 
are discarded, unless you validated the selection (by 
clicking the Next or Back button). 

➤ To delete a measurement you created, move it back 
to the Available Measurements box. When you click 
Finish, new measurements located in the Available 
Measurements box are automatically deleted, as 
they are not in use.

Note: When you select to display a Service report in 
the Chart format, you can create only Aggregated 
measurements; you cannot create Calculated 
measurements.

Limitations: See “Troubleshooting and Limitations” on 
page 281.

Included in Tasks “Configure a Service Report Portlet in My BSM – 
Workflow” in Using My BSM

“Create a Customized Measurement” on page 221
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Calculated Functions

The following calculated functions are available:

GUI Element (A-Z) Description

Measurement 
description

The description of the measurement you are creating.

Note: The description of the measurement appears as a 
tooltip when you move the pointer over the 
measurement on the Select Measurements page.

Measurement name The name of the measurement you are creating.

Note: * indicates that the field is mandatory.

Measurement type Select one of the following:

➤ Calculated to use a calculated function.

➤ Aggregated to use an aggregated function.

Select function Select the appropriate function. For details, see 
“Calculated Functions” on page 268 or “Aggregated 
Functions” on page 269.

Important 
Information

The Calculated Functions option is disabled when you 
select to display the Service report as a Chart.

For information on the function parameters relating to 
the selected calculated function, see “Function 
Parameters” on page 271. 

Function (A-Z) Description

Difference Returns the difference between the measurements 
selected in the First measurement list and the Second 
measurement list. 
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Aggregated Functions

The following aggregated functions are available:

Difference by 
percentage

Returns the difference between the measurements 
selected in the First measurement list and the Second 
measurement list, divided by the measurement 
selected in the Second measurement list, and 
multiplied by 100 (the result is in percentages). 

Note: If the source measurement value is 0, and the 
target value is not 0, the function cannot calculate the 
difference, and the calculation result is "-". For 
example: the difference by percentage of 97 from 0 is 
"-".

Percentage Returns the percentage of the selected First 
measurement value relative to the selected Second 
measurement value.

Status Compares the value of the measurement selected in 
Compare measurement box with the specified 
thresholds and returns a color. For more details, see 
“Status Function Automatic Measurements” on 
page 213.

Trend Returns the trend between the measurements selected 
in the First measurement list and the Second 
measurement list. The trend is indicated in the final 
report, using up , down , or no change arrow 

. For details, see “My BSM Page” in Using My BSM.

Important 
Information

For information on the function parameters relating to 
the selected aggregated function, see “Function 
Parameters” on page 271. 

Function (A-Z) Description

Average Returns the average of the values of the measurement 
you select in the Select measurement list.

Function (A-Z) Description
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Best Available only for status measurement types. Returns 
the best status of all the selected measurement statuses.

Note: This function is irrelevant when you select to 
display the Service report as a Chart.

Count Status Available only for status measurement types. Returns 
the number of times the status has the value selected in 
the Select measurement instance during the selected 
period of time.

Note: This function is irrelevant when you select to 
display the Service report as a Chart.

Max Returns the highest value of the measurement you 
select in the Select measurement list.

Min Returns the lowest value of the measurement you select 
in the Select measurement list.

Status Percentage Available only for status measurement types. Returns 
the percentage of the status for the value selected in 
the Select measurement instance.

Note: This function is irrelevant when you select to 
display the Service report as a Chart.

Sum Returns the sum of the values of the measurement you 
select in the Select measurement list.

Worst Available only for status measurement types. Returns 
the worst status of all the selected measurement 
statuses.

Note: This function is irrelevant when you select to 
display the Service report as a Chart.

Function (A-Z) Description
270



Chapter 10 • Service Report
Function Parameters

The following function parameters are available:

Important 
Information

Function Parameters are disabled when you select to 
display the Service report as a Chart.

GUI Element (A-Z) Description

Compare 
measurement

Displayed when you create a Status calculated 
function.

Select the measurement you want to compare with the 
thresholds you specify in To Threshold.

Create measurement Displayed when you create a Status calculated 
function.

Select one of the measurements that is automatically 
created when you create a Status calculated function. 
For details about those measurements, see “Status 
Function Automatic Measurements” on page 213.
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First measurement Displayed when you create a calculated function. 

Select the first measurement to be used in the 
calculation. 

Note: 

➤ When you create a calculated measurement, the 
names of the measurement in the First 
measurement and Second measurement lists are 
followed by an expression between parenthesis. For 
example, Event Count (Status 1) represents the 
instance of the measurement in the report. When 
the report including real data is displayed, the 
calculation occurs between the first instance of the 
measurement and the second instance of the 
measurement (or vice versa) according to your 
selection.

You can perform calculations between:

1. Two different instances of the same 
measurement. You can select only two instances 
(values) of the dimension on which you base the 
calculation in the Select Dimensions Filter page.

2. Different measurements. There is no limitation 
on the number of instances.

➤ When you select to display a dimension in a specific 
location (rows or columns), any calculated 
measurement based on that dimension and other 
selected measurements must also be displayed in the 
same location. 

Second 
measurement

Displayed when you create a calculated function. 

Select the second measurement to be used in the 
calculation. 

For more information, see “First measurement” on 
page 272. 

Select dimension Displayed when you create a calculated function. 

Select the dimension on which you want to perform 
the selected function.

GUI Element (A-Z) Description
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Select measurement Displayed when you create an aggregated function. 

Select the measurement on which you want to perform 
the selected function.

Selected 
measurement 
instance

Displayed when you create a Count Status or a Status 
Percentage aggregated function.

Select Failed, Breached, Minor Breached, Met, 
Exceeded, No Data, or Downtime.

To thresholds Displayed when you create a Status calculated 
function.

Enter the threshold values and select the operator to 
specify the status displayed when the comparison 
between the value of the measurement you selected in 
the Compare measurement list complies with the 
thresholds.

Note: The threshold definitions depend on the data 
source you selected in the Select a Data Source page.

GUI Element (A-Z) Description
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Edit Chart Properties Dialog Box

Target Lines Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to specify the target lines you want to 
display in the Service report and the scale of the Y-axis. 

Note: The capabilities offered in this dialog box are not 
available for Pie charts.

To access: Click Edit Chart Properties  in the Select 
Measurements page in the Service Report Builder 
wizard.

GUI Element (A-Z) Description

Add Click the Add button to add a label to the list of labels 
in the table.

Target Line Type 
Manual

Enter the following information:

➤ Label. The name of the target line. The name of the 
target line appears in the chart legend.

➤ Value. The value of the target line. It indicates the 
position of the target line on the Y-axis. The value 
appears in a tooltip when you move the pointer over 
the target line.

➤ Color. Select one of the colors (Red, Orange, Yellow, 
Khaki, Green, or Black). A line with the selected 
color appears next to the target line label in the 
chart legend.

Note: 

➤ When two or more labels have the same value but 
different colors, the corresponding target lines are 
displayed one over the other and the legend displays 
each colored line and its label. 

➤ When two or more labels have the same value and 
the same color, the legend displays the colored line 
followed by the label names separated by slashes (/).
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Target Line Type 
Measurement based

Select one of the measurements in the list. The 
measurements listed in the box are the measurements 
that are not dependant on the dimensions you moved 
to the X-Axis box in the Select dimensions page (if all 
the measurements available depend on the dimension 
you moved to the X-Axis, this option is disabled). 

The color of the labels corresponding to regular 
measurements (without background) is black. The 
color of the labels corresponding to measurements 
with background is the color of the background.

Note: 

➤ When two and more labels have the same value but 
different colors, the corresponding target lines are 
displayed one over the other and the legend displays 
each colored line and its label. 

➤ When two or more labels have the same value and 
the same color, the legend displays the colored line 
followed by the label names separated by slashes (/).

Update Select a label in the table, make the appropriate 
changes, and click Update to update the changes.

Note: You can select more than one label in the table, 
but you cannot edit more than one label at a time.

GUI Element (A-Z) Description
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Table Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Scaling Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Color The color of the target line. A colored line appears next 
to the target line label in the chart legend.

Label The name of the target line as it appears in the chart 
legend.

The labels are listed in chronological order.

Value The value of the target line. It indicates the position of 
the target line on the Y-axis. The value appears in a 
tooltip when you move the pointer over the target line.

GUI Element (A-Z) Description

Auto Scale The scale of the Y-axis is evenly distributed between 
the minimum and maximum values of the 
measurements selected in the Select Measurement 
page.

Start Chart at 0 The minimum value on the Y-axis is 0 and the 
maximum value is the maximum value of the 
measurements selected in the Select Measurement 
page.
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Select the Dimension Filters Page

Description Enables you to filter the dimensions you want to 
display in the report.

Important 
Information

➤ The Available Dimensions area lists both:

➤ the dimensions you selected in the Dimensions 
Selection page. 

➤ the dimensions related to the measurements you 
selected in the Measurement Selection page 
according to the application’s dimensions and 
measurements map. 

For details, see “Dimensions and Measurements” on 
page 206. 

➤ You must select at least one dimension filter for each 
dimension listed in the Available Dimension Filters 
area. Depending on the links between the 
dimensions and measurements you selected in the 
previous pages of the wizard, you can select a single 
value or multiple values for the dimension. For 
details, see “Impact on the Type of Selection: Single 
Selection or Multiple Selection” on page 208.

➤ The dimensions and measurements of each data 
source are mapped differently. For details, see the 
dimensions and measurement maps for each data 
source in “Impact of the Dimensions/Measurement 
Selection on the Report Structure” on page 208.

➤ General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Tips and Tricks: Before using this page, see “Tips and 
Tricks” on page 215.

Limitations: See “Troubleshooting and Limitations” on 
page 281.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) > (Edit Chart Properties 
Dialog Box) > Select the Dimension Filters Page > 
Summary Page
277



Chapter 10 • Service Report
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Available Dimensions 
Filters

Select a dimension in the list.

Clear Click to clear all selections.

Dimensions Filter Select the required dimension filter. 

Select only two values for dimensions that are used as a 
base for calculated functions. If you select one value, or 
more than two values, an error message is displayed.

For additional information, see “Impact on the Type of 
Selection: Single Selection or Multiple Selection” on 
page 208.

Note: When working with the Business Process Insight 
data source, select the measurements that are 
appropriate for the type of CI you select in the Select 
Dimension Filters. If the measurements you select have 
no connection with the type of CI you select, the 
report is empty or the data is meaningless for monitor 
CIs or partial for non-monitor CIs. For details about the 
available measurements, see “Business Process Insight 
Data Dimensions and Measurements Map” on 
page 240.
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Enable automatic 
preview

Select to display a preview of the report.

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the report preview.

Note: If, after previewing the page, you clear Enable 
automatic preview, the automatic preview is disabled 
on the next wizard page.

Preview Click to preview the page. The preview shows the 
report structure with the column and row headers; it 
does not display data. 

When you edit an existing Service report, Enable 
automatic preview is automatically selected and the 
Preview button is disabled. 

Any change made to the top part of the page 
automatically generates the preview report.

Note: The report preview displays randomly generated 
data and background color for illustration purposes 
only, and two placeholder values for each selected 
dimension.

GUI Element (A-Z) Description
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Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the report you have created with real data and 
real background color.

Important 
Information

General information about the wizard is available in 
“Service Report Builder Wizard” on page 227.

Wizard Map Welcome > Service Report Properties Page > Select a 
Display Type Page > Select a Data Source Page > Select 
Dimensions Page > Select Measurements Page > (Create 
Measurement Dialog Box) > (Edit Chart Properties 
Dialog Box) > Select the Dimension Filters Page > 
Summary Page

Useful Links “Edit Preferences <portlet_name> Dialog Box” in Using 
My BSM.

GUI Element (A-Z) Description

In My BSM, click to display the values of the 
dimensions selected in the Dimension Filters page that 
are not directly displayed in the report. 

<Common report 
elements>

For details, see “Common Report Elements” on 
page 56.
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Troubleshooting and Limitations

This section includes troubleshooting suggestions and limitations for the 
Service report.

General

➤ If you are editing a Service report and you change the data source of the 
report, you cannot perform the Clear operation in the Select Dimensions or 
the Select Measurement page. Clicking Clear issues an error message.

Select a Data Source Page:

➤ You cannot use both the Business Process Insight data and the 
TransactionVision data data sources.

➤ You can use only the Service Level Management - SLA Status data data 
source with the Service Level Management - SLA KPI data data source.

<Dimension filter 
elements>

In Report Manager, displays the values of the 
dimensions selected in the Dimension Filters page that 
are not directly displayed in the report. 

Remove empty 
columns and rows 
from report

In My BSM, select to remove the columns and rows 
that do not have data from the report.

Note: 

➤ When you create a Service report, you can choose 
components that are not necessarily related to other 
components in the report. Therefore, some results of 
the Service report may be blank when the report is 
generated.

➤ This option is disabled when you select the Chart 
display type for the report.

GUI Element (A-Z) Description
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Select Dimensions Page

➤ It is not recommended to move two or more elements in the Rows box and 
none to the Columns box in the Select Dimensions page, or vice-versa. It is 
recommended to move at least one element in the Columns box and one in 
the Rows box. 

Select Measurements Page

➤ When you select measurements from different measurement groups, the 
order of the measurements in the report and in the preview is different from 
the selected order. For example: if you select: Value, Targets - All, and Status, 
the order of the measurements in the report is: Value, Status, Targets - All. 
For details about the measurement groups, see the maps described in 
“Impact of the Dimensions/Measurement Selection on the Report Structure” 
on page 208.

➤ You cannot combine, in a report, an aggregated measurement with 
calculated measurements or with regular measurements.

➤ When you select the Line/Bar/Stacked Bar/Area chart type, and you do not 
move a dimension to the Series box in the Select Dimensions page, you can 
select more than one measurement in the Select Measurements page.

➤ When you select the Line/Bar/Stacked Bar/Area chart type and two 
measurements, the left Y-axis displays the first selected measurement scale 
and the right Y-axis displays the second selected measurement scale if the 
measurement units are different.

➤ When you select the Line/Bar/Stacked Bar/Area chart type and more than 
two measurements, a Line/Bar/Stacked Bar/Area chart is displayed for each 
measurement separately.

➤ When you use a Pie chart and you select several measurements , the report 
displays a separate pie chart corresponding to each selected measurement.
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Create Measurement Dialog Box

➤ If you select all the available dimensions in the Select Dimensions page, you 
cannot create a new aggregated measurement. For details about creating 
aggregated measurements, see “Create Measurement Dialog Box” on 
page 267.

➤ You cannot create a measurement that already exists and give it a different 
name.

➤ You cannot create different measurements with the same name.

➤ It is not recommended to create a calculated measurement whose 
dimensions appear in both the Rows and Columns boxes in the Select 
Dimensions page. For example, if you create a Diff calculated measurement 
based on the KPI Value and the Targets - Met measurements, the CI, SLA, 
and KPI dimensions participate in the calculation. It is recommended to 
move at least one of those dimensions in the Rows box if the other 
dimensions are in the Column box or vice-versa, so the report has the 
following structure:

Select Dimension Filters Page

➤ In the Select Dimension Filters page, the automatic preview displays an error 
message even when you have selected CIs. Click the Preview button or 
move to another dimension in the Mandatory Dimensions list to activate 
the preview feature.
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11
Custom Query Builder

This chapter includes the main concepts, tasks, and reference information 
for the Custom Query Builder.

This chapter includes:

Concepts

 ➤  Custom Query Builder - Overview on page 285

Tasks

 ➤  Build a Custom Query – Workflow on page 287

Reference

 ➤  Custom Query Builder User Interface on page 290

Troubleshooting and Limitations on page 313
Concepts

Custom Query Builder - Overview

The Custom Query Builder is a Web interface that assists in creating queries 
to the profile database. The queries are used to generate reports. The Custom 
Query Builder can also generate an HTML query string that can be used 
together with third-party tools or proprietary tools to extract data from the 
profile database. 

This section includes the following topics: 

➤ “Getting Metadata on the Samples” on page 286

➤ “Configuration” on page 286

➤ “Applying Filters to the Query Data” on page 286
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➤ “Supported Syntax and Limitations” on page 286

Getting Metadata on the Samples
When building queries, you must know the data representation of the 
sample. For information on commonly queried samples and descriptions of 
their fields, click “Data Samples” in Reference Information.

Configuration
You can set the maximum number of data rows returned at Admin > 
Platform > Setup and Maintenance > Infrastructure Settings > Foundations 
> Generic Data Engine Open API. Edit the Maximum Rows setting as 
required.

Note that the Enable Open API setting does not affect the Custom Query 
Builder.

Applying Filters to the Query Data
You can apply filters to the data being extracted by the query, using the 
Filter dialog box. For details on the Filter dialog box, see “Filter Dialog Box” 
on page 301. 

When a filter consists of strings containing white space or special characters 
(for example, where bb_guid IN (a b, c)), the white space or special character 
string must be enclosed with quotes (for example, where bb_guid IN (’a b’, 
c)). When you create filters on the Filter Builder page, quotes are added 
automatically. Special characters are defined as any characters other than 
digits, letters, and the following characters: "_", "$", "#".

When defining a filter that consists of strings containing one or more single 
quote characters, you must add a second single quote character beside each 
instance. For example, change szTransactionName = ('Login_to_O'brien') to 
szTransactionName = ('Login_to_O''brien').

Supported Syntax and Limitations
For a list of supported SQL syntax and query limitations, see “Supported 
SQL Syntax” and “Query Limitations” in Solutions and Integrations.

Tasks
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Build a Custom Query – Workflow

This task describes the working order for building a Custom Query.

Note: If you are accessing the Custom Query Builder from the Custom 
Report Wizard, you must click the Edit Filter button after selecting the 
Custom Query component to configure the Custom Query in your Custom 
report.

This task includes the following steps:

➤ “Select the Time Range” on page 287

➤ “Select Data Type” on page 288

➤ “Select Data Field” on page 288

➤ “Apply Filters” on page 288

➤ “Apply Field Properties” on page 288

➤ “Configure Presentation Settings” on page 289

➤ “Select Refresh Rate for Report (My BSM Portlet Only)” on page 289

➤ “Generate or Save the Query” on page 289

 1 Select the Time Range

 a Select the time range of the data to be extracted from the database. (Not 
relevant if accessing the Custom Query Builder from the Custom Report 
Wizard.)

Using the Time Range and Granularity bar, specify the time range for 
which you want to extract data. For details, see “Time Range and 
Granularity Bar” on page 70.

 b If you want returned data grouped according to a specific granularity 
setting (for example, if you want data for the past day grouped per hour), 
select Return data per specified granularity and specify a granularity 
setting.
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Example

The Time Range and Granularity bar is set to extract data from March 3, 
2008 at 5:02 PM until March 4, 2008 at 5:02 PM, according to the GMT + 
2:00 time zone.

 2 Select Data Type
Select the type of data you want to extract from the database.

From the Sample type list, select a data sample type. For a description of the 
available sample types, see “Data Samples” in Reference Information.

 3 Select Data Field
Select the data fields of the chosen sample type that you want to extract 
from the database, and the functions to perform on the data. Optionally, 
you can change the Field Alias of the field by modifying the Alias Name 
field. Click Add to add the field. For detailed descriptions of the available 
data fields per sample type, see “Data Samples” in Reference Information.

 4 Apply Filters
Click the Filter Builder button to apply filters to the data to be extracted by 
the query. For details on the user interface for applying filters, see “Filter 
Dialog Box” on page 301.

 5 Apply Field Properties
Click the Field Properties button to define custom properties for the field. 
For details on the user interface for defining custom properties, see “<Field 
alias> Field Properties Dialog Box” on page 294.
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 6 Configure Presentation Settings
Configure presentation settings to instruct HP Business Availability Center 
how to present the data in the report. For details the user interface for 
performing this task, see “Presentation Settings Wizard” on page 302.

 7 Select Refresh Rate for Report (My BSM Portlet Only)
In the Advanced Settings table, select a refresh rate for the report (either 
every 1 hour or every 2 hours), or specify no refresh.

 8 Generate or Save the Query

➤ If accessing the Custom Query Builder directly from the User Reports 
context, click Generate to generate a report based on the selected data. 
The report appears beneath the Query Filter pane, and the Query Filter 
pane collapses. To edit the query or create a new query, expand the Query 
Filter pane. To view the report, you must collapse the Query Filter pane.

➤ If accessing the Custom Query Builder from the Custom Report Wizard, 
click OK in the Add Component dialog box to save the settings to your 
Custom report. 

➤ If accessing the Custom Query Builder from My BSM, click Save to save 
the settings for the portlet.

Tip: To create a URL query string, click the Export button , select Publish 
Report, specify the requested settings, and click the Generate URL button.

Reference
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Custom Query Builder User Interface

This section describes:

 ➤  Custom Query Builder Page on page 290

 ➤  Presentation Settings Wizard on page 302

Custom Query Builder Page

Description Enables you to: 

➤ Create queries to the profile database to generate 
reports. 

➤ Generate an HTML query string that can be used 
together with third-party tools or proprietary tools to 
extract data from the profile database.

To access: 

You access the Custom Query Builder page in one of the 
following ways:

➤ Select Applications > User Reports > Custom Query 
Builder. 

➤ In the Custom Report wizard, select the Custom Query 
component category to add a Custom Query Builder 
report to a Custom report. For details on Custom 
reports, see “Custom Reports” on page 127.

➤ Select the Custom Query portlet in My BSM. For 
details on configuring a portlet in My BSM, see “Add 
Portlets to <page_name>/Add Portlets Dialog Box” in 
Using My BSM.

Important 
Information

To create a URL query string, click the Export button 
, select Publish Report, specify the requested 

settings, and click the Generate URL button.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Useful Links “Custom Query Builder - Overview” on page 285

“Common Report Elements” on page 56
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to open the <Field alias> Field Properties dialog box 
and modify field properties, if required. For details, see 
“<Field alias> Field Properties Dialog Box” on page 294.

<Common report 
elements>

For details, see “Common Report Elements” in Reports.

Alias Name Modify the alias name for the selected field, if required. 
For example, if you chose AVG from the Function list, 
modify the alias name to say Avg Response Time. 

Clear Filter Click to clear the filter string, if required. 

Edit Presentation Click to open the Presentation Settings dialog box and 
configure presentation settings. For details, see 
“Presentation Settings Wizard” on page 302.

Field Alias The value of the Alias name cell for the added field. 

Note: You can edit the value of this field directly in the 
Field Alias cell. 

Field Formula The value of the Function and Field name cells for the 
added field.

Note: You can edit the value of this field directly in the 
Field Formula cell. For example, to display returned 
response time in seconds rather than milliseconds, edit 
the field formula for Response Time, dResponseTime, as 
follows: dResponseTime / 1000.

Field Name Select a data field that you want to extract from the 
database. For a description of the available field types, see 
“Data Samples” in Reference Information.

Tip: When adding fields to the query, select them in the 
order in which you want the data columns to appear, 
from left to right, in the returned output. 
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Filter Displays the configured filter string. 

Note: 

➤ When a filter consists of strings containing white 
space or special characters (for example, where bb_guid 
IN (a b, c)), the white space or special character string 
must be enclosed with quotes (for example, where 
bb_guid IN (‘a b’, c)). When you create filters on the 
Filter Builder page, quotes are added automatically. 
Special characters are defined as any characters other 
than digits, letters, and the following characters: 
"_", "$", "#".

➤ When defining a filter that consists of strings 
containing one or more single quote characters, you 
must add a second single quote character beside each 
instance. For example, change szTransactionName = 
('Login_to_O'brien') to szTransactionName = 
('Login_to_O''brien')

Filter Builder Click to open the Filter dialog box and apply filters to the 
data being extracted by the query. For details, see “Filter 
Dialog Box” on page 301.

Function Select a function to perform on the data represented in 
the specified data field. For example, to return average 
response time, select Response Time from the Field name 
list and AVG from the Function list.

For a list of the supported functions, see “Supported SQL 
Syntax” in Solutions and Integrations.

Generate Click to generate the report based on the selected data. 
The report appears beneath the Query Filter pane, and 
the Query Filter pane collapses. To edit the query or 
create a new query, expand the Query Filter pane. When 
the Query Filter pane is expanded, the existing report 
remains beneath it.

Note: This element is available only when accessing the 
Custom Query Builder from the User Reports menu. 

GUI Element (A-Z) Description
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Return data per 
specified granularity

Select if you want returned data grouped according to a 
specific granularity setting (for example, if you want data 
for the past day grouped per hour), and specify a 
granularity setting.

Note:

➤ If you modify this setting after configuring 
presentation settings, the presentation settings are 
then lost. For details on presentation settings, see 
“Presentation Settings Wizard” on page 302.

➤ When selecting this field, it is recommended not to 
select the time_stamp field in the query. This is 
because, if Return data per specified granularity is 
selected, HP Business Availability Center automatically 
adds a time dimension to the report.

Sample type Select a data sample type. For a description of the 
available sample types, see “Data Samples” in Reference 
Information.

GUI Element (A-Z) Description
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<Field alias> Field Properties Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify the default field properties and 
define custom properties for the field.

To access: Click the Field Properties button  on the 
Custom Query Builder page. 

GUI Element (A-Z) Description

Critical Threshold Displayed for Double and Integer field types. Used to add 
color coding in tables and graphs to data for which 
thresholds in the system have been defined—for 
example, to display transaction response time data with 
color coding corresponding to the Critical threshold 
defined in System Availability Management. In tables, 
the color coding is in the form of colored cells. In graphs, 
the color coding is in the form of a colored line. For 
details on working with Critical Threshold settings, see 
“OK/Critical Thresholds” on page 298.

Format Displayed for Date, Double, and Integer field types. Used 
to customize the format of the displayed date or 
numerical data in data tables, as well as in graphs (x-axis, 
tooltips, legend). For a list of possible formats and syntax 
examples, see “Field Formats” on page 295.

Max length Displayed only for String field type. Used to set a 
maximum length, in characters, for the displayed string. 
In cases where the string exceeds the defined length, a 
tooltip is shown with the complete string.
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Field Formats

You enter values in the Formats box to modify the default format for a field, 
as defined in the field’s metadata. For example, the default date format is 
M/dd/yy hh:mm:a, which displays the date_stamp data as 
5/22/06 11:25 AM. By changing the date format, you can modify the way 
the date_stamp data is displayed. 

You can also add a string beside the returned data, for example, the literal 
string ms after returned response time data. The allowed formats are based 
on Java formatting classes. 

OK Threshold Displayed for Double and Integer field types. Used to add 
color coding in tables and graphs to data for which 
thresholds in the system have been defined—for 
example, to display transaction response time data with 
color coding corresponding to the OK threshold defined 
in System Availability Management. In tables, the color 
coding is in the form of colored cells. In graphs, the color 
coding is in the form of a colored line. For details on 
working with OK Threshold settings, see “OK/Critical 
Thresholds” on page 298.

Type The field type. The default type for the field is initially 
displayed.

Example: By changing a field type from Double to 
Integer, you can display the returned data without the 
decimal point, if you use a function to modify a field 
formula in a way that results in a numerical value 
becoming a string. For example, if you change 
(dResponseTime) to IF(dResponseTime,>,5000,pass,fail), 
you must change the type to String to enable the 
returned result to display correctly in a table.

The following field types exist: 

➤ String. Used for textual expressions.

➤ Date. Used for date fields.

➤ Double. Used for numerical fields.

➤ Integer. Used for numerical fields.

GUI Element (A-Z) Description
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Some typical date/time formats include:

Symbol Meaning Type Examples

y Year Number yy > 06

yyyy > 2006

M Month Text or Number M > 7

M > 12

MM > 07

MMM > Jul

MMMM > 
December

d Day in month Number d > 3

d > 14

dd > 03

h Hour (1-12, 
AM/PM)

Number h > 3

h > 11

hh > 03

H Hour (0-23) Number H > 15

HH > 15

m Minute Number m > 7

m > 15

mm > 15

s Second Number s > 15

ss > 15

S Millisecond (0-
999)

Number SSS > 007

E Day in week Text EEE > Tue

EEEE" > Tuesday

a AM/PM Text a > AM

aa > AM
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Some typical decimal formats include:

z Time zone Text z > EST

zzz > EST

zzzz > Eastern 
Standard Time

' Escape for text Delimiter 'hour' h > hour 9

Symbol Meaning Examples

0 Shows a digit, or 0 if no digit 
present

Value: 123.78 

Pattern: 000000.000 

Output: 000123.780 

# Shows a digit, or nothing if no 
digit present

Value: 123.78 

Pattern: #.###

Output: 123.78 

. Indicates the decimal point Value: 123.78 

Pattern: #.##

Output: 123.78

, Used to group numbers Value: 4123.78 

Pattern: ,###.##

Output: 4,123.78 

' Used to quote a literal symbol Value: 123.78 

Pattern: '#'###.##

Output: #123.78

% Multiplies by 100 and shows as 
percentage

Value: 123.78 

Pattern: #%

Output: 12378%

Symbol Meaning Type Examples
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A complete reference to these classes is located on the Sun Web site, at the 
following URLs: 

➤ Date and Time Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html

➤ Decimal Format Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/DecimalFormat.html

OK/Critical Thresholds

You enter values in the OK Threshold and Critical Threshold boxes to add 
color coding to your reports. Colors are added to the reports as follows:

➤ Green. For values corresponding to the specified OK Threshold value.

➤ Red. For values corresponding to the specified Critical Threshold value.

➤ Yellow. For values in between the specified OK Threshold and Critical 
Threshold values.

Example 1: Assuming your report is in table format, if you edit the field 
properties for transaction response time and specify 2000 ms for the OK 
Threshold and 4000 ms for the Critical threshold, all returned transaction 
response time values that are less than or equal to 2000 ms are colored 
green, all returned transaction response time values that are greater than or 
equal to 4000 ms are colored red, and all in-between values are colored 
yellow. This is the case even if, in System Availability Management, 
thresholds are defined differently.
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Example 2: Assuming your report is in graph format and average response 
time is selected for the y-axis, if you edit the field properties for transaction 
response time and specify 2000 ms for the OK Threshold and 4000 ms for 
the Critical threshold, a green line is drawn on the graph at the 2000 point 
and a red line is drawn on the graph at the 4000 point.

The following types of values can be entered in the OK Threshold and 
Critical Threshold boxes:

➤ Numerical values. You enter the actual values according to which you want 
data colored. Numerical values entered in the OK/Critical Threshold boxes 
color code both data tables (cells whose values are within a specific 
threshold range are colored accordingly) and graphs (a colored line 
representing the specified value is added to the graph). The values that you 
enter override any actual set threshold values. 
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Note: When editing the query presentation format to return a graph, if you 
configure multiple y-axes on the same graph, no colored line is displayed. 
For details on editing presentation see “Presentation Settings Wizard” on 
page 302.

➤ Referenced fields. You enter the exact field alias of two other fields that have 
been added to the query. The values of the referenced fields must be 
numerical. Typically, you add threshold fields such as Green Threshold and 
Red Threshold. Referenced fields entered in the OK/Critical Threshold boxes 
color code only data tables (cells whose values are within a specific 
threshold range are colored accordingly). Graphs are not color coded.

The following logic is used when determining how to interpret the values 
placed in the OK Threshold and Critical Threshold boxes to correctly apply 
color to the reports:

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is lower than the numerical value or value of the referenced 
field entered in the Critical Threshold box, HP Business Availability Center 
assumes that lower values are OK and higher values are Critical (for 
example, response time). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Green Threshold box 
would be colored green.

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is higher than the numerical value or value of the referenced 
field entered in the Critical Threshold box, HP Business Availability Center 
assumes that higher values are OK and lower values are Critical (for 
example, measurement of disk space). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Red Threshold box 
would be colored red.
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Filter Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to apply filters to the data being extracted by 
the query. 

To access: Click the Filter Builder button on the Query 
Filter pane. 

GUI Element (A-Z) Description

Add ’OR’ Expression Click to add Or filters. 

Add Values Click when available to select from a predefined list of 
values. The Add Values button is enabled for fields whose 
lookup value is defined as true in the sample metadata in 
the database (generally for final, discreet values).

And Click to add an additional And filter. 

Field Select a field to which you want to apply a filter. For 
example, select Profile Name to filter the query to return 
data only for specific profiles (rather than all profiles in 
the database), or select Response Time to filter the query 
to return only response time data above or below a 
specific value (rather than all response times).

Operator Select the required operator. For a description of the 
supported operators, see “Supported SQL Syntax” in 
Solutions and Integrations.

Note: The LIKE operator does not work for the Profile 
Name field.

Value Specify the required value. For example, if you are 
filtering the query by transaction name, specify a specific 
transaction. If you use the LIKE operator, you can use the 
* wildcard character to return like results (for example, a 
value of *westcoast* would return all transactions whose 
name included the string westcoast).



Chapter 11 • Custom Query Builder

302

Presentation Settings Wizard 

Description Enables you to configure the presentation display of your 
Custom Query. 

To access: Click the Edit Presentation button on the 
Query Filter pane. 

Important 
Information

The pages that appear on the Presentation Settings 
wizard depend on the option you select in the Choose 
Presentation View page and the Choose Table Type page.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map The Presentation Settings wizard contains the following 
pages, depending on whether you chose Table view or 
Graph view on the Choose Presentation View page of the 
wizard:

➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290
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Choose Presentation View Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the layout of the Custom Query 
presentation. 

To access: Click the Edit Presentation button on the 
Query Filter pane. 

Important 
Information

➤ The resulting wizard pages that appear depend on the 
Presentation View option you choose. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > 
Choose Table Type Page > (Select Field Order Page) > 
(Sort Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Graph Select to view the Custom Query presentation in graph 
format. 

Table Select to view the Custom Query presentation in table 
format.
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Choose Table Type Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to choose the type of table in which the 
Custom Query is displayed. 

To access: Select Table on the Choose Presentation View 
page in the Presentation Settings wizard. 

Important 
Information

➤ The resulting wizard pages that appear depend on the 
Table type you choose. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Pivot Select to display the Custom Query table as a table that 
can include multiple fields in a spreadsheet matrix.

Regular Select to view the Custom Query table as a standard table 
with a column for each field in the query.
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Select Field Order Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the order of the Custom Query 
fields to appear in your table. 

To access: Select Regular on the Choose Table Type page 
in the Presentation Settings wizard. 

Important 
Information

➤ The uppermost field in the Available Fields dialog box 
appears on the left side of the table, and the 
lowermost field appears on the right side of the table. 

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Click to move the selected field up in the Available Fields 
list, for it to be moved to the left side of the table. 

Click to move the selected field down in the Available 
Fields list, for it to be moved to the right side of the table. 

Available Fields Displays the fields selected on the Custom Query Builder 
Main page to be included in your Custom Query. 
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Sort Field Order Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the fields by which you want to sort 
the table. 

To access: Select the order of fields to appear in the table 
on the Select Field Order page, and click Next. 

This page appears only if you selected Regular on the 
Choose Table Type page. 

Important 
Information

➤ Fields are sorted first by the topmost field in the Sorted 
Fields dialog box, then by the next field, and so on.

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort 
Field Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Click to move the selected field to the Sorted Fields box.

Click to move all available fields to the Sorted Fields box.

Click to remove the selected field from the Sorted Fields 
box.

Click to remove all fields from the Sorted Fields box.
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 Click to move the selected field up in the sort hierarchy. 
Fields are first sorted by the topmost field, then by the 
next, and so on. 

Click to move the selected field down in the sort 
hierarchy. Fields are first sorted by the topmost field, 
then by the next, and so on. 

Click to sort the selected fields in the Sorted Fields box in 
ascending order. 

Click to sort the selected fields in the Sorted Fields box in 
descending order. 

Available Fields Displays the fields selected on the Custom Query Builder 
Main page that are available for sorting. 

Sorted Fields Displays the fields that are to be sorted in the Custom 
Query. Fields are first sorted by the topmost field, then by 
the next, and so on. 

GUI Element (A-Z) Description
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Table Definition Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the fields by which you want to sort 
the table. 

To access: Select the order of fields to appear in the table 
on the Select Field Order page, and click Next. 

This page appears only if you selected Pivot on the 
Choose Table Type page. 

Important 
Information

➤ If Return data per specified granularity is selected for 
the query, HP Business Availability Center adds Time 
to the list of available fields in the Table Definition 
page. 

➤ Fields are sorted first by the topmost field in the Sorted 
Fields dialog box, then by the next field, and so on.

➤ General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Click to move the highlighted key column to the 
Selected Key Columns dialog box.

Click to move all key columns to the Selected Key 
Columns dialog box.
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Click to remove the highlighted key column from the 
Selected Key Columns dialog box.

Click to remove all key columns from the Selected Key 
Columns dialog box.

Click to move the selected key column down in the 
Selected Key Columns dialog box, and specify the order 
in the table. The topmost key column appears on the left, 
then the next key column, an so on. 

 Click to move the selected key column up in the Selected 
Key Columns dialog box, and specify the order in the 
table. The topmost key column appears on the left, then 
the next key column, an so on. 

Across Column Select a field for the Across Column. Each unique value 
returned for that field is displayed in a separate column 
in the table. Examples of useful fields to select for the 
across column include: time, location, or any other field 
that returns a relatively small number of data points that 
are useful to compare one to another.

Available Key 
Columns

Select one or more fields, and move them to the Selected 
Key Columns list by clicking the relevant right arrow key. 
Consider selecting fields that contain data that you want 
to compare against the field selected in the Across 
Column. For example, in a query filtered to one specific 
transaction, if you selected time for the Across Column 
and average response time for the Value Field, you could 
select location and host fields as key columns; this would 
enable you to directly compare average response time of 
a transaction for various hosts at different locations at 
specific points in time.

Note: The fields that remain in the Available Key 
Columns box still exist in the query, but are hidden in 
the report table returned by the query.

GUI Element (A-Z) Description
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Choose Graph Type Page

Selected Key 
Columns

Displays the fields selected from the Available Key 
Column list. Each selected field displays in the table, to 
the left of the field selected for the Across Column. You 
can remove individual or all selections by clicking the 
left arrow keys. 

Value Field Select a field for the value field. It is recommended that 
you select a field that returns a meaningful numerical 
value, for example, response time. Do not select date-
related fields such as Time or time_stamp. 

Description Enables you to choose the type of graph for the Custom 
Query to be displayed in. 

To access: Select Graph on the Choose Presentation View 
page in the Presentation Settings wizard.

Important 
Information

General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Define Graph Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Bar Select to view the Custom Query in Bar Graph format.

Line Select to view the Custom Query in Line Graph format.

Description Enables you to specify the layout of the graph in which 
the Custom Query is displayed. 

To access: Select Bar or Line on the Choose Graph Type 
page in the Presentation Settings wizard.

Important 
Information

General information about the wizard is available in 
“Presentation Settings Wizard” on page 302.

Included in Tasks “Build a Custom Query – Workflow” on page 287

Wizard Map ➤ Table View: Choose Presentation View Page > Choose 
Table Type Page > (Select Field Order Page) > (Sort Field 
Order Page) > (Table Definition Page)

➤ Graph View: Choose Presentation View Page > Choose 
Graph Type Page > Define Graph Page

Useful Links “Custom Query Builder - Overview” on page 285

“Custom Query Builder Page” on page 290

GUI Element (A-Z) Description

Click to move the highlighted dimension to the Selected 
Dimensions list.

Click to move all key columns to the Selected 
Dimensions list.
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Click to remove the highlighted key column from the 
Selected Dimensions list.

Click to remove all key columns from the Selected 
Dimensions list.

Click to move the selected key column down in the 
Selected Dimensions list, and specify the order in the 
table. The topmost key column appears on the left, then 
the next key column, an so on. 

 Click to move the selected key column up in the Selected 
Dimensions list, and specify the order in the table. The 
topmost key column appears on the left, then the next 
key column, an so on. 

Available Dimensions Optionally, select one or more dimensions for the graph. 
If no dimensions are selected, the y-axis value is used as 
the single dimension. 

Note: The fields that remain in the Available Dimensions 
box are not sent as part of the query and do not appear in 
the report.

Max. Scale Optionally, specify a maximum value for the y-axis scale. 

Min. Scale Optionally, specify a minimum value for the y-axis scale. 

Selected Dimensions The dimensions that have been selected to appear in the 
graph. The data for a field selected as a dimension is 
displayed on the graph separately, differentiated using a 
color coding. 

GUI Element (A-Z) Description
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Troubleshooting and Limitations

➤ If you leave the Custom Query Builder page while building a query, the 
query is lost. To avoid losing the query, click the Generate button to 
generate a report based on the query. After generating a report, if you move 
to a different page and then return to the Custom Query Builder page, the 
last query built prior to report generation is available.

➤ Once you log out of your current Web session, the query is lost.

➤ When accessing the Custom Query Builder window from the Custom Report 
wizard, the query is lost as soon as you close the window, unless you click 
OK to save it.

X-axis Select a field to display on the x-axis. Both numerical 
fields and strings are supported.

Note: If Return data per specified granularity is selected 
for the query, HP Business Availability Center defines the 
x-axis as Time. This cannot be modified. 

Y-axis Select one or more numerical fields to display on the y-
axis (only numerical fields are supported). Fields selected 
for the y-axis are removed from the Dimensions list.

➤ If multiple y-axis fields are selected but no dimensions 
are selected, one single graph is displayed with all the 
fields on the same y-axis. For the graph with multiple 
y-axis fields to be meaningful, consider selecting fields 
whose values are comparable.

➤ If multiple y-axis fields are selected and one or more 
dimensions are selected, a separate graph is displayed 
for each separate y-axis.

GUI Element (A-Z) Description
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12
Excel Reports

This chapter explains how to use the capabilities of Microsoft Excel to build 
and view customized reports in HP Business Availability Center.

This chapter includes:

Concepts

 ➤  Configuring Excel Reports on page 316

Tasks

 ➤  Create a Microsoft Excel Report - Workflow on page 317

 ➤  Create a Microsoft Excel Web Query File on page 318

 ➤  Generate a Report with Microsoft Excel on page 318

Reference

 ➤  Example of a Web Query on page 320
Concepts
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Configuring Excel Reports

You can build and view customized reports in HP Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel, to 
display various types of data collected by HP Business Availability Center 
data collectors. The reports can be viewed with Microsoft Excel or any 
spreadsheet program capable of reading files with the .xls format. You 
cannot export information from charts into Microsoft Excel. For details on 
creating a Microsoft Excel Report, see “Create a Microsoft Excel Report - 
Workflow” on page 317.

Note: Contact HP Software-as-a-Service Support for details on implementing 
Microsoft Excel reports in HP Software-as-a-Service. 

Tasks
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Create a Microsoft Excel Report - Workflow

This task describes how to create Microsoft Excel reports that include 
HP Business Availability Center data:

This task includes the following steps:

➤ “Write a Query” on page 317

➤ “Save the Query” on page 317

➤ “Generate a Report with Microsoft Excel” on page 317

➤ “Upload the Microsoft Excel Report to the Report Manager” on page 317

➤ “View the Microsoft Excel Report” on page 317

 1 Write a Query
Write a query that retrieves data from the HP Business Availability Center 
profile database. For details on writing queries, see “Working with the 
Generic Reporting Engine API” in Solutions and Integrations.

 2 Save the Query
Save the query in a Web Query file. For details, see “Create a Microsoft Excel 
Web Query File” on page 318.

 3 Generate a Report with Microsoft Excel
Create a Microsoft Excel report. For details, see “Generate a Report with 
Microsoft Excel” on page 318.

 4 Upload the Microsoft Excel Report to the Report Manager
Click the New button in the Report Manager and select New Excel Report to 
open the Excel Report dialog box and upload the Microsoft Excel report to 
the Report Manager. For details, see “New Excel Report Page” on page 113.

 5 View the Microsoft Excel Report
Select the Microsoft Excel report in the table on the Report Manager main 
page and click the View button to view the report.
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Create a Microsoft Excel Web Query File

This task describes how to create a text file with an .iqy (IQY) extension that 
you then import into Excel.

To create an .iqy file:

 1 Open an empty file in a text editor and copy the following content into the 
file:

 2 Locate the query you created and place it in the file instead of the line 
<query_url_goes_here>. 

 3 Save the text file with an .iqy (IQY) extension.

For an example of a query that extracts data from the profile database, see 
“Example of a Web Query” on page 320.

Generate a Report with Microsoft Excel 

This task describes how to generate a report with Microsoft Excel. 

To generate a report with Microsoft Excel:

 1 Open a new Microsoft Excel file.

 2 Select cell A1.

WEB
1
<query_url_goes_here>

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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 3 In Microsoft Excel 2002 or 2003, select Data > Import External Data > 
Import Data. Microsoft Excel opens the Select Data Source dialog box. Select 
the .iqy file you created (as explained in “Create a Microsoft Excel Web 
Query File” on page 318 ) and click Open. Excel opens the Import Data 
dialog box.

In Microsoft Excel 2000, select Data > Get External Data > Run Saved Query. 
Microsoft Excel opens the Run Query dialog box. Select the .iqy file and 
click Get Data. Excel opens the Returning External Data to Microsoft Excel 
dialog box.

 4 Select Existing worksheet, and check that the value =$A$1 is selected.

 5 Click Properties. Microsoft Excel opens the External Data Range Properties 
dialog box.

 6 Make sure the following settings are configured:

➤ refresh data on file open

➤ remove external data from worksheet before saving

➤ overwrite existing cells with new data, clear unused cells

 7 Click OK. Microsoft Excel closes the External Data Range Properties dialog 
box and displays the Import Data dialog box (Returning External Data to 
Microsoft Excel dialog box in Excel 2000).

 8 Click OK to retrieve the data.

 9 Use Microsoft Excel’s charting features to format the report, as required.

 10 Name the file and save the Microsoft Excel workbook to a temporary 
location.

Reference
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Example of a Web Query

The following is an example of a typical Web query file. This example 
illustrates the retrieval of a list of rum_server_t samples that failed in any 
given day:

To use this example:

 1 Type or copy the text from the above example into a text editor.

 2 Edit the URL beginning on the third line of the file as required. Leave all 
other values as shown.

 3 Save the file with an .iqy extension.

WEB
1
http://myServer.mydomain/topaz/gdeopenapi/GdeOpenApi?method=getData&user=ad
min&password=admin&query=select time_stamp, engine_name, server_name from 
rum_server_t where availability=0 and total_hits > 0 and time_stamp>1041379200 and 
time_stamp<1136197020

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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activities
report log, 93

Adobe Flash Player
viewing reports with, 45

annotating reports, 44, 56
annotation, 44
annotation tool, 52, 56
API

configuration, 224
metadata for samples, 223

automatically generated report, 88

C

common report elements, 59
configuration items dialog box

in reports, 127
custom query builder

field formats, 234
main page, 228
overview, 223

custom reports
additional, 185
overview of additional, 185
Profile Summary, 186
Profile Summary User Interface, 192

E

email reports
troubleshooting, 132

Excel reports
creating a web query file, 257
troubleshooting, 132
web query, 258

F

favorite filters
wizard, 125
wizard, filter properties page, 125
wizard, filter setting page, 126
wizard, preview page, 129

field formats, custom query builder, 234
footer

adding to report, 84
formats, custom query builder, 234

H

header
adding to report, 84

I

Infrastructure Settings Manager
modifying maximum number of 

measurements in trend reports, 
201

modifying number of samples in 
reports, 40

K

KPIs dialog box
in reports, 128

L

log
report activities, 93

P

publishing reports, 42
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R

report manager, 101
creating a schedule, 112
custom link, creating, 130
favorite filters wizard, 125
favorite filters wizard, filter properties 

page, 125
favorite filters wizard, filter setting 

page, 126
favorite filters wizard, preview page, 

129
limitations, 132
main page, 113
saving a report to, 103
troubleshooting, 132
uploading Excel report, 131
user interface, 113
working with, 105

report schedules
troubleshooting, 132

reports
adding footer, 84
adding header, 84
annotation, 44, 56
annotation tool user interface, 52
automatically generated, 88
common report elements, 59
configuring favorite filter, 76
custom query builder main page, 228
custom query builder, field properties 

dialog box, 233
custom query builder,overview, 223
customizing, 83
Excel, 255
Excel, web query, 258
favorite filter, 76
generating, 50
generation button, 60
logs, 93
Profile Summary, 186
Profile Summary User Interface, 192
publishing, 42
report manager, 101
report schedules, 104
Response Time – 90th Percentile, 187
Response Time – 90th Percentile User 

Interface, 194
save as pdf, 75
time range, 60, 77
time range and granularity bar, 60, 77
View as Graph link, 63
View as Table link, 63
viewing in Microsoft Excel, 104
viewing reports with Adobe Flash 

Player, 45
working in reports, 38
working in reports overview, 38

reports log
level, 95
log structure, 96
logging activities, 94
logging errors, 94

reports scheduling a report, 104
Response Time – 90th Percentile report, 187
Response Time – 90th Percentile report User 

Interface, 194

S

summary reports
Profile Summary, 186
Profile Summary User Interface, 192

T

time range and granularity bar  77
trend report

wizard, header/footer page, 209
wizard, measurement selection page, 

203
wizard, preview report page, 210

trend reports
adjusting scales, 202
wizard, 199
wizard, select measurements page, 

201
wizard, trend properties page, 199

U

user reports
trend reports, adjusting scales, 202
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